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Welcome

 

Thank you for purchasing the Canon BJC-3000 Series Color Bubble Jet™ Printer.

This 

 

User’s Manual

 

 provides complete explanations of the features and functions of the 
printer. To maximize the life of your printer, it’s a good idea to familiarize yourself fully with 
all of its functions.

This 

 

User’s Manual

 

 uses the following symbols to indicate important information. Always 
observe the instructions indicated by these symbols.

Indicates instructions that, if ignored, could result in personal injury or 
material damage caused by incorrect operation of the equipment. 
Instructions indicated by this symbol must be observed for safe operation.

Indicates useful reference information or supplementary instructions 
concerning operation of the equipment. Be sure to read these notes.

This manual uses the following symbols depending on the computer system you are using. 
Always observe the instructions indicated by these symbols.

Indicates information for Windows

 

®

 

 98 and Windows 95 users only.

Indicates information for iMac

 

®

 

 and Power Macintosh

 

®

 

 G3 users only.

If you are a Windows NT 4.0 user, refer to the document file (NT_Guide320.doc)
provided with the Windows NT printer driver (on your Canon Creative CD-ROM).

Note

Caution

Windows

Macintosh
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Copyright

 

This manual is copyrighted by Canon Computer Systems, Inc. (CCSI) with 
all rights reserved. Under the copyright laws, this manual may not be 
reproduced in any form, in whole or part, without the prior written consent 
of CCSI.

© 2000 Canon Computer Systems, Inc.

 

Disclaimer

 

Canon Computer Systems, Inc. has reviewed this manual thoroughly in 
order that it will be an easy-to-use guide to your Canon BJC-3000 Series 
Color Bubble Jet Printer. All statements, technical information, and 
recommendations in this manual and in any guides or related documents 
are believed reliable, but the accuracy and completeness thereof are not 
guaranteed or warranted, and they are not intended to be, nor should they 
be understood to be, representations or warranties concerning the 
products described.

Your printer and the software media included with your printer have been 
sold to you subject to the limited warranties set forth in the warranty card 
and license agreement enclosed with the respective product. All software is 
licensed AS IS, as described in the license agreement enclosed with the 
software media. Further, CCSI reserves the right to make changes in the 
specifications of the products described in this manual at any time without 
notice and without obligation to notify any person of such changes.
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Trademarks

 

Canon, BCI, BJ, and Bubble Jet are trademarks, and SelectExchange is a 
service mark of Canon Inc. Print Planet is a service mark of Canon 
Computer Systems, Inc.

Microsoft and Windows are registered trademarks of Microsoft Corporation 
in the U.S. and other countries.

Mac and the Mac logo are trademarks of Apple Computer, Inc., registered 
in the U.S. and other countries. All other product and brand names are 
trademarks or service marks of their respective owners.

E

 

NERGY

 

 S

 

TAR

 

®

 

 COMPLIANT

As an E

 

NERGY

 

 S

 

TAR

 

®

 

 Partner, Canon U.S.A., Inc. has determined that this 
product meets the E

 

NERGY

 

 S

 

TAR

 

®

 

 guidelines for energy efficiency.
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How to Use This Manual

 

To view this 

 

User’s Manual

 

, please use Adobe

 

®

 

 Acrobat

 

®

 

 Reader 4.0 or later, which is
included on your CD.

Use this button when you wish to 
enlarge the screen you are viewing. 
Select this button in the tool bar, and 
then click within the screen of the 
User’s Manual. Use this button to display the 

next page of the User’s 
Manual.

Use this button to 
return to the page 
you were viewing 
previously. This 
button moves you 
back from another 
page.

This arrow and blue text 
indicate a jump to another 
location in the User’s 
Manual where the topic 
shaded in blue is 
discussed.

Use this button to display the 
previous page of the User’s 
Manual.
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How to Use This Manual

 

This column displays a table of contents for the 

 

User’s Manual

 

. 
Click the desired item to jump to the topic.
Click the + (or   ) symbol when you wish to see detailed headings for each chapter.
Click the – (or 

 

�

 

) symbol when you wish to return to the original (condensed) display.

Use this button to 
run a video clip 
about the current 
procedure.

Movie

 

Use this button 
when you wish to 
search for a word.

 

�
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Printer Features

 

�  

 

1440 dpi full-color printing with color BJ cartridges

 

Prints bright, vibrant colors at 1440 (horizontal) x 720 (vertical) dots per inch (dpi) on print 
media such as High Resolution Paper or Glossy Photo Paper.

 

�  

 

High-speed color printing with color BJ cartridges

 

Uses the bi-directional printing system for simple, fast printing for both color and 
monochrome printouts.

 

�  

 

Individual ink tanks save money

 

The simple design of the ink tanks allows each tank to supply one color. When one ink tank 
runs out of ink, just replace it.

 

�  

 

Variety of print media

 

Allows use of a wide variety of print media for many application programs. High Resolution 
Paper, Banner Paper, Back Print Film and other special media are available for your work 
and enjoyment.
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Printer Features

 

�  

 

Dual interface (USB and parallel)

 

Features built-in parallel and USB interface connectors. The USB interface of the printer 
supports the Microsoft

 

®

 

 Windows 98 operating system, and iMac and Power Macintosh G3 
computers (Mac OS 8.1 or later).

 

�  

 

Full scanner function (option)

 

If you purchase the IS-32 Color Image Scanner Cartridge, you can also use your printer as 
a 720-dpi scanner. You can capture your favorite photographs and pictures and then edit 
them on your computer. The IS-32 Color Image Scanner Cartridge is available via Canon’s 
Web site (www.ccsi.canon.com), or you can call 1-800-385-2155.

 

 Using the IS-32 Color Image Scanner Cartridge
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Safety Precautions

 

Please read the safety warnings provided in this manual to ensure that you use the printer 
safely. Do not attempt to use the printer in any way not described in this manual as this 
could result in unforeseen printer faults or cause a fire or electric shock.

Turning the printer off

Choosing a location

Power supply

Working around the printer

Cleaning the printer

BJ cartridges and ink tanks

Using the printer near appliances such as fluorescent lamps
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Safety Precautions

 

�  

 

Turning the printer off

 

To avoid printer malfunctions, always use the POWER button to turn the printer on and off. 
Do not remove the power cord from the power outlet until the printer has been turned off by 
pressing the POWER button. Be sure to unplug the power cord from the power outlet after 
the POWER light goes off.

 

�  

 

Choosing a location

 

Do not install the printer in a location that is unstable or subject to excessive vibration.

The printer could tip over or fall and cause injury.

Do not install the printer in locations that are very humid or dusty, in direct sunlight, or close 
to a heating appliance or fireplace.

To avoid the risk of fires or electric shocks, install the printer in a 
location with an ambient temperature range of 41°F to 95°F 
(5°C to 35°C) and humidity of 10% to 90% (no condensation).
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Safety Precautions

 

Do not place the printer on a thick rug or carpet.

Fibers or dust entering the printer could cause a fire.

Keep the power outlet for the printer free of all obstacles so you can unplug the power cord 
at any time.

Any obstacles could prevent you from unplugging the printer when 
a printer fault occurs and thereby cause a fire or electric shock.

When you are carrying the printer, always use both hands and hold the printer by both 
ends.

When you are moving the printer to another location, keep it stable 
so that you do not drop it and cause injury.
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Safety Precautions

 

Do not place the printer close to flammable solvents such as alcohol or thinner.

If flammable solvents come in contact with electrical components 
inside the printer, such substances could cause a fire or electric 
shock.

 

�  

 

Power supply

 

The socket-outlet shall be installed near the equipment and shall be easily accessible.

Always grasp the plug when you unplug the power cord.

Unplugging the power cord by pulling on the cord itself can 
damage the cord and cause a fire or electric shock.

Do not use an extension cord.

This could cause a fire or electric shock.
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Safety Precautions

 

Do not use a power supply voltage other than that supplied in the country of purchase.

Using the incorrect voltage could cause a fire or electric shock. The 
correct power supply voltage and frequency is:
USA/Canada:   AC 120V, 60Hz

Do not attempt to plug the power cord into the power outlet or unplug the power cord when 
your hands are wet.

This could cause an electric shock.

Always push the plug all the way into the power outlet.

A loose or poorly inserted plug could cause a fire or electric shock.
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Safety Precautions

 

Do not damage, modify, stretch or excessively bend or twist the power cord. Do not place 
heavy objects on the power cord.

Power leaking from a damaged power cord could cause a fire or 
electric shock.

Do not use the printer while the power cord is bundled or knotted.

This could cause a fire or electric shock.

If you detect smoke, unusual odors or strange noises around the printer, immediately press 
the POWER button to turn the printer off and always unplug the power cord.

Continuing to use the printer in these circumstances could cause a 
fire or electric shock. Call the Canon Customer Care Center.

 

 Getting Help From Canon
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Safety Precautions

 

�  

 

Working around the printer

 

Do not use flammable sprays near the printer.

Gases in the spray could cause a fire or electric shock if they come
in contact with electrical components inside the printer.

Do not put your hands or fingers in the printer while it is printing.

The printer contains moving parts that could cause injury.

Do not place metal objects (paper clips, staples, etc.) or containers of flammable solvents 
(alcohol, thinners, etc.) on the top of the printer.

Such objects could fall or spill into the printer and cause a fire or 
electric shock.
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Safety Precautions

 

If any foreign objects (metal or liquid) enter the printer, turn the printer off, unplug the power 
cord, and call the Canon Customer Care Center.

 

 Getting Help From Canon

 

Continued use of the printer when a foreign object has fallen into 
the printer could cause a fire or electric shock.

 

�  

 

Cleaning the printer

 

Use a damp cloth to clean the printer. Never use flammable solvents such as alcohol, 
benzene, or thinner.

If flammable solvents come in contact with electrical components 
inside the printer, such substances could cause a fire or electric 
shock.
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Safety Precautions

 

Always unplug the printer from the power outlet when you are cleaning the printer.

If you mistakenly turn the printer on while cleaning it, you could 
touch moving internal printer components and suffer injury.

Do not attempt to disassemble or modify the printer.

The printer contains high-voltage components that could cause a 
fire or electric shock.

 

�  

 

BJ cartridges and ink tanks

 

For safety reasons, store BJ cartridges and ink tanks out of the reach of small children.

If a child inadvertently licks a BJ cartridge or ink tank or ingests 
any ink, consult a physician immediately.
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Safety Precautions

 

Do not subject BJ cartridges or ink tanks to shocks or excessive vibration.

This could cause the ink to leak out and stain your clothing or the 
surroundings.

Do not touch the metal contacts on a BJ cartridge after printing.

The metal parts may be very hot and could cause burns.

 

�  

 

Using the printer near appliances such as fluorescent lamps

 

Allow at least 6 inches (approximately 15cm) clearance between the printer and an 
appliance such as a fluorescent lamp. Electrical noise generated by a fluorescent lamp 
placed too close to the printer may cause printer malfunctions.
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Parts and Functions of the Printer 

 

Front View

Rear View

Inside the Printer

Operation Panel
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Front View

 

Paper Guide

 

Ensures that sheets from the paper stack in the 
auto sheet feeder feed straight into the printer. 
Always align this guide with the left edge of the 
paper loaded in the auto sheet feeder.

 

Paper Rest

 

Raise to support the paper, 
especially a larger paper size.

 

Auto Sheet Feeder

 

Holds sheets of paper or other 
media for printing. The auto 
sheet feeder holds multiple 
sheets that are automatically 
fed into the printer one sheet at 
a time.

 

Operation Panel

 

For details, see the
Operation Panel section.

 

 Operation Panel

 

Front Cover

 

Open to install/replace/switch BJ 
cartridges or to remove a paper jam.

 

Paper Thickness Lever

 

Adjusts the gap between the print 
head and the surface of the paper 
you are printing on.

 

Paper Output Tray 

 

Holds printed sheets 
after they are 
ejected from the 
printer. 
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Rear View

 

Printer Cable Connector (Parallel Interface)

 

Provides a connection point for connecting a parallel 
interface cable to the printer.

 

Printer Cable Connector 
(USB Interface)

 

Provides a connection 
point for connecting a 
USB interface cable to 
the printer.

 

Power Connector

 

Provides a connection point for connecting 
the power cord to the AC power outlet. 
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Inside the Printer

 

Cartridge Holder

 

Holds the BJ cartridge: 
BC-33 Color BJ Cartridge (provided)
BC-30 Black BJ Cartridge (optional)
BC-34 Photo BJ Cartridge (optional)

 

Cartridge Lock Lever

 

Locks the BJ cartridge into the 
cartridge holder.
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Operation Panel

 

POWER button

 

Press to turn the printer on and 
off.

 

RESUME button

 

After you have removed the cause of a printer 
error, press the RESUME button to resume
printing.

 

POWER light

 

Lights to indicate the status of the printer:
Off Printer power off.
On (green) Ready for operation.
Flashing (green) Standby status or print job in progress.
Flashing (orange) Printer error. Remove the cause of the error, then press 

RESUME to continue printing.
Flashing (orange and green) Service error. Contact the Canon Customer Care Center.

 

 Getting Help From Canon
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Operation Panel

 

Hold down the RESUME button until the POWER light starts to flash.Then, 
release the button.The following operations are performed, depending on 
how many times you let the light flash.

• If you release the button after the light flashes 

 

once

 

:
Print head cleaning is performed.

• If you release the button after the light flashes 

 

twice

 

:
A Nozzle Check Pattern is printed out.

• If you release the button after the light flashes 

 

three

 

 times:
Paper feed roller cleaning is performed. In this case, you must place the 
cleaning sheet (that comes only with a package of High Resolution Paper) 
in the auto sheet feeder before pressing the RESUME button.

 

 Cleaning the Paper Feed Rollers

 

• You can also perform these tasks from the printer driver. 

 

 Using the Windows Printer Driver

Note
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Connecting and Turning On the Printer

 

About the Printer Cable

Notes on Handling the USB Interface

Connecting the Power Cord

Turning On the Printer

Turning Off the Printer
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About the Printer Cable

 

The printer is equipped with a parallel interface and USB interface. To connect the printer to 
your computer, you need a printer cable that supports bi-directional communication.

Check the interface connector of your computer, and follow the instructions in your 

 

Quick 
Start Guide

 

 to set up the printer.

Recommended printer cable specifications are as follows:

Parallel printer cable — IEEE 1284-compatible

Material AWG28 or larger
Type Twisted-pair shielded cable
Length Up to 6.5 ft (2.0m)
Connectors Amphenol 30360 or equivalent

USB printer cables — USB 1.0-compatible

Material AWG28 (data wiring pair) or AWG20 to 28 (distribution pair)
Type Twisted-pair shielded cable
Length Up to 16.4 ft (5.0m)
Connectors USB standard Series B
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Notes on Handling the USB Interface

 

 

 

When you use the printer through the USB interface, you can connect or disconnect the 
USB interface cable while the printer and computer are turned on. However, you must follow 
these guidelines.

 

�

 

Follow the instructions in the 

 

Quick Start Guide to install the printer driver properly, 
and to connect the printer and computer using the USB interface cable. If you fail to 
follow the correct order, the printer driver may not be installed properly.

� Do not connect or disconnect the USB interface cable in the following circumstances: 

• While the printer driver is being installed
• While the operating system (Windows 98 or Mac OS 8.1 or later) is starting up
• While the printer is printing

� You can connect or disconnect the USB interface cable while the printer and computer 
are turned on. Wait for at least 5 seconds before connecting the USB interface cable 
again.

� When you connect multiple printers using the USB interface, use the external USB 
hub and then install the printer driver each time you connect the printer. 

� When you disconnect the USB interface cable while the printer and computer are 
turned on, always disconnect it on the side of the computer or USB hub.
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Connecting the Power Cord

Plug the power cord securely into a power outlet.

• Use only the standard power supply voltage and frequency for the printer.
Using an incorrect voltage and frequency could cause fire or electric 
shock. The correct power supply voltage and frequency is:

USA/Canada AC 120V, 60Hz

• The socket-outlet shall be installed near the equipment and shall be
easily accessible.

• Move the printer only when the power cord is removed from the power 
outlet.

• Do not connect the printer to an outlet that is shared by other appliances. 
If the power outlet is shared with other appliances such as an air
conditioner, photo copier or fluorescent lamp, the electrical noise
generated by the appliance could cause printer malfunctions. Also, 
avoid placing electrical appliances of this type close to the printer.

Caution

Note
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Turning On the Printer

1 Make sure that the printer is connected to the computer and that the power 
cord is plugged into a power outlet.

2 Press and hold down the POWER button ( ).

The POWER light flashes for one to two minutes while the printer warms 
up. When the printer is ready to print, the POWER light stops flashing and 
remains green.

If you detect smoke, unusual smells or strange noises around the printer, 
press the POWER button to switch the printer off, unplug the power cord 
from the power outlet, and contact the Canon Customer Care Center 
immediately.

 Getting Help From Canon

Caution
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Turning Off the Printer

 

To turn off the printer, press the POWER button ( ).

The print head automatically moves back to the home position on the right and the POWER 
light turns off.

If you need to unplug the power cord, grasp the plug itself to pull it out. Do 
not pull on the power cord.

• Do not unplug the cord from the power outlet while the

 

 

 

POWER light is on
or flashing. If the printer is still turned on when you unplug it, the
cartridge holder will not return to the home position and may dry out,
making further printing impossible.

• If you do not intend to use the printer for an extended period, press the
POWER button to turn off the printer and then unplug the power cord
from the power outlet.

Caution

Note
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Printing on Paper and Other Media

 

Media Sizes You Can Use With 
the Printer

Media Types You Can Use With 
the Printer

Media Types You Cannot Use With 
the Printer

Loading Paper and Other Media

Setting the Paper Thickness Lever

Printing Area

Notes on Handling Media

Using Plain Paper or High 
Resolution Paper

Using Envelopes

Using Transparencies

Using Back Print Film

Using Glossy Photo Paper

Using High Gloss Photo Film

Using Glossy Photo Cards

Using Banner Paper

Using Magnet Sheets

Using Artist Canvas

Using Greeting Cards
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Media Sizes You Can Use With the Printer

The following table lists the standard paper sizes that you can use with the printer.

You can also use custom paper sizes within the following ranges.

Width 3.94 in. to 9.50 in. (100.0 mm to 241.3 mm)

Height 3.94 in. to 23.0 in. (100.0 mm to 584.2 mm)

You can load media of the following weight for printing.

17 lb to 28 lb (64 g/m2 to 105 g/m2)

Paper Width × Height

Letter 8.5 in. × 11.0 in. 

Legal 8.5 in. × 14.0 in.

A4 210 mm × 297 mm

A5 148 mm × 210 mm

B5 182.0 mm × 257.0 mm

Envelope (US Com. #10) 9.5 in. × 4.12 in.

Envelope (European DL) 220 mm × 110 mm

Canon 4" × 6" 4 in. × 6 in.

Custom Size 8.5 in. × 11.0 in.
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Media Types You Can Use With the Printer

Plain paper and Canon Specialty Papers are recommended for use with the printer. 

Refer to any instructions provided with special media for details about handling and printing.

�  Ordinary Paper
• Plain Paper

Provides standard print quality.
You can use standard photocopier paper if its weight is within the range of 17 lb 
to 28 lb (64 to 105 g/m2). (You can also use Canon Bubble Jet Paper.)

 Using Plain Paper or High Resolution Paper

• Envelopes
You can use the standard US Commercial #10 and European DL sizes. 

 Using Envelopes

| | | | | | | | | | |
@ E | | | | | | | | |

@ @ | | | | | | |
@ E | | | | | | | |

@ @ | | |@ E | | | | | | |
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Media Types You Can Use With the Printer

�  Canon Specialty Papers
Canon offers a range of special paper and films for the reproduction of superb images in 
vibrant colors. 

• Bubble Jet Paper
Provides standard print quality.

 Using Plain Paper or High Resolution Paper

• High Resolution Paper
Provides more vivid colors than plain paper.
Ideal for printing photographs or business documents that include large numbers 
of color illustrations and graphs.

 Using Plain Paper or High Resolution Paper

• Glossy Photo Paper
Slightly heavier than High Resolution Paper because a gloss coating is applied 
to the print side of the paper. Provides near-photographic quality images with the 
glossy feel of a photographic print.

 Using Glossy Photo Paper

• High Gloss Photo Film
To obtain the highest quality reproduction of photographs, use this media with 
the BC-33 Color BJ Cartridge. (You cannot use this media type with the BC-34 
Photo BJ Cartridge.)

 Using High Gloss Photo Film



 

40Printing on Paper and Other Media

Media Types You Can Use With the Printer

 

• Glossy Photo Cards
A special size media made of the same stock as Glossy Photo Paper. You can 
print borderless photos by printing the image so that it extends beyond the 
perforations and then trim off the unwanted white margins. 

 

 Using Glossy Photo Cards

 

• Transparencies 
Use these to prepare materials for use with an overhead projector. To avoid 
paper jams and other problems, use transparencies specifically designed for use 
with the Canon BJC-3000 printer. Do not use transparencies designed for laser 
printers or photocopiers.

 

 Using Transparencies

 

• Back Print Film 
This white translucent film is ideal for displays that use backlighting to show a 
printed image in the same way as slides and stained glass. The original image is 
reversed (mirrored) when printed.

 

 Using Back Print Film

 

• Banner Paper
This banner paper allows you to print on up to six connected sheets of letter size 
paper to create party or advertising banners.

 

 Using Banner Paper
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Media Types You Can Use With the Printer

• Magnet Sheets 
Printable magnets can be cut to any desired shape or size.
In the printer driver, select Glossy Photo Paper for the Media Type.

 Using Magnet Sheets

• Artist Canvas
Use this media to add an artistic touch to your images and artwork.
In the printer driver, select High Resolution Paper for Media Type and Custom 
9.5" x 14" for Paper Size.

 Using Artist Canvas

• Greeting Cards
Get the most out of your Canon Creative or other card-making software with 
Canon Greeting Cards. These cards give your unique, personalized cards the 
look and feel of professional cards. You can create cards, invitations, 
announcements, and more. These cards come in regular size and half-fold. In 
the printer driver, select High Resolution Paper for the Media Type.

 Using Greeting Cards
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Media Types You Cannot Use With the Printer

To avoid poor print quality and possible damage to the printer, do not use the media types 
listed below.

• Folded paper
• Curled paper
• Creased or crumpled paper
• Damp or wet paper
• Excessively thin media (weight less than 17 lb — 64 g/m2)
• Excessively thick or extremely heavy paper (exceeding 28 lb — 105 g/m2)
• Continuous feed paper (tractor feed)
• Punched paper (loose-leaf folder inserts, etc.)
• Reply-paid postcards (such as double postcards)
• Postcards with a photograph printed on the reverse side
• Postcards with a photograph or sticker pasted on
• Envelopes with overlapping flaps
• Envelopes with pressure seals
• Envelopes with embossed or treated surfaces
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Loading Paper and Other Media

�  Landscape and Portrait
There are two methods of orientation you can use to load the printer, depending on the type 
of media you intend to load.

• When the short edge of the paper is fed into the auto sheet feeder, this is called 
Portrait orientation.

• When the long edge of the paper is fed into auto sheet feeder, this is called 
Landscape orientation.

Paper
Portrait

(vertical)
Landscape 
(horizontal)

Letter Yes No

Legal Yes No

A5 Yes Yes

B5 Yes No

A4 Yes No

Envelope (US Com. #10) No Yes

Envelope (European DL) No Yes

Glossy Photo Cards Yes No
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Loading Paper and Other Media

�  Print Side
The following media must be printed on its correct side.

• Envelope Must be printed on the address side.

• High Resolution Paper Must be printed on the whiter side.

• Back Print Film Must be printed on the matte side.

• Glossy Photo Paper Must be printed on the whiter (glossy) side.

• High Gloss Photo Film Must be loaded and printed with the glossy side 
facing up and the cutting edge aligned against the 
right of the auto sheet feeder.

• Glossy Photo Cards Must be printed on the whiter (glossy) side.

• Magnet Sheets Must be printed on the glossy side.

• Artist Canvas Must be printed on coated side of the canvas.

• Greeting Cards Must be loaded with the words “Canon Greeting 
Cards” face down.
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Loading Paper and Other Media

�  Number of sheets that can be loaded at a time
The type of paper feed (auto versus manual) and the number of sheets that can be loaded 
vary according to the type of media. Make sure that the paper stack is not higher than the 
load limit mark (   ❘ ) on the auto sheet feeder.

Media type Maximum capacity of sheet feeder

Plain Paper Approximately 100 sheets (20 lb — 64 g/m2)

Envelopes Approximately 10 pieces (US Com. #10 or European DL)

High Resolution Paper Approximately 80 sheets

Transparency Approximately 30 sheets

Back Print Film Approximately 10 sheets

Glossy Photo Paper Approximately 10 sheets

High Gloss Photo Film 1 sheet

Glossy Photo Cards 1 sheet

Banner Paper 1 sheet (2 to 6 sheets in length)

Magnet Sheets 1 sheet

Artist Canvas 1 sheet

Greeting Cards 1 sheet

�
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Setting the Paper Thickness Lever

Before you print, be sure to set the paper thickness lever as listed below.

Media type Position

Plain Paper Up

Envelope Down

High Resolution Paper Up

Transparency Up

Back Print Film Up

Glossy Photo Paper Up

High Gloss Photo Film Up

Glossy Photo Cards Up

Banner Paper Down

Magnet Sheets Down

Artist Canvas Down

Greeting Cards Down

Paper Thickness Lever
Adjusts the gap between 
the print head and the 
surface of the paper you 
are printing on.
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Printing Area

To ensure the best print quality, the printer requires a margin along each edge of the media. 
The printing area, which varies according to the media size, is the paper size minus the 
margins.

There is both a printing area (recommended) and a printable area (possible).

Printing area (dark blue) Canon recommends that you print within this area 
for optimum print quality. ( )

Printable area (light blue) The area where it is possible to print. However, 
printing in this area can adversely affect the print 
quality or the paper feed precision. ( )

 Letter, Legal
 A4, A5, B5
 Glossy Photo Cards

 US Com. #10 Envelope
 European DL Envelope
 Banner Paper
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Printing Area

�  Letter, Legal

Media Type Printable Area (width × height)

Letter 7.5 in. × 10.68 in.

Legal 7.5 in. × 13.68 in.

* Printing in this area can adversely affect the print quality or the paper 
feed precision.

1.26"

1.02"

0.25" 0.25"

0.20"

0.12"

Recommended printing area
Printable area where it is possible to print.*

Note
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Printing Area

�  A4, A5, B5

Media Type Printable Area (width × height)

A4 203.2 mm × 289.0 mm

A5 141.2 mm × 202.0 mm

B5 175.2 mm × 249.0 mm

* Printing in this area can adversely affect the print quality or the paper
feed precision.

32.0 mm

26.0 mm

3.4 mm 3.4 mm

5.0 mm

3.0 mm

Recommended printing area
Printable area where it is possible to print.*

Note
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Printing Area

�  Glossy Photo Cards

Media Type Printable Area (width × height)

Glossy Photo Cards 3.64 in. × 3.72 in.

0.2" 0.16"

1.02"

1.26"

Recommended printing area
(The printable area is identical to the printing area.)
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Printing Area

�  US Com. #10 Envelope

Media Type Printable Area (width × height)

US Com. #10 8 in. × 3.7 in.

0.25" 1.25"

0.28"

0.12"

Recommended printing area
(The printable area is identical to the printing area.)



52Printing on Paper and Other Media

Printing Area

�  European DL Envelope

Media Type Printable Area (width × height)

European DL 203.2 mm × 100 mm

6.4 mm 10.4 mm

7.0 mm

3.0 mm

Recommended printing area
(The printable area is identical to the printing area.)
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Printing Area

�  Banner Paper

Media Type Printable Area (width × height)

Banner Paper 8.24 in. × 65.88 in. (Letter)
203.2 mm × 1731.0 mm (A4)

*  Printing in this area can adversely affect the print quality or the paper
 feed precision.

3.4 mm
A4

0.12" (3.0 mm)
1.3" (32.0 mm)

Recommended printing area

Max. 6 sheets
Min. 2 sheets

Printable area where it is possible to print.*

(    )(    )

3.4 mm
A4(    )0.13"

Letter

0.13"
Letter

(    )

Note
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Notes on Handling Media

• Whenever possible, hold the paper by the edges and avoid touching the print 
side. Any scratching or soiling on the print side will adversely affect the print 
quality.

• When storing your media, put the media back in its original packaging and avoid 
locations that are exposed to direct sunlight or that are subject to high 
temperatures or humidity. To avoid bending or wrinkling the paper, store it in a 
level place.

• After printing, do not touch the print side until the ink is dry. If water gets on the 
printed media, do not touch the print side until the media dries.

• The following are guidelines on how long ink takes to dry on individual print 
media.

Glossy Photo Paper About 2 minutes
Glossy Photo Cards About 2 minutes
High Gloss Photo Film About 2 minutes
Transparency About 15 minutes
Back Print Film About 15 minutes
Artist Canvas About 15 minutes
Magnet Sheets About 30 minutes
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Using Plain Paper or High Resolution Paper

1 Make sure that the printer is turned on and the paper thickness lever is set 
to the Up position. Raise the paper rest.

 Turning On the Printer

 Setting the Paper Thickness Lever

Paper thickness lever

Paper rest

Paper output tray
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Using Plain Paper or High Resolution Paper

2 Fan the stack to remove static cling and align the edges of the stack by 
tapping them on a flat surface. 

To avoid touching the print surface, always handle media by the edges. 
Unclean or scratched print surfaces can adversely affect print quality.

Note
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Using Plain Paper or High Resolution Paper

3 Load the stack of paper:

(a) Align the stack with the right side of the auto sheet feeder and insert it 
into the auto sheet feeder.

• Plain paper You can print on either side of the paper.
• High Resolution Paper Load the paper with the whiter side 

facing up.

(b) Adjust the paper guide to the left side of the stack.

Make sure that the top of the stack is not higher than the load limit mark. 
Maximum capacity of the sheet feeder is:
• Plain paper Approximately 100 sheets (20 lb — 64 g/m2)
• High Resolution Paper Approximately 80 sheets

Load limit mark

(a)

(b)

Note
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Using Plain Paper or High Resolution Paper

4

Open the Printer Properties dialog box, then select the most appropriate 
icon in the Choose Print Mode box under the Main tab. Select Plain Paper 
(when printing on plain paper) or High Resolution Paper (when printing on 
High Resolution Paper) in the Media Type box. Also make sure that the BJ 
Cartridge setting matches the BJ cartridge installed in the printer. 

Change the settings if necessary.

Select the most appropriate icon that indicates the print mode in the Printer 
Properties dialog box. Specify the media type (Plain Paper when printing 
on plain paper, or High Resolution Paper when printing on High Resolution 
Paper), and the BJ cartridge installed in the printer.

5 Start the print job.

Windows

Macintosh
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Using Plain Paper or High Resolution Paper

6 Check the printed sheets as they are ejected from the printer.

As soon as about 20 sheets have stacked on the paper output tray, remove 
them.

If the printed sheets are excessively curled after they are ejected from the 
printer, remove each sheet immediately to prevent curled sheets from 
blocking other sheets ejected from the printer.

• Store unused paper and other media flat in the original package in a dry, 
cool location away from direct sunlight, high temperature, and high
humidity.

• After you have printed one package of High Resolution Paper, use the
cleaning sheet provided with the package to clean the feed rollers of
the printer. Cleaning the feed rollers prevents misfeeds and jams.

 Cleaning the Paper Feed Rollers

Note
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Using Envelopes

1 Make sure that the printer is turned on and the paper thickness lever is set 
to the Down position. 

 Turning On the Printer

 Setting the Paper Thickness Lever

• To avoid poor print results, do not attempt to print on envelopes with 
embossed or treated surfaces.

• To avoid misfeeds and jams, do not use envelopes with overlapping flaps 
or pressure seals.

Paper thickness lever
Paper output tray 

Note
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Using Envelopes

2 Prepare the envelopes.

(a) Press down firmly on the corners of the envelopes and all edges to 
flatten the envelopes and expel all air.

(b) If the envelopes are still warped, hold the edges of the envelopes 
diagonally and bend gently. Make sure the flaps are straight.

(c) To ensure the envelopes feed correctly, use a pen or similar object to 
flatten the flaps.

• Failure to flatten the envelopes before loading may cause jams.

• Warping and air pockets in the envelopes should not exceed 0.2 in.
(5mm).

(a) (b)

(c)

Note
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Using Envelopes

3 Load the envelopes:

(a) Load the top edge of the address side (flap side down) into the auto 
sheet feeder and align the stack with the right side of the auto sheet 
feeder.

(b) Adjust the paper guide to the left side of the stack.

The maximum number of envelopes you can load is 10.

Print side (address side)

(a)

(b)

Note
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Using Envelopes

4

Open the Printer Properties dialog box, then select the most appropriate 
icon in the Choose Print Mode box under the Main tab. Select Envelope in 
the Media Type box. Also make sure that the BJ Cartridge setting matches 
the BJ cartridge installed in the printer. 

Change the settings if necessary.

Select the most appropriate icon that indicates the print mode in the Printer 
Properties dialog box. Specify the media type (Envelope), and the BJ 
cartridge installed in the printer.

Windows

Macintosh
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Using Envelopes

5

Click the Page Layout tab, then select “#10 Env. 9.50 × 4.12 in.” or “DL Env. 
220.0 × 110 mm” in the Page Size box for the envelope size.

Normally you can set the envelope size with the application program. 
However, if the setting on the Page Layout tab does not match the setting in 
the application program, change the setting here.

Select “#10 Env. 9.50 × 4.12 in.” or “DL Env. 220.0 × 110 mm” for the 
envelope size.

Normally you can set the envelope size with the application program.

6 Start the print job.

7 Remove each printed envelope as it is ejected from the printer.

Windows

Macintosh
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Using Transparencies

1 Make sure that the printer is turned on and the paper thickness lever is set 
to the Up position. Raise the paper rest.

 Turning On the Printer

 Setting the Paper Thickness Lever

Paper output tray

Paper rest

Paper thickness lever
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Using Transparencies

2 Fan the Transparencies to remove static cling and tap the edges against a 
flat surface to align them neatly. 

• To avoid touching the print surface, always handle the sheets by the 
edges. Unclean or scratched print surfaces can adversely affect print 
quality.

• Do not remove transparencies from the package until you are ready to 
load them in the auto sheet feeder, especially in humid conditions.

Note
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Using Transparencies

3 Load the Transparencies:

(a) With the print side facing up, place one sheet of plain paper under the 
stack. Load the stack with the edges aligned against the right side of the 
auto sheet feeder.

(b) Adjust the paper guide to the left side of the stack. You can print on 
either side of transparencies, but using a slightly curled surface as a 
print side is recommended.

You can load up to 30 transparencies in the auto sheet feeder.

Print side

(a)(b)

Plain paper

Print side

Note
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Using Transparencies

4

Open the Printer Properties dialog box, then select the most appropriate 
icon in the Choose Print Mode box under the Main tab. Select Transparency 
in the Media Type box. Also make sure that the BJ Cartridge setting 
matches the BJ cartridge installed in the printer. 

Change the settings if necessary.

Select the most appropriate icon that indicates the print mode in the Printer 
Properties dialog box. Specify the media type (Transparency), and the BJ 
cartridge installed in the printer.

5 Start the print job.

6 Remove each printed transparency as it is ejected from the printer.

Do not touch the printed side until the ink is completely dry. About 15 
minutes is required for drying.

• After drying, cover each transparency with one sheet of plain paper 
(uncoated) to prevent sticking and abrasion. Also, cover each
transparency if you are storing them in plastic pockets to prevent the
transparencies from sticking to the plastic.

• Store unused transparencies in the original package in a dry, cool
location away from direct sunlight, high temperature, and high humidity.

Windows

Macintosh

Note



69Printing on Paper and Other Media

Using Back Print Film

1 Make sure that the printer is turned on and the paper thickness lever is set 
to the Up position. Raise the paper rest.

 Turning On the Printer

 Setting the Paper Thickness Lever

Paper output tray 

Paper rest

Paper thickness lever
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Using Back Print Film

2 Fan the Back Print Film to remove static cling and tap the edges against a 
flat surface to align them neatly. 

If the film is curled, bend it slightly in the opposite direction of the curl to 
straighten it. 

• The matte side of the film is the print side which should be loaded 
face up.

• To avoid touching the print surface, always handle the sheets by the 
edges. Unclean or scratched print surfaces can adversely affect print 
quality.

Note
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Using Back Print Film

 3 Load the Back Print Film:

(a) With the print (matte) side facing up, place one sheet of plain paper 
under the stack. Load the stack with the edges aligned against the right 
side of the sheet feeder.

(b) Adjust the paper guide to the left side of the stack.

You can load up to 10 sheets of film in the auto sheet feeder.

4

Open the Printer Properties dialog box, then select the most appropriate icon 
in the Choose Print Mode box under the Main tab. Select Back Print Film in 
the Media Type box. Also make sure that the BJ Cartridge setting matches 
the BJ cartridge installed in the printer. 

Change the settings if necessary.

Print (matte) side up

(a)

(b)

Plain paper

Note

Windows
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Using Back Print Film

Select the most appropriate icon that indicates the print mode in the Printer 
Properties dialog box. Specify the media type (Back Print Film), and the BJ 
cartridge installed in the printer.

5 Start the print job.

6 Remove each printed sheet of Back Print Film as it is ejected from the 
printer.

Do not touch the printed side until the ink is completely dry. About 15 
minutes is required for drying.

 
• An image is reversed when printed on Back Print Film in order to display 

correctly when lit with a backlight.

• After drying, cover each sheet of Back Print Film with one sheet of plain
paper (uncoated) to prevent sticking and abrasion. Also, cover each
sheet of Back Print Film if you are storing them in plastic pockets to
prevent the film from sticking to the plastic.

• Store unused film in the original package in a dry, cool location away
from direct sunlight, high temperature, and high humidity.

Macintosh

Note
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Using Glossy Photo Paper

1 Make sure that the printer is turned on and the paper thickness lever is set 
to the Up position. Raise the paper rest.

 Turning On the Printer

 Setting the Paper Thickness Lever

Paper thickness lever

Paper rest

Paper output tray
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Using Glossy Photo Paper

2 Fan the Glossy Photo Paper to remove static cling and tap the edges 
against a flat surface to align them neatly. 

If the film is curled, bend it slightly in the opposite direction of the curl to 
straighten it. 

To avoid touching the print surface, always handle the sheets by the edges. 
Unclean or scratched print surfaces can adversely affect print quality.

Note
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Using Glossy Photo Paper

3 Load the Glossy Photo Paper.

(a) With the print side (glossy side) facing up, place the Loading Support 
Sheet B provided with the package under the stack. Load the stack with 
the edges aligned against the right side of the auto sheet feeder. (For 
details, refer to the instructions provided with the package.)

(b) Adjust the paper guide to the left side of the stack.

You can load up to 10 sheets in the auto sheet feeder.

(a)
(b)

Print side
(glossy side) up Loading Support Sheet B

Note



76Printing on Paper and Other Media

Using Glossy Photo Paper

4

Open the Printer Properties dialog box, then select the most appropriate 
icon in the Choose Print Mode box under the Main tab. Select Glossy Photo 
Paper in the Media Type box. Also make sure that the BJ Cartridge setting 
matches the BJ cartridge installed in the printer.

Change the settings if necessary.

Select the most appropriate icon that indicates the print mode in the Printer 
Properties dialog box. Specify the media type (Glossy Photo Paper), and 
the BJ cartridge installed in the printer.

5 Start the print job.

6 Remove each printed sheet as it is ejected from the printer.

Do not touch the printed side until the ink is completely dry. About two 
minutes are required for drying.

Store unused film in the original package in a dry, cool location away from
direct sunlight, high temperature, and high humidity.

Windows

Macintosh

Note
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Using High Gloss Photo Film

Use only the BC-33 Color BJ Cartridge for printing on High Gloss Photo 
Film. Do not use the BC-34 Photo BJ Cartridge.

1 Make sure that the printer is turned on and the paper thickness lever is set 
to the Up position. Raise the paper rest.

 Turning On the Printer

 Setting the Paper Thickness Lever

Note

Paper thickness lever

Paper rest

Paper output tray 
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Using High Gloss Photo Film

2 Load one sheet of High Gloss Photo Film:

(a) Remove one sheet from the package and hold the glossy side up with 
the cut corner up and on the right. Align the right edge with the right 
side of the auto sheet feeder and insert the sheet into the auto sheet 
feeder.

(b) Adjust the paper guide to the left side of the sheet. 

• If the sheet is curled, bend it slightly against the curl to straighten it.

• Always handle the sheet by the edges. An unclean or scratched print
surface can adversely affect print quality.

Print
side

Print side (glossy side) up with the
cut corner up and on the right

Cut corner

(a)
(b)

Note
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Using High Gloss Photo Film

3

Open the Printer Properties dialog box, then select the most appropriate 
icon in the Choose Print Mode box under the Main tab. Select High Gloss 
Photo Film in the Media Type box. The BJ Cartridge setting is automatically 
set to Color. 

Change the settings if necessary.

Select the most appropriate icon that indicates the print mode in the Printer 
Properties dialog box. Specify the media type (High Gloss Photo Film), and 
the BJ cartridge (Color).

4 Start the print job.

5 Remove each printed sheet as it is ejected from the printer.

Do not touch the printed side until the ink is completely dry. About 10 
minutes are required for drying.

Store unused film in the original package in a dry, cool location away from 
direct sunlight, high temperature, and high humidity. After storing the 
unused film in the package, place it on a stable, horizontal surface so that 
the film is not curled or creased in the package.

Windows

Macintosh

Note
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Using Glossy Photo Cards

1 Make sure that the printer is turned on and the paper thickness lever is set 
to the Up position. Raise the paper rest.

 Turning On the Printer

 Setting the Paper Thickness Lever

Paper thickness lever

Paper rest

Paper output tray
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Using Glossy Photo Cards

2 Load the Glossy Photo Cards:

(a) With the print side (glossy side) facing up, place the Loading Support 
Sheet B provided with the package under the stack. Load the stack with 
the edges aligned against the right side of the auto sheet feeder. (For 
details, refer to the instructions provided with the Glossy Photo Cards 
package.)

(b) Adjust the paper guide to the left side of the stack.

• Do not remove the borders from the photo card before printing.

• To avoid touching the print side (glossy side), always handle the sheet by 
the edges. Unclean or scratched print surfaces can adversely affect print
quality.

(a)
(b)

Print side
(glossy side) up Loading Support Sheet B

Note
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Using Glossy Photo Cards

3

Open the Printer Properties dialog box, then select the most appropriate 
icon in the Choose Print Mode box under the Main tab. Select Glossy Photo 
Cards in the Media Type box. Also make sure that the BJ Cartridge setting 
matches the BJ cartridge installed in the printer. 

Change the settings if necessary.

Select the most appropriate icon that indicates the print mode in the Printer 
Properties dialog box. Specify the media type (Glossy Photo Cards), and 
the BJ cartridge installed in the printer.

4 Click the Page Layout tab and make sure that the Page Size setting is 
Canon 4" x 6".

Normally you can set the paper size with the application program. However, 
if the setting on the Page Layout tab does not match the setting in the 
application program, or if your application program does not provide a size 
selection for Glossy Photo Cards, specify the setting here.

5 Start the print job.

6 Remove each printed card as it is ejected from the printer.

Do not touch the printed side until the ink is completely dry. About two 
minutes are required for drying.

Windows

Macintosh
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Using Glossy Photo Cards

7 Tear away the strip of the Glossy Photo Card. For more details, see the 
instructions provided with the Glossy Photo Cards package.

Store unused Glossy Photo Cards in the original package in a dry, cool 
location away from direct sunlight, high temperature, and high humidity.

Note
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Using Banner Paper

1 Make sure that the printer is turned on and the paper thickness lever is set 
to the Down position. Lower the paper rest.

 Turning On the Printer

 Setting the Paper Thickness Lever

2 Before you tear off the sheets, make sure that you take one more sheet 
than you need for printing. (When you wish to print three sheets, tear off a 
length of four sheets—one more than you need for printing.)

You can print on up to six sheets. If you want to print a banner of maximum 
length (six sheets), tear off a length of seven sheets—one more than you 
need for printing.

Note
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Using Banner Paper

3 Load the Banner Paper:

(a) Align the right side of the first sheet with the right side of the auto sheet 
feeder and insert it into the auto sheet feeder until it stops.

(b) Adjust the paper guide to the left side of the sheet.

• You can print on either side of Banner Paper.

• Neatly fold the unprinted paper behind the printer and do not allow it 
to hang over the edge of the table.

Print side up

(a)(b)

Note
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Using Banner Paper

4 Gently fold over the perforations between the first and second sheet.
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Using Banner Paper

5 Be sure to provide ample space in front of the printer so each sheet is 
supported as it comes out of the printer and then allowed to hang over the 
edge of the table:

A dense printout will require more time to dry. Be careful that wet ink does 
not stain the desk or the floor.

Note
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Using Banner Paper

6 Start the print job.

 Printing on Banner Paper—Windows

 Printing on Banner Paper—Macintosh

• In the Windows driver, you select Banner Printing on the Page Layout tab.

• When using an iMac or Power Macintosh G3, select Banner Printing
before creating a document using an application program.

Note
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Using Magnet Sheets

1 Make sure that the printer is turned on and the paper thickness lever is set 
to the Down position. Raise the paper rest.

 Turning On the Printer

 Setting the Paper Thickness Lever

Paper output tray

Paper rest

Paper thickness lever
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Using Magnet Sheets

2 Place one sheet of plain paper behind one magnet sheet. 

Place both sheets on a hard surface to align the bottom edge and sides. 

• From the bottom edge, roll the two sheets together with the plain paper 
facing out and glossy side of the magnet sheet facing inside.

• Once rolled, hold in this position for 20 seconds.

Glossy side of magnet sheet

Plain paper

Note

1.5"

1.5"
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Using Magnet Sheets

 3 Unroll the media and place it in the sheet feeder immediately.

(a) Make sure the print (glossy) side is facing up and one sheet of plain 
paper is under the sheet, load the two sheets with the edges aligned 
against the right side of the sheet feeder.

(b) Adjust the paper guide to the left side of the sheets.

You can load 1 Magnet Sheet in the auto sheet feeder.

4

Open the Printer Properties dialog box, then select the most appropriate icon 
in the Choose Print Mode box under the Main tab. Select Glossy Photo 
Paper in the Media Type box. The BJ Cartridge setting is automatically set to 
Color. 

Change the settings if necessary.

Print (glossy) side up

(a)

(b)

Plain paper

Note

Windows
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Using Magnet Sheets

Select the most appropriate icon that indicates the print mode in the Printer 
Properties dialog box. Specify the media type (Glossy Photo Paper), and 
the BJ cartridge (Color).

5 Start the print job.

6 Remove the printed Magnet Sheet as it is ejected from the printer.

Do not touch the printed side until the ink is completely dry. About 30 
minutes is required for drying.

Discard the sheet of plain paper.

 
• Return unused Magnet Sheets to the original package and store the 

sheets in a flat, dry, cool location away from direct sunlight, high 
temperature, and high humidity.

• You cannot use the BC-34 Photo BJ Cartridge with Magnet Sheets.

Macintosh

Note
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Using Artist Canvas

1 Make sure that the printer is turned on and the paper thickness lever is set 
to the Down position. Raise the paper rest.

 Turning On the Printer

 Setting the Paper Thickness Lever

Paper thickness lever

Paper rest

Paper output tray
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Using Artist Canvas

2 Load the Artist Canvas.

(a) With the print side (coated side) facing up, load one sheet of Artist 
Canvas with the edge aligned against the right side of the auto sheet 
feeder. 

(b) Adjust the paper guide to the left side of the sheet.

You can load one sheet of Artist Canvas in the auto sheet feeder.

(a)
(b)

Print side
(coated side) up

Note
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Using Artist Canvas

3

Open the Printer Properties dialog box, then select the most appropriate 
icon in the Choose Print Mode box under the Main tab. Select High 
Resolution Paper in the Media Type box. Also make sure that the 
BJ Cartridge setting matches the BJ cartridge installed in the printer. 
For Page Size, select Custom and set it to 9.5" x 14".

Select the most appropriate icon that indicates the print mode in the Printer 
Properties dialog box. Specify the media type (High Resolution Paper), and 
the BJ cartridge installed in the printer.

4 Start the print job.

5 Remove each printed sheet as it is ejected from the printer.

Do not touch the printed side until the ink is completely dry. About 
15 minutes are required for drying.

• Return unused sheets to the original package. Store the sheets in a flat, 
dry, cool location away from direct sunlight, high temperature, and high 
humidity.

• You cannot use the BC-34 Photo BJ Cartridge with Artist Canvas.

Windows

Macintosh

Note
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Using Greeting Cards

1 Make sure that the printer is turned on and the paper thickness lever is set 
to the Down position. Raise the paper rest.

 Turning On the Printer

 Setting the Paper Thickness Lever

Paper thickness lever

Paper rest

Paper output tray
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Using Greeting Cards

2 Load the Greeting Cards:

(a) With the print side facing up, load the stack with the edges aligned 
against the right side of the auto sheet feeder. (For details, refer to the 
instructions provided with the Greeting Cards package.)

(b) Adjust the paper guide to the left side of the stack.

3

Open the Printer Properties dialog box, then select the most appropriate 
icon in the Choose Print Mode box under the Main tab. Select High 
Resolution Paper in the Media Type box. Also make sure that the 
BJ Cartridge setting matches the BJ cartridge installed in the printer. 

Change the settings if necessary.

(a)
(b)

Print side
(glossy side) up Loading Support Sheet B

Windows
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Using Greeting Cards

Select the most appropriate icon that indicates the print mode in the Printer 
Properties dialog box. Specify the media type (High Resolution Paper), and 
the BJ cartridge installed in the printer.

4 Start the print job.

5 Remove each printed card as it is ejected from the printer.

Do not touch the printed side until the ink is completely dry. About two 
minutes are required for drying.

Store unused Greeting Cards in the original package in a dry, cool 
location away from direct sunlight, high temperature, and high humidity.

Macintosh

Note
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Using BJ Cartridges

BJ Cartridges You Can Use With the Printer

Notes on Handling BJ Cartridges
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BJ Cartridges You Can Use With the Printer

�  Types of BJ Cartridges
You can use the BC-33 Color BJ Cartridge, BC-34 Photo BJ Cartridge, or BC-30 Black 
BJ Cartridge with this printer. Use whichever cartridge is appropriate for the work you are 
doing.

 BC-33 Color BJ Cartridge

 BC-34 Photo BJ Cartridge

 BC-30 Black BJ Cartridge
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BJ Cartridges You Can Use With the Printer

�  BC-33 Color BJ Cartridge
This BJ cartridge includes pigment black, cyan, magenta, and yellow ink. This cartridge is 
best for printing general color documents and graphics.

The BC-33 Color BJ Cartridge is composed of the print head and four replaceable ink 
tanks.

When a color runs out, you replace only that color’s ink tank.

Black: BCI-3BK Ink Tank 
Cyan: BCI-3C Ink Tank 
Magenta: BCI-3M Ink Tank 
Yellow: BCI-3Y Ink Tank 

 Replacing the Ink Tanks

BCI-3Y

InkTank

Canon

Canon
BCI-3C

InkTank Canon
BCI-3M

InkTankMagenta

Cyan

Yello

Canon
BCI-3BK

Ink
ank
T

Black

BJ Cartridge

Ink tanks
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BJ Cartridges You Can Use With the Printer

�  BC-34 Photo BJ Cartridge 
This BJ cartridge includes Photo Black, Photo Cyan and Photo Magenta (which are slightly 
lighter than ordinary Cyan and Magenta), and standard Yellow. The photo cartridge is best 
for producing natural images such as photographs, and when you want to produce the best 
possible resolution.

The BC-34 Photo BJ Cartridge is composed of the print head and four replaceable ink 
tanks. 

When a color runs out, you replace only that color’s ink tank.

Photo Black: BCI-3PBK Photo Ink Tank 
Photo Cyan: BCI-3PC Photo Ink Tank 
Photo Magenta: BCI-3PM Photo Ink Tank
Yellow: BCI-3Y Ink Tank 

 Replacing the Ink Tanks

BCI-3Y

InkTank

CanonYello

Photo
Cyan

Canon
BCI-3PC

InkTank
Photo

Photo
Black

Canon
BCI-3PBK

Ink ank
Photo

T

Photo
Magenta

BCI-3PM

CanonPhoto

InkTank
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BJ Cartridges You Can Use With the Printer

�  BC-30 Black BJ Cartridge 
This BJ cartridge contains pigment black ink, which takes longer to dry than general dye 
ink, but produces extremely sharp, water-resistant text and graphics. This is intended for 
printing monochrome documents.

The BC-30 Black BJ Cartridge is composed of the print head and one replaceable ink tank, 
the BCI-3BK Ink Tank.

When this BJ cartridge runs out of black ink, you replace only the ink tank.

 Replacing the Ink Tanks

Canon
BCI-3BK

InkTankBlack
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Notes on Handling BJ Cartridges

�  When you handle BJ cartridges...

• To avoid personal injury or damage to the print head, do not touch the 
print head of a BJ cartridge. The print head becomes very hot during 
printing and can cause a minor burn. Touching the print head could 
damage it and make further printing impossible.

• To avoid ink spills and stains on your clothing or the surrounding area, do 
not drop or shake BJ cartridges or ink tanks.

Caution

CanonBCI-3BK

InkTank

Black
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Notes on Handling BJ Cartridges

�  When you store BJ cartridges...
When you replace a BJ cartridge, always store the BJ cartridge you are not using in an Ink 
Cartridge Storage Box. If the BJ cartridge is not properly stored in the container, the ink will 
dry out and you can no longer use the BJ cartridge. Also, after removing the seal on an
ink tank, always insert it into a BJ cartridge to prevent the ink tank from drying out.

Always store BJ cartridges and ink tanks out of the reach of small children. 
If any ink enters an eye or is accidentally ingested, seek medical assistance 
immediately.

BCI-3Y

InkTank

Canon

Canon
BCI-3C

InkTank Canon
BCI-3M

InkTankMagenta

Cyan

Yello

Canon
BCI-3BK

Ink
ank
T

Black

Caution
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Notes on Handling BJ Cartridges

• Do not attempt to reattach the protective cap and protective tape after 
removing them. Observe all local regulations regarding the location and 
method of disposing of them.

• Do not leave an empty ink tank in a BJ cartridge. Remove it immediately 
after ink runs out, and replace it with a new ink tank.

• If, for some reason, you remove a usable ink tank from the BJ cartridge,
re-insert the ink tank right away. Otherwise the ink will dry and print jobs
may not be performed properly when you install the ink tank later.

• For optimum print quality, an ink tank or BJ cartridge should be used up
within six months or a year respectively, after opening the original
packaging.

 Replacing the Ink Tanks

�  When you replace an ink tank or BJ cartridge...
The BC-30 Black, BC-33 Color, and BC-34 Photo BJ Cartridges contain replaceable ink 
tanks. Ink tanks and BJ cartridges are consumable items. After an ink tank runs out of ink, 
or after a print head wears out, replace the item.

 Replacing the BJ Cartridge

 Replacing the Ink Tanks

• When you replace an ink tank, note the name and number and replace it 
only with an identical ink tank.

• If the print head is worn out, replace the entire BJ cartridge.

Note

Note
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Using the Windows Printer Driver

Printer Driver Basics

Preparing and Executing a Print Job

Getting to Know the Printer Driver
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Using Maintenance Functions
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Printer Driver Basics

The printer driver controls communication between the printer and your computer. To use 
the printer with your computer, you must install the printer driver. For instructions on 
installing the printer driver, refer to the Quick Start Guide.

A
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Preparing and Executing a Print Job

Before you start a print job, you need to specify the print settings. The print settings in the 
printer driver allow fine control over the print quality and color adjustment, but you can 
simplify the setup procedure as follows.

1 Set the paper size you use from within the application program before 
printing.

2 Select the command used for printing (for example, “Print” or “Print Setup” 
in the File menu) in the application program.

3 Click the Properties button to open the Printer Properties dialog box, then 
select the desired icon for your print mode in the Choose Print Mode box 
under the Main tab.

• The most appropriate print settings are pre-assigned in each icon for a 
particular type of print job.

• The BJ Cartridge and Media Type settings are selected automatically.

4 Make sure that the BJ Cartridge and Media Type settings match the BJ 
cartridge installed in the printer and the print media you are using. 

Change the settings, as needed.



110Using the Windows Printer Driver

Preparing and Executing a Print Job

5 Also make sure that the Paper Size setting in the Page Layout tab matches 
the setting in the application program.

6 Click the OK button to close the Printer Properties dialog box.

7 Click the OK button in the Print window. Printing begins.

For Windows NT 4.0 Users

If you are a Windows NT 4.0 user, please note that some of the operation 
procedures are not identical to Windows 98 and Windows 95, and some of 
the features are not supported. The following examples indicate the 
differences.

• The features in the Page Layout tab are divided between two other tabs.

• The Maintenance tab is contained in the BJ Status Monitor.

• The Stamp/Background tab is not available.

• When you click the Advanced button in the Main tab, only the Quality
and Color tabs are displayed.

For more details on the operation procedures for Windows NT 4.0, please 
refer to the NT_Guide320.doc document file provided with the Windows NT 
printer driver (on your Canon Creative CD-ROM). 

Note
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Getting to Know the Printer Driver

Opening the Printer Properties Dialog Box

Selecting the Print Mode

Setting the Page Size

Using Online Help

Closing the Printer Properties Dialog Box
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Getting to Know the Printer Driver

�  Opening the Printer Properties Dialog Box
When you specify the print settings or use maintenance functions such as print head 
cleaning, you must open the Printer Properties dialog box.

This section describes the general procedures for opening the Printer 
Properties dialog box. Depending on the application program you use, 
different menu items may be used for printing. For more details, refer to the 
documentation for your application program.

From your application program

You can open the Printer Properties dialog box from your application program before 
printing.

1 Select the command used for printing (for example, “Print” or “Print Setup” 
from the File menu) in your application program.

Note
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Getting to Know the Printer Driver

2 Make sure that “Canon BJC-3000” is selected in the Printer box.

If another printer name is displayed, click the down-arrow and then select 
“Canon BJC-3000” from the pull-down list.

3 Click the Properties button. The Printer Properties dialog box opens. The 
“Main,” “Page Layout,” “Stamp/Background,” and “Maintenance” tabs are 
displayed in the Printer Properties dialog box.



114Using the Windows Printer Driver

Getting to Know the Printer Driver

From the Start menu

When you wish to specify print settings that are common to all application programs, open 
the Printer Properties dialog box from the Start menu.

This method is also helpful when you wish to use maintenance functions such as print head 
cleaning without starting up an application program.

1 Click the Start button. Point to Settings, then click Printers.

2 When the Printer window is displayed, click the “Canon BJC-3000” icon.
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Getting to Know the Printer Driver

3 Select Properties from the File menu. Or, right-click and select Properties 
from the pop-up menu. The Properties dialog box opens. The “Main,” “Page 
Layout,” “Stamp/Background,” and “Maintenance” tabs are contained in the 
Printer Properties dialog box.

When you open the Printer Properties dialog box from the Start menu, 
some other tabs (such as “General” and “Details”) are added by the 
Windows operating system. For more details on these additional tabs, refer 
to your Windows documentation.

Note
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Getting to Know the Printer Driver

�  Selecting the Print Mode
Before you start a print job, open the Printer Properties dialog box and specify the print 
mode. The print settings in the Printer Properties dialog box allow fine control over the print 
quality and color adjustment, but you can simplify the setup procedure by selecting the icon 
in which the most appropriate print settings are pre-assigned.

Default settings
The following print modes are set up as defaults in the printer driver. When you select an 
icon in the Choose Print Mode box, the combination of BJ Cartridge and Media Type 
settings changes automatically. Select the most appropriate icon according to your print job.

Icon Purpose BJ Cartridge Media Type

For printing documents that consist mostly of text 
(such as word processor files) at the standard print 
quality.

Color Plain Paper

Gives priority to print speed rather than print quality. 
Use this print mode for trial printing.

Color Plain Paper

Automatically recognizes photographs and graphics 
and prints using the optimum print settings. This print 
mode is the best choice when you print data that 
contains different elements such as text, tables, 
graphs, and photographs in the same document.

Color Plain Paper

Produces high print quality for printing photographs 
and other graphics with fine gradations of tone.

Color High Resolution 
Paper

Produces the best possible print quality for printing 
photographs. This print mode is also suitable for 
printing graphics with fine gradations of tone.

Photo High Resolution 
Paper
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Getting to Know the Printer Driver

• In addition to the BJ Cartridge and Media Type settings, other print
settings are also pre-assigned to each icon in the Choose Print Mode
box. To confirm all default settings, click the Advanced button
after selecting the icon. The settings on the Quality, Special Effects, and
Color tabs are the properties of the print mode.

• You can modify the default print mode settings, as necessary.

 Customizing the Print Settings in the Printer Driver
 (Creating an original print mode)

Selecting the print mode

After you select the icon, match the BJ Cartridge and Media Type settings with the BJ 
cartridges and print media installed in the printer.

1 Open the Printer Properties dialog box, then click the Main tab.

2 Select the desired icon according to your print job in the Choose Print 
Mode box.

Note
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Getting to Know the Printer Driver

3 Make sure that the BJ Cartridge and Media Type settings are identical to 
the BJ cartridge and print media installed in the printer.

When you change a default setting in the BJ Cartridge or Media Type box, 
the icon that indicates the current settings changes to User-modified.

Note

Current settings
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Getting to Know the Printer Driver

You can start a print job with the User-modified icon, but you can also save and register the 
settings in the Choose Print Mode box under a new icon.

 Customizing the Print Settings in the Printer Driver
   (Creating an original print mode)

�  Setting the Page Size
Set the page size you use from within the application program before printing.

Also make sure that the page size setting in the Printer Properties dialog box is identical to 
the page size setting in the application program.

Confirming the page size

You can view the page size you use in the print settings information box of the Main tab. 
Make sure that Page Size is identical to the setting in the application program before 
printing.

Print settings information box
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Getting to Know the Printer Driver

Changing the page size (for regular paper sizes)

1 Click the Page Layout tab.

2 Click the down-arrow in the Page Size box, then select the appropriate 
page size from the pull-down list.

Depending on the application program you use, the Page Size box may be 
grayed out and unusable. If this occurs, click the Cancel button to close the 
Printer Properties dialog box. Then open the Printer Properties dialog box 
from the Start menu and try again.

 Opening the Printer Properties Dialog Box

Note
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Getting to Know the Printer Driver

Changing the page size (for custom paper sizes)

1 Click the Page Layout tab.

2 Click the down-arrow in the Page Size box, then select Custom Size from 
the pull-down list. 

The Custom Paper Size dialog box is displayed.
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Getting to Know the Printer Driver

3 Select inch or mm (millimeter) for the unit of measurement in the Unit box, 
and enter the desired width and height within the following ranges:

width: 3.94" to 9.50" (100.0 mm to 241.3 mm)

height: 3.94" to 23.0" (100.0 mm to 584.2 mm)

4 Click the OK button.
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Getting to Know the Printer Driver

�  Using Online Help
When you want to learn about a particular topic, the online help function provides the 
necessary information on the screen of your computer.

Finding information on a particular topic

1 When you click the “?” button on the upper right corner of the Printer 
Properties dialog box, the shape of the mouse pointer changes to “ ”.

2 Click the desired item to learn more about the item. A detailed explanation 
appears.
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Getting to Know the Printer Driver

Finding information on an operation procedure

1 Click the Help button on the lower right corner of the Printer Properties 
dialog box.

2 When the contents of the BJ Raster Printer Driver Help are displayed, 
select the desired item to learn more about that item.
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Getting to Know the Printer Driver

�  Closing the Printer Properties Dialog Box
After specifying the necessary print settings, close the Printer Properties dialog box and 
start your print job.

Taking effect on the print settings

1 Make sure that the information on Direction, Feed, and Thickness Lever in 
the illustrated guideline is correct.
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Getting to Know the Printer Driver

2 Click the OK button. The print settings become enabled and the Printer 
Properties dialog box closes.

• When you want to enable the print settings without closing the Printer
Properties dialog box, click the Apply button.

• When you do not want to enable the print settings, click the Cancel
button.

• When you want to revert the print settings to the factory settings, click 
the Defaults button in each tab.

Note
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Making the Most of the Printer Driver

Printing Documents Enlarged/Reduced (Scaled Printing)

Printing Multiple Pages on One Sheet (Page Layout Printing)

Printing Documents Enlarged (Poster Printing)

Printing on Banner Paper

Changing the Print Order/Number of Copies

Printing a Stamp

Printing a Background

Optimizing Image Data

Photo Optimizer

Using Special Effects

Changing the Print Quality (Halftoning)

Adjusting Image Data

Customizing the Print Settings in the Printer Driver

Using Background Printing

Using the BJ Status Monitor

Using the BJ Printer Monitor
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Making the Most of the Printer Driver

�  Printing Documents Enlarged/Reduced (Scaled Printing)
The Scaled Printing feature of the printer driver allows you to set a scaling value to print 
an enlarged or reduced page on a paper size that is larger or smaller than the paper size of 
the original file in the application program.

There are two different ways to use Scaled Printing.

Setting the scaling value

This method is helpful when you know the enlargement or reduction ratio before printing.

1 Open the Printer Properties dialog box and click the Page Layout tab.

2 Click Scaled Printing. The Scaling and Printer Paper Size settings are 
enabled.
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3 Set the desired enlargement or reduction ratio in the Scaling box.

To change the value of the enlargement or reduction ratio, click the up- or 
down-arrow to the right of the Scaling box. (You can also enter the desired 
value directly.)

4 Confirm the layout of the printout in the preview area and click the OK 
button.

When you wish to revert Scaled Printing to the original value (100%), click 
Normal-size Printing.

Setting a printer paper size different from the original page size

1 Open the Printer Properties dialog box and click the Page Layout tab.

2 Click Scaled Printing. The Scaling and Printer Paper Size settings are 
enabled.

Note
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Making the Most of the Printer Driver

3 Click the down-arrow to the right of the Printer Paper Size box and select 
the desired paper size. When you select a paper size in the Printer Paper 
Size box which is different from the paper size originally set in the Page 
Size box, the enlargement or reduction ratio is calculated automatically and 
is displayed in the Scaling box. (If you need to make a fine adjustment, 
change the value in the Scaling box.)

4 Confirm the layout of the printout in the preview area and click the OK 
button.

When you wish to revert to the original value (100%), click Normal-size 
Printing.

Scaling box

Note
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�  Printing Multiple Pages on One Sheet (Page Layout Printing)
By reducing the scale in a 2-Page Print or 4-Page Print layout, you can print multiple pages 
on one sheet. You can save the total amount of paper used for long documents. This feature 
is also useful when you wish to view an image spread or print your document as a book 
cover.

Specifying the layout

1 Open the Printer Properties dialog box and click the Page Layout tab.

2 Click Page Layout Printing. The Specify button is displayed and the 
preview area display changes.
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Making the Most of the Printer Driver

3 Click the Specify button, as necessary. You can specify the detailed layout 
setting in the Page Layout Printing dialog box.

4 Confirm the layout of the printout in the preview area and click the OK 
button.

• When you use Page Layout Printing, check that Background Printing 
is enabled in the Page Layout tab.

• When you wish to revert Page Layout Printing to the original setting,
click Normal-size Printing.

Pages: Click the down-arrow and select the 2-Page Print or 
4-Page Print layout. The 2-Page Print setting prints two 
pages on one sheet of paper and the 4-Page Print 
setting prints four pages on one sheet of paper.

Page Order: Click the icon in the Page Order box. The icon indicates 
the order in which the pages run (for example, running 
from top-left to top-right to bottom-left to bottom-right in 
the 4-Page Print setting).

Frame Border: Check the Frame Border checkbox when you wish to 
print with a frame around each page.

Note
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Making the Most of the Printer Driver

�  Printing Documents Enlarged (Poster Printing)
By dividing image data (such as a photographic image) and enlarging it for printing, you can 
print one page on multiple sheets. Pasting the pages after printing makes it possible to 
create a large-sized document such as an artistic poster.

Setting the image divisions

1 Open the Printer Properties dialog box and click the Page Layout tab.

2 Click the button for Poster Printing. The Specify button is displayed and 
the preview area displays the changes.
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3 Click the Specify button, as necessary. You can specify a detailed image 
division setting in the Poster Printing dialog box.

Image divisions:
Specifies the number of divisions you want to make on the image.

2 × 2:  The number of printouts totals 4.
3 × 3:  The number of printouts totals 9.
4 × 4:  The number of printouts totals 16.

Print Cut/Paste in margins:
When Print Cut/Paste in margins is enabled, the printer prints “cut” and 
“paste” characters. Use these characters as a guideline when you cut and 
paste each page after printing.

Print Cut/Paste lines in margins:
When Print Cut/Paste lines in margins is enabled, the printer prints lines for 
cutting along. Use these lines as a guideline when you cut and paste each 
page after printing.



135Using the Windows Printer Driver

Making the Most of the Printer Driver

4 Confirm the layout of the printout in the preview area and click the OK 
button.

• When you use Poster Printing, check that Background Printing is
enabled in the Page Layout tab.

• When you wish to revert Poster Printing to the original setting, click
Normal-size Printing.

• You can divide the image divisions between printed pages and unprinted
pages.

When you do not wish to print the page, click the image division in the
preview area. (The image division disappears and the page is not
printed.)

When you wish to restore the image division, click the image division in
the preview area again. (The image division reappears and the page is
printed.)

• You can select the printed or unprinted pages at one time. Right-click 
the mouse in the preview area and select “Print all pages” or “Delete 
all pages.”

Note
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�  Printing on Banner Paper
For details on how to load banner paper in the printer, refer to Using Banner Paper.

 Using Banner Paper

This section describes the print settings for printing on banner paper.

Setting banner printing

1 Open the Printer Properties dialog box and choose the desired icon in the 
Choose Print Mode box of the Main tab. Also make sure that Plain Paper is 
set in the Media Type box.

2 Click the Page Layout tab.

3 Click the button for Banner Printing. A confirmation message appears.

• If you click the Help button, detailed instructions on banner printing are 
given.

• If you wish to skip over the detailed instructions on banner printing, click 
the OK button.

4 Confirm the preview area and click the OK button.

When you wish to revert Banner Printing to the original setting, click 
Normal-size Printing.

Note
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�  Changing the Print Order/Number of Copies
Based on the default settings of the printer driver, the printer starts printing one set of any 
document from the first page. When you print multiple copies of the same document, you 
need to specify the number of copies. You can change the print order with “Reverse” and 
“Collate,” as needed.

Setting the print order and number of copies

When you wish to print multiple copies of the same document, specify the number of 
copies.

You can also change the print order with “Reverse” and “Collate.” 

1 Open the Printer Properties dialog box, then click the Page Layout tab.

2 When you print multiple copies of the same document, set the number of 
copies between 1 and 999 in the Copies box.

Reverse order:
Use this setting when you print a multiple page document. The printer 
starts printing from the last page of the document. (When this setting is 
disabled, the printer starts printing from the first page of the document.)
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Collate:
Use this setting when you print multiple copies of a multiple page 
document.

When Collate is enabled, the printer prints the document and collates each 
copy from the first page to the last page.

When Collate is disabled, the printer prints the document and collates 
copies of the same page.

3 Select the print order.

4 Click the OK button to close the Printer Properties dialog box.

• Before setting the print order and number of copies, make sure that
Background Printing is enabled in the Page Layout tab. (If it is disabled,
you cannot change the print order and number of copies.)

• When Banner Printing is selected in the Page Layout tab, you cannot
change the print order or the number of copies.

• When Poster Printing is selected in the Page Layout tab, Reverse order
is grayed out and cannot be used.

Note
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�  Printing a Stamp
The printer driver allows you to print a stamp on your documents. Stamps are notations 
such as “CONFIDENTIAL” or “IMPORTANT,” which are frequently rubber-stamped on 
documents to alert readers. Several default stamps are available for immediate use.

Printing a default stamp

1 Open the Printer Properties dialog box, then click the Stamp/Background 
tab.

2 Click the down-arrow and select the desired stamp item from the 
pull-down list. (The stamp you select is displayed in the preview area at this 
time.)
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3 Specify whether to print the stamp on the first page only or on each page of 
the document.

Place stamp over text:
Click this checkbox to print the stamp on each page of the document.

Stamp first page only:
Click this checkbox to print the stamp on the first page only.

If you leave the box unchecked, the stamp is printed on each page. 

4 Click the OK button to close the Printer Properties dialog box and start the 
print job.

• When Background Printing is disabled or Banner Printing is enabled in
the Page Layout tab, the stamp items are grayed out and cannot be
used.

• To cancel stamp printing, select None from the Stamp pull-down list.

• When you wish to change settings such as size, color, or position of the
stamp, click the Define Stamp button.

  Customizing the Print Settings in the Printer Driver 
(Creating an original stamp)

Note
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�  Printing a Background
The printer driver allows you to print a background on your documents, like a watermark. 
Two types of default backgrounds are available for immediate use.

Printing a default background

1 Open the Printer Properties dialog box, then click the Stamp/Background 
tab.

2 Click the down-arrow and select the desired background item from the pull-
down list. (The background you select is displayed in the preview area at 
this time.)
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3 Specify whether to print the background on the first page of the document 
only, as necessary.

Background first page only:
Click this checkbox to print the background on the first page only.

If you leave this box unchecked, the background is printed on each page.

4 Click the OK button to close the Printer Properties dialog box and start the 
print job.

• When Background Printing is disabled or Banner Printing is enabled in
the Page Layout tab, the background items are grayed out and cannot 
be used.

• When you wish to revert to the normal print setting without any
background, select None from the pull-down list.

• When you wish to change settings such as the layout or position of the
background, click the Select Background button.

• You can also use a bitmap file as a background.

 Customizing the Print Settings in the Printer Driver
 (Creating an original background)

Note
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�  Optimizing Image Data
The printer driver allows you to compensate and optimize the print quality of image data. 
Depending on the type of image data you print, you can use either Image Optimizer or 
Photo Optimizer.

Image Optimizer

Enlarging an image often causes edges to look jagged. To solve this problem, after 
enlarging an image in your application program, turn on the Image Optimizer before 
printing. For example, you may want to use the Image Optimizer when you print a 
low-resolution image downloaded from a home page on the Internet.

1 Open the Printer Properties dialog box, then click the Main tab.

2 Click the Advanced button.

3 Select Image Optimizer in the Quality tab to enable the Image Optimizer 
setting.
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4 Click the OK button to return to the Main tab. 

5 Click the OK button to close the Printer Properties dialog box and start the 
print job.

• The Image Optimizer setting may have little or no effect on printing,
depending on the application program you use.

• The Image Optimizer setting has more effect on low-resolution images
than on high-resolution images.

• Using the Image Optimizer setting to smooth an image may require 
more time for printing.

Note
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�  Photo Optimizer
The Photo Optimizer adjusts a photographic image created with a digital camera when it is 
printed out. Use the Photo Optimizer to compensate unsatisfactory color balance and over- 
or underexposure before printing.

1 Open the Printer Properties dialog box, then click the Main tab.

2 Click the Advanced button.

3 Select Photo Optimizer in the Quality tab to enable the Photo Optimizer 
setting.
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4 Check the Whole Page checkbox, if necessary. 

Disabled: 
When the Whole Page setting is disabled, the Photo Optimizer adjusts 
multiple photographic images appearing on the same page separately.

Enabled: 
When the Whole Page setting is enabled, the Photo Optimizer adjusts 
multiple graphic images appearing on the same page as a whole. Use this 
setting when any trimmed or rotated images are contained in the page.

5 Click the OK button to return to the Main tab. 

6 Click the OK button to close the Printer Properties dialog box and start the 
print job.

• Using the Photo Optimizer setting to adjust an image may require more
time for printing.

• When Background Printing is disabled in the Page Layout tab, the 
Whole Page setting is grayed out and cannot be used.

• When Banner Printing is enabled in the Page Layout tab, the Whole
Page setting can be turned on but does not function.

Note
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�  Using Special Effects
The printer driver not only performs simple color adjustments to improve the quality of the 
original image, but also enhances images for artistic effect.

Setting Simulate Illustration

Use this artistic effect to simplify complex image data so that a photograph appears to be 
an illustration.

1 Open the Printer Properties dialog box, then click the Main tab.

2 Click the Advanced button.

3 Click the Special Effects tab.
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4 Check the Simulate Illustration checkbox to enable the setting. The 
appearance of the image data in the preview area changes (as if the 
photograph is converted to an illustration) at this time.

5 If necessary, drag the slide bar to increase or decrease the contrast.

6 Click the OK button to return to the Main tab.

7 Click the OK button to close the Printer Properties dialog box and start the 
print job.

• The Simulate Illustration setting can be used with the Monochrome
Effects setting.

 Setting Monochrome Effects

• When Background Printing is disabled in the Page Layout tab, the
Simulate Illustration setting is grayed out and cannot be used.

• When Black is selected in the Main tab, the Simulate Illustration 
setting is grayed out and cannot be used.

Setting Monochrome Effects

Use this setting when you want to give expression to an image by using a monochrome 
effect.

1 Open the Printer Properties dialog box, then click the Main tab.

2 Disable Grayscale Print by unchecking the Grayscale Print checkbox.

3 Click the Advanced button.

Note
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4 Click the Special Effects tab.

5 Check the Monochrome Effects checkbox to enable the setting. The 
appearance of the image in the preview area changes to a monochrome 
image.

6 Select the desired monochrome effect from Sepia, Blue, Pink, Green or 
Select Color.

7 When you select Select Color, drag the color slide bar until the desired 
monochrome image is displayed in the preview area. (You can also select 
the desired monochrome image by clicking the right or left arrow of the 
color slide bar.)

8 Click the OK button to return to the Main tab.
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9 Click the OK button to close the Printer Properties dialog box and start the 
print job.

• The Monochrome Effects setting can be used with the Simulate
Illustration setting.

 Setting Simulate Illustration

• When Background Printing is disabled in the Page Layout tab, the
Monochrome Effects setting is grayed out and cannot be used.

• When Grayscale Print is enabled in the Main tab, the Monochrome
Effects setting is grayed out and cannot be used.

�  Changing the Print Quality (Halftoning)
When your printouts are not satisfactory, the printer driver allows you to make fine 
adjustments to the print quality and halftoning settings.

Setting the print quality/halftoning

If there is a problem in the image data you wish to print, the print quality 
and halftoning settings may not be visible or effective.

1 Open the Printer Properties dialog box, then click the Advanced button in 
the Main tab.

Note

Note
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2 Click the Quality tab and set Print Quality and Halftoning, as needed.

Print Quality:
When you wish to improve the print quality, drag the Print Quality slide bar 
to the right (Fine). The print mode changes according to the setting of the 
slide bar. Please note that using a higher setting in the direction of Fine 
requires more time for printing.

Halftoning:
The colors and shapes of printouts are reproduced by the ink dots ejected 
from the nozzles of the print head. Halftoning determines the color 
boundaries of intermediate tones.

Fine (Fast):
Uses a simplified halftoning method for high speed printing.
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Fine:
Lines up ink dots of different colors under the rules specified in the printer 
driver. Use this setting for printing graphics or charts with clearly defined 
color boundaries.

Diffusion:
Randomly places ink dots of different colors. Use this setting for printing 
natural color images such as photographs.

Auto:
The printer driver automatically distinguishes among the types of image 
data, and switches to the most appropriate halftoning method.

3 Click the OK button to return to the Main tab.

4 Click the OK button to close the Printer Properties dialog box.

• Depending on the Halftoning settings, some of the Print Quality settings
cannot be used. When you wish to print at the highest quality, set
Halftoning to Diffusion.

• Depending on the BJ Cartridge and Media Type settings in the Main tab, 
some of the Print Quality and Halftoning settings cannot be used.

Note
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�  Adjusting Image Data
When the color reproduction of your printouts is unsatisfactory, you can adjust the color 
balance and intensity as needed. Use this feature only when you wish to make fine 
adjustments to the color balance in the printouts, and do not change the settings 
excessively. (Please note that this feature does not compensate the overall color balance of 
the image data as some application programs for editing image data would do.)

Adjusting the colors

Before adjusting the color balance and intensity, make sure that Color Adjustment is 
enabled in the Colors tab under the Main tab.

1 Open the Printer Properties dialog box, then click the Advanced button in 
the Main tab.

2 Click the Color tab and make sure that the Color Adjustment setting is 
enabled.
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3 Set the following items as needed.

Color Balance:
Move the slide bars of the individual colors. For example, when blues are 
too strong in the printouts, drag the slide bar for Cyan to the left.

Output Style:
Specifies whether printouts should emphasize intermediate tones or 
produce bright and sharp colors. When you select Auto, the printer driver 
automatically distinguishes among the types of image data, and switches to 
the most appropriate matching method.

Brightness:
Specifies the contrast among intermediate tones between black and white. 
Adjusting the brightness towards Light makes the overall image brighter, 
with stronger contrast in the light areas and lower contrast in the dark 
areas.

4 Click the OK button to return to the Main tab.

5 Click the OK button to close the Printer Properties dialog box.

Depending on the application program you use, you can also use the ICM 
(Image Color Management) feature of the Windows 98 operating system. 
For more details, refer to the online Help for Windows or your Windows 
documentation.

Note
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Adjusting the intensity

The Intensity Setting specifies whether to make the overall printout darker or lighter.

1 Open the Printer Properties dialog box, then click the Advanced button in 
the Main tab.

2 Click on the Color tab.

3 Move the Intensity slide bar to the left (lighter) or right (darker).

4 Click the OK button to return to the Main tab.

5 Click the OK button to close the Printer Properties dialog box.
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�  Customizing the Print Settings in the Printer Driver
Changing the default properties of the Print Mode, Stamp, and Background settings makes 
it possible to use them as customized settings in the printer driver.

You can also register your original stamp and background in the printer driver.

Creating and deleting an original print mode

You can create an original print mode by changing the default properties of the Print Mode 
settings as desired. It is also possible to save your original print mode as a file and delete it 
when it is unnecessary.

Creating an original print mode

1 Open the Printer Properties dialog box, then select the most appropriate 
icon for printing your document from the Choose Print Mode box in the 
Main tab.

2 Click the Advanced button. This displays all the properties of the print 
mode you selected in step 1.

When you need detailed descriptions of the print settings on any tab, click 
the “?” button and then move the “?” symbol to the item you want to learn 
more about in order to display the online Help of the printer driver.

Note
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3 Change the print settings in the Quality tab, if necessary. 

4 Change the print settings in the Special Effects tab, if necessary.
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5 Change the print settings in the Color tab, if necessary. 

6 Click the Save tab. You can save the desired print settings you made in 
steps 3, 4, and 5 here.
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7 To save the new print settings, enter a name for the desired print settings in 
the Title box of the Save tab. You can use up to eight characters. Please 
note that you cannot use a title that is pre-assigned in the printer driver 
(such as Draft or Standard).

8 Select the desired icon from the Icon Selection box.

9 Write a brief description in the Description box, if necessary.

10 Click the Save button. The icon you selected in step 8 appears in the Saved 
Settings box at this time.

11 Click the OK button to return to the Main tab. Make sure that the icon you 
selected in step 8 for the new print settings is in the Choose Print Mode 
box, and that the description you wrote in step 9 appears when you move 
the mouse pointer to the icon.
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• When “User-modified” is displayed to the left of the Choose Print Mode
box of the Main tab, you can save the new print settings using the
following procedure.

(1) Right-click the “User-modified” icon, then select Save As from the
pull-down menu.

(2) To save the new print settings, enter a name for the desired print
settings in the Title box of the Save tab. You can use up to eight
characters.

(3) Select the desired icon from the Icon Selection box.

(4) Write a brief description in the Description box, if necessary.

(5) Click the 

 

Save

 

 button.

• You cannot use a title that is pre-assigned in the printer driver (such as,
Draft or Standard).

 

Changing the position of a print mode icon

 

1

 

Open the Printer Properties dialog box, then click the 

 

Advanced

 

 button in 
the Main tab.

 

2

 

Click the Save tab.

 

3

 

Select the icon you wish to change the position of in the Saved Settings 
box.

 

4

 

Each time you click the arrow  to the right of the Saved Settings box, 
the icon moves in the direction of the arrow. (To move the icon, you can also 
drag the icon directly to the desired position.)

Note
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5 Click the OK button to return to the Main tab.

You cannot move the icon back to its original position by clicking the 
Cancel button.

Saving an original print mode as a file

1 Open the Printer Properties dialog box, then click the Advanced button on 
the Main tab.

2 Click the Save tab.

3 Select the icon you wish to save as a file in the Saved Settings box.

4 Click the Save As button. This displays the Save File dialog box.

5 Enter a file name in the File Name box.

6 Select the drive name and folder name in the Directory box.

7 Click the OK button. The print mode is saved as a file.

You can save multiple print modes to a single file.

Note

Note
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Opening an original print mode that was saved as a file

1 Open the Printer Properties dialog box, then click the Advanced button.

2 Click the Save tab.

3 Click the Open button. This displays the Open File dialog box.

4 Select the drive name and folder name in the Directory box.

5 Select the file in which the original print mode was saved in the File Name 
box.

6 Select the icon you wish to open in the Icon Selection box.

7 Click the OK button. The original print mode you opened in the printer 
driver is displayed in the Saved Settings box.

Deleting an unnecessary print mode

1 Open the Printer Properties dialog box, then click the Advanced button on 
the Main tab.

2 Click the Save tab.

3 Select the icon you wish to delete in the Saved Settings box.

4 Click the Delete button.

5 When a confirmation message appears, click the OK button. The icon of 
the original print mode is deleted from the Saved Settings box in the Save 
tab.
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6 Click the OK button to return to the Main tab. (The icon of the original print 
mode is also deleted from the Choose Print Mode box in the Main tab.)

• You cannot delete default print modes such as Standard.

• You can delete the unnecessary print mode directly in the Choose Print
Mode box of the Main tab.

(1) Right-click the icon of the original print mode you wish to delete in the
Choose Print Mode box of the Main tab.

(2) When a confirmation message appears, click the OK button.

Creating and deleting an original stamp

You can create an original stamp by changing the default properties of the Stamp settings 
as desired. You can also register your original stamp in the printer driver.

Creating an original stamp

1 Open the Printer Properties dialog box, then click the Stamp/Background 
tab.

2 When you wish to change the settings of a default stamp item, click the 
Stamp box and then select the item you wish to change from the 
pull-down menu. When you wish to create an original stamp, select None in 
the Stamp box.

3 Click the Define Stamp button. The Stamp Settings Properties dialog box 
is displayed.

Note
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When you need detailed descriptions of the settings on any tab, click the 
“?” button and then move the “?” symbol to the item you want to learn more 
about in order to display the online Help of the printer driver.

4 Specify original settings related to text in the Text tab. 

5 Specify original settings related to colors in the Color tab.

Note
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6 Specify original settings related to the stamp position in the Placement tab. 

7 Click the Save settings tab.



166Using the Windows Printer Driver

Making the Most of the Printer Driver

8 Enter a name for the original stamp in the Title box of the Save settings tab.

9 Click the Save button.

10 When a confirmation message appears, click the OK button.

11 Click the OK button in the Save settings tab to return to the Stamp/
Background tab.

Deleting an unnecessary stamp

1 Open the Printer Properties dialog box, then click the Stamp/Background 
tab.

2 Click the Define Stamp button. The Stamp Settings Properties dialog box 
is displayed.

3 Click the Save settings tab.

4 Select the stamp you wish to delete from the Title box.

5 Click the Delete button.

6 When a confirmation message appears, click the OK button.

7 Click the OK button in the Save settings tab to return to the Stamp/
Background tab.

You cannot delete default stamp items such as IMPORTANT and 
CONFIDENTIAL.

Note
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Creating and deleting an original background

You can create an original background by changing the default properties of the 
Background settings as desired. You can also register your original background (bitmap file 
only) in the printer driver.

Creating an original background

1 Open the Printer Properties dialog box, then click the Stamp/Background 
tab.

2 When you wish to change the settings of a default background item, click 
the Background box and then select the item you wish to change from the 
pull-down menu. When you wish to create an original background, select 
None in the Background box.

3 Click the Select Background button. The Background Settings Properties 
dialog box is displayed.
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4 Click the Select File button. The Select image file dialog box is displayed.

5 Select the name of the drive in which the bitmap file you wish to use as an 
original background is saved.

6 Select the name of the folder in which the bitmap file you wish to use as an 
original background is saved.

7 Select the file name of the bitmap file you wish to use as an original 
background.

8 Click the OK button. The file name you specified in step 7 is displayed in 
the File box of the Background tab.

9 Specify the other settings in the Background tab, if necessary. 

10 Click the Save settings tab.
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11 Enter a name for the original background in the Title box of the Save 
settings tab.

12 Click the Save button.

13 When a confirmation message appears, click the OK button.

14 Click the OK button in the Save settings tab to return to the Stamp/
Background tab.

Make sure that the file size of the bitmap file you can use as an original 
background is smaller than 15MB. A bitmap file that is larger than 15MB 
cannot be used as the background.

Note
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Deleting an unnecessary background

1 Open the Printer Properties dialog box, then click the Stamp/Background 
tab.

2 Click the Select Background button. The Background Settings Properties 
dialog box is displayed.

3 Click the Save settings tab.

4 Select the background you wish to delete from the Title box.

5 Click the Delete button.

6 When a confirmation message appears, click the OK button.

7 Click the OK button in the Save settings tab to return to the Stamp/
Background tab.

�  Using Background Printing
The print processing method that enables you to do other tasks simultaneously while 
printing documents is called “Background Printing.”

Normally, the BJ Raster Printer Driver performs “background printing.” The BJ Background 
Monitor and BJ Backgrounder allow you to confirm the progress of printing that is being 
performed in the background.
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About background printing

You can see the Background Printing checkbox in the Page Layout tab of the Printer 
Properties dialog box. When Background Printing is enabled, the BJ Background Monitor 
and BJ Backgrounder are launched before the printer starts the print job. You can verify 
information on the print process.

When Background Printing is disabled in the Page Layout tab, the following 
settings cannot be used because background printing is applied to them.

Page Layout tab:
Page Layout Printing, Poster Printing, Copies, Printer control, Reverse 
order and Collate

Stamp/Background tab:
All stamp and background settings

Quality tab (opens from the Advanced button in the Main tab):
Photo Optimizer

Special Effects tab (opens from the Advanced button in the 
Main tab):
All Simulate Illustration and Monochrome Effects settings

Note
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BJ Background Monitor

When a print command is sent to the printer, the BJ Background Monitor is launched 
automatically and is minimized on the Windows taskbar.

To verify the print process, click the BJ Background Monitor icon minimized on the Windows 
Taskbar. The following items are displayed.

Application/Print Document:
Shows the file names of documents that are queued or currently being 
printed. (Depending on the application program you use, the name of the 
application program is also displayed.) The icon on the left of the file name 
indicates the document which is currently being printed.

Page(s) [Size]:
Shows the file size of the documents in pages and bytes.

Time/Date:
Shows the time and date when the print job started.
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The BJ Background Monitor makes it possible to perform the following tasks:

• You can change the order of the documents you print.
Drag the document you wish to change the priority of to the desired position. 
Please note that you cannot change the priority of the document which is being 
printed.

• You can cancel a print job.
Click the document you wish to stop printing, then select Delete from the Edit 
menu. When a confirmation message appears, click the OK button.

• You can quit the BJ Background Monitor.
Select Quit from the File menu.

• You can give priority to background printing.
Select Priority from the Option menu and drag the slide bar.
As you drag the slide bar to the left, another job you are working on using an 
application program is given priority over the background printing in order to 
make the processing for the application program faster.

• You can change the temporary directory for saving print data.
To perform background printing, a region which is used to save the print data 
temporarily is required on the hard disk. (If sufficient hard disk space is not 
available, background printing cannot be performed.) To solve this problem, you 
need to change the directory that saves the print data temporarily, as described 
on the next page.



174Using the Windows Printer Driver

Making the Most of the Printer Driver

1 Select Directory from the Option menu.

2 Select the drive and directory.

3 Click the OK button.

• When you wish to open the BJ Background Monitor while the printer is
not printing, follow these steps:

(1) From the Start menu, select Programs.

(2) Point to BJ Printer, and then select BJ Background Monitor.

 or

(1) Double-click the BJ Printer icon on the Windows desktop.

(2) Double-click the BJ Background Monitor in the BJ Printer window.

• For more details on the BJ Background Monitor, refer to the online 
Help for the BJ Background Monitor.

BJ Backgrounder

When Background Printing is enabled in the Page Layout of the Printer Properties dialog 
box, the BJ Backgrounder is displayed in the lower right corner of the screen.

Note
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The BJ Backgrounder makes it possible to perform the following tasks:

• You can cancel a print job.
When you wish to cancel printing in mid-job, click the Cancel button. When a 
confirmation message appears, click the OK button.

• You can stop the print process of the printer driver temporarily.
When you wish to stop the print process of the printer driver temporarily for some 
reason, click the Pause button.
While the print job is paused, the Pause button changes to the Resume button. 
Click the Resume button to start printing again.

�  Using the BJ Status Monitor
The BJ Status Monitor (which is found in the Maintenance tab) is a utility program that 
allows you to check the status of the printer. If an error occurs for some reason, the BJ 
Status Monitor displays the cause of the error and a solution.

In addition, the BJ Status Monitor detects the remaining ink of the BJ cartridge and displays 
a warning message when the ink is low.

About the operating environment

The following are the minimum requirements to run the BJ Status monitor.

When using the parallel interface only:

• Check that your computer supports bi-directional communications.
• Check that your printer cable (interface cable) supports bi-directional 

communications.
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When using the parallel or USB interface:

• Check that the settings to support bi-directional communications are enabled in 
the Windows operating system.

To check that the settings to support bi-directional communications are 
enabled in Windows, follow these steps:

(1) Open the Printer Properties dialog box from the Start menu.

(2) Click the Canon BJC-3000 icon in the Printers window, then select
Properties from the File menu.

(3) Click the Details tab.

(4) Click the Spool Settings button.

(5) Check that the “Enable bi-directional support for this printer” is enabled
in the Spool Settings dialog box.

Launching the BJ Status Monitor

When a print command is sent to the printer or low ink is detected, the BJ Status Monitor is 
launched automatically and is minimized on the Windows taskbar.

To verify the print process and the type of BJ cartridge, click the BJ Status Monitor icon 
minimized on the Windows taskbar. The following items are displayed.

Note
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Printer Name:
Shows the name of the printer you are using.

Document Name:
Shows the file name of the document that is currently being printed. 
(Depending on the application program you use, the name of the 
application program is also displayed.)

Status:
Shows the printer status and print job progress using graphics and 
messages.
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Start Time:
Shows the time and date when the print job started.

Progress:
When “Spool print jobs so program finishes printing faster” is enabled and 
the “Spool data format” is set to RAW in the Spool Settings dialog box 
under the Details tab, the print job progress is indicated by the percentage 
and gauge shown here.

Pages Printed:
Shows the number of printed pages.

Cancel Printing:
Click this button when you wish to cancel the print job (before data transfer 
is completed).

Cartridges:
Shows the BJ cartridge currently installed in the printer.

—Color BJ Cartridge or Photo BJ Cartridge

—Black BJ Cartridge

Low Ink:
Shows the remaining ink warning icon when the ink is low.

 Error and warning display
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• When you wish to open the BJ Status Monitor while the printer is not
printing, follow these steps:

(1) Open the Printer Properties dialog box.

(2) Click the Maintenance tab.

(3) Click the Start Status Monitor button.

• You can select the way of launching the BJ Status Monitor. For more
details, refer to the online Help for the BJ Status Monitor.

• When nothing is displayed in Progress, follow these steps:

(1) Open the Printer Properties dialog box from the Start menu.

(2) Click the Details tab.

(3) Click the Spool Settings button.

(4) Check that “Spool print jobs so program finishes printing faster” is
enabled in the Spool Settings dialog box.

(5) Check that “RAW” is displayed in the Spool data format box.

• To close the BJ Status Monitor, click the “X” button on the upper right
corner of the BJ Status Monitor window. When the BJ Status Monitor is
minimized on the Windows Taskbar, right-click the BJ Status Monitor
icon on the Taskbar and then select Close.

Note
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Error and warning display

If an error occurs, the BJ Status Monitor launches automatically. Check the meaning of the 
error in the Status box of the Printer Status tab first. Then click the Guide tab and refer to 
the information on the solution.

When the remaining ink is running low, the BJ Status Monitor displays a low ink warning 
icon in the Printer Status tab.

—Cyan is running low. —Black is running low.

—Magenta is running low. —Photo Cyan is running low.

—Yellow is running low. —Photo Magenta is running low.
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When the ink runs out, the  low ink warning icon is replaced with the  ink empty icon. 
For more details, click the Ink Information tab.

Even after the ink runs out, the printer continues to print for a while. 
However, it is recommended that you install a new ink tank.

Cancelling the print job

You can cancel the print job using the BJ Status Monitor. To cancel the print job, open the 
BJ Status Monitor and then click the Cancel Printing button in the Printer Status tab.

Note
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Switching the BJ Status Monitor

When you are using multiple bubble jet printers and launching the BJ Status Monitor of 
each printer as well, select the port to which the printer you wish to display is connected 
from the Port menu.

The BJ Printer Monitor displays all Bubble Jet printers installed in your 
system. To launch the BJ Status Monitor of a specific printer, double-click 
the printer name in the BJ Printers tab.

 Using the BJ Printer Monitor

�  Using the BJ Printer Monitor
The BJ Printer Monitor displays all Bubble Jet printers installed in your system. You can 
view information such as the printer status, printer port to which the printer is connected, 
and installed BJ cartridges.

You can also launch the BJ Printer Monitor for a desired printer.

About the operating environment

The following are the minimum requirements to run the BJ Printer monitor.

When using the parallel interface only:

• Check that your computer supports bi-directional communications.
• Check that your printer cable (interface cable) supports bi-directional 

communications.

Note
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When using the parallel or USB interface:

• Check that the settings to support bi-directional communications are enabled in 
the Windows operating system.

To check that the settings to support bi-directional communications are 
enabled in Windows, follow these steps:

(1) Open the Printer Properties dialog box from the Start menu.

(2) Click the Canon BJC-3000 icon in the Printers window, then select
Properties from the File menu.

(3) Click the Details tab.

(4) Click the Spool Settings button.

(5) Check that “Enable bi-directional support for this printer” is enabled in
the Spool Settings dialog box.

Launching the BJ Printer Monitor

1 From the Start menu, select Programs.

2 Point to BJ Printer, and then select BJ Printer Monitor.

 or

1 Double-click the BJ Printer icon on the Windows desktop.

2 Double-click the BJ Printer Monitor in the BJ Printer window.

Note
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Information display of the BJ Printer Monitor

Printer Name:
Shows the name of the printer installed in your system. The icon to the left 
of the printer name shows the printer status.

— Normal condition.

— A warning occurred for some reason.

— An error occurred for some reason.

Port:
Shows the port to which the printer is connected.

Status:
Shows a brief description about the printer status.

Cartridges:
Shows the type of the installed BJ cartridge.
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Ink Information:
Shows ink information when the remaining ink is running low or when it 
runs out.

Jobs:
Shows the number of print jobs that are currently being processed.

Other Information:
Shows information such as paper size and the availability of options (when 
using the BJC-3000, no information is displayed.)

• The following printers are not displayed in the BJ Printer Monitor:

A printer that is connected using a USB/parallel conversion cable

A printer that is being shared by other computers

• Make sure that the printer port setting is correct before using the BJ
Printer Monitor. For example, if you are using a printer which does not
support USB or infrared communication but the printer port is set to a
USB port or IrDA port, the printer is not displayed in the BJ Printer
Monitor.

Note
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• To close the BJ Printer Monitor, click the “X” button on the upper right
corner of the BJ Printer Monitor window. When the BJ Printer Monitor 
is minimized on the Windows Taskbar, right-click the BJ Printer Monitor
icon on the Taskbar and then select Close.

To view a printer connected using a USB interface cable, click the USB 
Connected Printer tab (Windows 98 only).

BJ Printer Monitor icon



187Using the Windows Printer Driver

Making the Most of the Printer Driver

• When you wish to refresh the information display of the BJ Printer
Monitor, select Refresh from the View menu.

• To launch the BJ Status Monitor from the BJ Printer Monitor screen,
select the desired printer name and then select Start Status Monitor
from the Printer Info menu. (You can also launch the BJ Status Monitor
by double-clicking the printer name.)

• For more details, refer to the online Help for the BJ Printer Monitor.

Note
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�  Cleaning the Print Head
Cleaning the print head clears the nozzles. There are two ways to clean the print head: 
normal print head cleaning and deep print head cleaning. Always execute normal print head 
cleaning first. If this does not correct the problem then execute deep print head cleaning.

Cleaning the print head consumes ink so clean the print head only when 
necessary.

Normal print head cleaning 

1 Open the Printer Properties dialog box, then click the Maintenance tab.

2 Click the normal print head cleaning icon in the Print Head Cleaning box.

Note
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3 When a confirmation message appears, make sure that the printer is 
turned on and then click the OK button. Print head cleaning begins.

Deep print head cleaning

1 Open the Printer Properties dialog box, then click the Maintenance tab.

2 Click the deep print head cleaning icon in the Print Head Cleaning box.

3 When a confirmation message appears, make sure that the printer is 
turned on and then click the OK button. Print head cleaning begins.

Print a Nozzle Check Pattern to confirm the success of normal print head 
cleaning.

 Printing a Nozzle Check Pattern

Note
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�  Printing a Nozzle Check Pattern
The Nozzle Check Pattern confirms whether the inks are being correctly ejected from the 
print head nozzles and whether the print head on the BJ cartridge is correctly aligned. Print 
the Nozzle Check Pattern when your printouts are streaked or the color tones are not 
correct, or after performing print head cleaning.

Printing a Nozzle Check Pattern

1 Open the Printer Properties dialog box, then click the Maintenance tab. 

2 Click the Nozzle Check Pattern icon in the Test Prints box.
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3 When a confirmation message appears, make sure that paper is loaded in 
the printer and the printer is turned on.

4 Click the OK button.

5 Look at the check patterns and perform the correction procedure.

If the cleaning had no effect, perform normal print head cleaning and deep 
print head cleaning again. After cleaning the print head several times, if the 
Nozzle Check Pattern is not satisfactory, the print head may be worn out 
and the BJ cartridge must be replaced.

 Replacing the BJ Cartridge

Note
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�  Aligning the Print Head
Each time you replace a BJ cartridge or switch BJ cartridges for a special print job, you 
must align the print head to ensure optimum results in printing.

Print head alignment

1 Open the Printer Properties dialog box, then click the Maintenance tab.

2 Click the Print Head Alignment icon in the Test Prints box.

3 When a confirmation message appears, make sure that the printer is 
turned on and one sheet of plain paper is loaded, and then click the OK 
button. The printer starts to print the standard head alignment pattern.

4 When the pattern is printed, click the Yes button.
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5 Check all the patterns in lines (B1) and (B2).

For each line, enter the appropriate number where you see the lines most 
perfectly aligned in (B1) and (B2).

When you finish entering numbers, click the OK button.

6 When a confirmation message appears, make sure that the printer is 
turned on and one sheet of plain paper is loaded, and then click the OK 
button. The printer starts to print the high-resolution head alignment 
pattern.

7 Check all the patterns in lines (B1) and (B2) again.

For each line, enter the appropriate number where you see the lines most 
perfectly aligned in (B1) and (B2).

When you finish entering numbers, click the OK button.

8 Click the OK button. 

This completes the manual print head alignment procedure.



195Using the Windows Printer Driver

Using Maintenance Functions

�  Cleaning the Paper Feed Rollers
With frequent use of High Resolution Paper and other coated paper, paper dust from the 
coated surfaces of such media accumulates around the paper feed rollers and may cause 
misfeeds and paper jams. If this occurs, use the special cleaning sheet (that comes with a 
package of High Resolution Paper) to clean the paper feed rollers inside the printer.

1 Open the Printer Properties dialog box, then click the Maintenance tab.

2 Click the paper feed roller cleaning icon in the Print Head Cleaning box.

3 When a confirmation message appears, make sure that the special 
cleaning sheet is set in the printer and the printer is turned on.

4 Click the OK button. Cleaning begins.
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�  Turning the Printer On and Off
You can turn the printer on and off from the Printer Properties dialog box.

The Auto Power On/Off capability of the printer driver also allows you to turn the printer off 
when no data is sent to the printer for a certain period of time, or turn the printer back on 
again when data is sent to the printer.

Turning the printer off

1 Open the Printer Properties dialog box, then click the Maintenance tab.

2 Click the Power-off icon.

3 When a confirmation message appears, click the OK button. The printer is 
turned off.

Next time you turn on the printer, press the POWER button of the printer.

Setting Auto Power on/off

1 Open the Printer Properties dialog box, then click the Maintenance tab.

2 Click the Power on/off icon.

Note
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3 Select the desired settings in the Auto Power dialog box.

Auto Power On:
Click the down-arrow and select either Enable or Disable. When this setting 
is enabled, the printer is turned on when data is sent to the printer. The 
default setting is Disable.

Auto Power Off:
Click the down-arrow and select the desired value. When no data is sent to 
the printer within the set time interval, the printer is turned off automatically. 
The default setting is Disable.

4 Make sure that the printer is turned on and click the Send button.

5 When a confirmation message appears, click the OK button.

When you wish to disable the Auto Power On/Off setting, select Disable for 
Auto Power On and Auto Power Off in the Auto Power dialog box.

Note
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�  Using the Special Settings
You can use some special settings that allow you to change the printer operation mode in 
the printer driver.

Changing the printer operation mode

1 Open the Printer Properties dialog box, and then click the Custom Setting 
button in the Maintenance tab. This displays the Custom Setting dialog box.

2 Change the printer operation mode, as needed.

Set printer to ECP mode (when using the parallel interface only)
Click this checkbox when you wish to use the ECP mode setting to operate 
the printer.

 Using ECP Mode

High-speed printing
Click this checkbox when you wish to shorten the response speed of the 
printer to enable high-speed printing.
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Pause Page
Click this checkbox when you wish to increase the pause between printed 
pages after performing high density printing. Use this setting to prevent the 
backs of pages from becoming stained after they are printed and ejected 
from the printer.

Pause Scan
Click this checkbox when you wish to increase the pause in the print head 
operation while the print job is being executed. Use this setting to prevent 
the next page from stacking on top of a printed page before it is dry.

3 Make sure that the printer is turned on and click the Send button.

4 When a confirmation message appears, click the OK button to close the 
dialog box and send the setting to the printer.



200Using the Windows Printer Driver

Using Maintenance Functions

�  Using ECP Mode
Normally, data transfer between the computer and printer are conducted using the 
“Centronics®-compatible” mode, which is a widely-used printer interface type.

You can change the data transfer method to ECP mode, as needed. The ECP mode makes 
it possible to conduct data transfer between the computer and printer at a higher speed 
while keeping compatibility with the former interface type. This shortens the time required 
for printing, depending on the computer system.

Before changing the data transfer method to the ECP mode, consider the 
following points:

• The computer system and printer cable you are using must support ECP 
mode. For details, contact your computer manufacturer.

• The parallel port must be set for ECP in the BIOS settings of your 
computer. When you change the BIOS settings of your computer system, 
be sure to refer to your computer’s documentation, or contact the 
computer manufacturer.

Note
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If the print job cannot be executed properly after changing the data transfer 
method to ECP mode, follow these steps:

(1) Click the Custom Setting button in the Maintenance tab.

(2) Uncheck the Set printer to ECP mode checkbox in the Custom Setting
dialog box.

(3) Click the Send button.

(4) Shut down Windows, then turn the printer off.

(5) Turn the printer back on again. The ECP mode setting is released.

Note
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�  Uninstalling the BJ Printer Driver
The printer driver may be updated to improve the performance of the printer. When you 
install a new version of the printer driver, delete the old version before installing the new 
version.

Uninstalling the BJ Printer Driver with the Uninstaller

When you use multiple Bubble Jet printers and wish to delete all the printer drivers for the 
Bubble Jet printers at the same time, use the Uninstaller feature.

1 Select Programs from the Start menu, then click BJ Printer.

2 Click Uninstall.

3 When a confirmation message appears, click the Yes button.

4 Click the OK button. This completes the uninstallation procedure.

Depending on the system you use, you may be prompted to restart the 
system. Click the OK button.
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• You can also delete all printer drivers for Bubble Jet printers at the same
time from the Windows desktop. Follow these steps:
(1) Double-click the BJ Printer icon on the Windows desktop.
(2) Double-click the Uninstall icon in the BJ Printer folder.

• When you wish to delete a specific printer driver, follow these steps:
(1) Select Settings from the Start menu, then click Printers.
(2) Select the icon of the printer driver you wish to delete in the Printers

window.
(3) Select Delete from the File menu.
(4) When a confirmation message appears, click the Yes button. 

• You cannot run the uninstaller while the BJ Printer Status Monitor 
is active.

Note
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Printer Driver Basics

The printer driver controls communication between the printer and your computer. To use 
the printer with your computer, you must install the printer driver. For instructions on 
installing the printer driver, refer to the Quick Start Guide.

A
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Preparing and Executing a Print Job

Before you start a print job, you need to specify the print settings. The print settings in the 
printer driver allow fine control over the print quality and color adjustment, but you can 
simplify the setup procedure as follows.

1 Set the paper size you use from within the application program before 
printing.

2 Select the command used for printing (for example, “Print” in the File menu) 
in the application program.

3 Select the most appropriate icon that indicates the print mode in the Printer 
Properties dialog box.

4 Specify the BJ Cartridge setting according to the BJ cartridge you are 
using. 

5 Specify the Media Type setting acording to the print media you are using.

6 Click the Print button. Printing begins.
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�  Selecting a Printer Driver
Before using the Page Setup dialog box and the Print dialog box, you must first go into 
Chooser in the Apple Menu and choose the correct printer driver for your type of 
connection. 

Once you have chosen the printer driver, it will remain selected. You will only need to 
choose it again if you change to another driver.

Selecting the printer driver using the Chooser

If the printer is directly connected to your Macintosh, use the procedure below to choose 
the printer driver.

1 Select Chooser from the Apple Menu. The Chooser is displayed.

2 Click the BJC-3000 icon.
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3 When you wish to perform background printing, set Backgrounding to On.

4 Click in the Close box to close the Chooser. A dialog box may appear with 
this message:

You have changed your current printer. 
Please choose “Page Setup” in all the open applications.

Simply click OK.

The BJC-3000 can now be used for printing.

 Using Background Printing 

 Using the Printer With a Network 

Close
box
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�  Changing the Page Setup Dialog Box Settings
The size of the paper to be used for printing is usually set when a document is created with 
an application. In your application, open the Page Setup dialog box and select the paper 
size that you want to use with your printer. (The default Paper Size is Letter.)

Selecting the page size and the orientation

You can open the Page Setup dialog box from your application program.

1 Select the command used for Page Setup in your application program.
Normally, click Page Setup from the File menu, and the Page Setup dialog 
box is displayed.

2 Click on Paper Size, and then select the appropriate paper size from the 
pop-up menu.
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3 Select Orientation.

4 Click the OK button.
The Page Setup dialog box closes.

Selecting the paper size (for custom paper sizes)

When you use custom paper sizes, select any one of Custom1 to Custom3.

1 Select the command used for Page Setup in your application program.
Normally, click Page Setup from the File menu, and the Page Setup dialog 
box is displayed.
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2 In Paper Size, select any one of Custom1 to Custom3 and then click the 
Custom button.

The Custom dialog box is displayed.

3 Select millimeters or inches for the unit of measurement in Unit and enter 
the desired width and height.
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4 Click the Apply button.

The Custom dialog box closes and the specified paper size is set.

• Any of Custom1 to Custom3 can be specified as the user-defined paper
size.

• To make the setting made with the Page Setup dialog box the default,
so that it is automatically selected whenever a new document is created,
place a check mark in the Save Settings checkbox.

Note
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�  Changing the Print Dialog Box Settings
Before you can start printing, a few basic settings must be made. Set the BJ Cartridge and 
Media Type settings to match your printer setup, then select the icon corresponding to the 
print mode which you want to use to print your document.

Setting the print mode and starting printing

1 Select the command used for Print in your application program.

Normally, click Print from the File menu, and the Print dialog box is 
displayed.

2 Type in the number of copies to be printed, and then set which pages are to 
be printed.

When only certain pages of a document are to be printed, enter the first 
and last print pages before and after To.

Note
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3 Select BJ Cartridge and Media Type.
Click the up- or down-arrow to display a pop-up menu. Select a mode 
according to the setup of your printer.

When a document created in color is to be printed out in monochrome, 
place a check mark in the Print Grayscale checkbox.

Note
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4 Select the Print Mode icon.
Select the icon that is closest to your document type and intended results.
The “Current settings” shows the name of the selected icon, along with 
information on the Halftoning and Color Correction.

Print Mode Icons

Text Prints documents made up primarily of text at normal 
quality.

Graphics Intended for printing graphs and other computer 
graphics with clear color boundaries.

Photo Intended for printing photographs and other graphics 
that use gradations of color and tone.

Manual Allows you to customize the print mode settings.

 Setting for Manual Printing

5 Click the Print button to close the Print dialog box and start the print job.
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Displaying a print preview of the document 

To view a preview of the document as it will appear when printed, click the Options... button 
and change the output destination.

1 Open the Print dialog box, and click the Options... button.
The Options dialog box is displayed.

2 Select Preview as the output destination, and click the OK button.

3 Click the Preview button in the Print dialog box.
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The Preview dialog box is displayed.

When the preview screen is displayed as a result of selecting manual for 
Print Mode, you can adjust the Color Balance and Density Settings. 

 Setting for Manual Printing

4 When you are satisfied with the document and want to print it, click the 
Print button. To close the preview screen without printing, click the Cancel 
button.

Note
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Saving a document as a PICT file

To save your document as a PICT file, click the Options... button and change the output 
destination.

1 Open the Print dialog box, and click the Options... button.
The Options dialog box is displayed.

2 Select PICT File as the output destination, and click the OK button.

3 Click the File button in the Print dialog box.
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4 Type in the name under which you want to save and click the Save button.

The document data is saved in PICT file format.
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�  How to Use Help
The printer driver has many helpful functions. To display an explanation of these functions, 
use the balloon help. When you position the cursor over a given item, a brief explanation of 
that item appears in a balloon.

Displaying balloon help

1 Select Show Balloons from the Help menu.

2 Display the printer driver screens (the Page Setup dialog box, the Print 
dialog box, etc.).

3 Position the cursor over the item for which you want to display an 
explanation. An explanation of the item is displayed.

To turn off the balloon help, select Hide Balloons from the Help menu.Note
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�  Printing Documents Enlarged/Reduced
The scaled printing feature of the printer driver allows you to set a scaling value so you can 
print an enlarged or reduced page on a paper size that is larger or smaller than the page 
size of the original file in the application program.

Setting the scaling value

Set a value between 25% and 400% as the enlargement/reduction scale in the Page Setup 
dialog box.

1 Open the Page Setup dialog box.
Normally, select Page Setup from the File menu.

2 Set Paper Size, as necessary.

3 Set the desired enlargement or reduction ratio in Scale.
Enter the value of the enlargement or reduction ratio. Alternatively, click the 
up- or down-arrow in Scale. 
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4 Click the OK button.
The Page Setup dialog box closes.

5 To start printing, click the Print button in the Print dialog box.
Normally, select Print from the File menu to open the Print dialog box.

• When you wish to revert Scaled Printing to the original value, set the 
original value (100%) in the Scale box.

• You can type in a Scale value from 25% to 400%. When clicking the 
arrows, the Scale values run from 50% to 200%.

Note
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�  Printing on Banner Paper

 Using Banner Paper

Setting banner printing

Place a check mark in the Banner Printing checkbox in the Page Setup dialog box.

1 Open the Page Setup dialog box. 
Normally, select Page Setup in the File menu.

2 Select Letter in Paper Size.

3 Click the Banner Printing checkbox to place an X in the box.

4 When a confirmation message appears, click the OK button.
The Page Setup dialog box closes.

5 Open the Print dialog box.
Normally, select Print from the File menu.
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6 Select Plain Paper in Media Type.

7 Click the Print button to close the Print dialog box and start the print job.

• Always set “1” in the Copies box in the Print dialog box. If you set
multiple copies, the data cannot be printed on the banner paper properly. 

• When you wish to return to normal printing, clear the check mark from
the Banner Printing checkbox. 

Note
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�  Printing Multiple Pages on One Sheet
By reducing the scale in a 2-up or 4-up layout, you can print multiple pages on one sheet of 
paper. You can save the total amount of paper used for long documents. This feature is also 
useful when you wish to view an image spread or print your document as a book cover.

Specifying the layout

Open the Options dialog box from the Print dialog box and make the necessary settings.

1 Open the Print dialog box.
Normally, select Print from the File menu.

2 Click the Options... button.
 The Options dialog box is displayed.

3 Click on Page layout and select the 2-up or 4-up layout from the pop-up 
menu.
The 2-Page Print setting prints two pages on one sheet of paper and the 
4-Page Print setting prints four pages on one sheet of paper. Confirm the 
layout of the printout in the Preview.
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4 Make the following settings, as necessary.

Page Order:
Click on Page Order. The illustration indicates the order in which the pages 
run (for example, running from top-left to top-right to bottom-left to bottom-
right in the 4-Page Print setting).

Frame:
When you print multiple pages of data on one sheet, this option allows you 
to select whether to add a border around each page. Click the up- or down-
arrow to select None, Fine line, or Broad line.

5 Click the OK button.
The Options dialog box closes.

6 Click the Print button to close the Print dialog box and start the print job.

When you wish to revert Page Layout printing to the original setting, select 
the 1-up layout in Page Layout.

Note
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�  Changing the Print Order 
Based on the default settings of the printer driver, the printer starts printing one set of any 
document from the first page. When two or more copies of the same data are to be printed, 
specify collation reverse order printing. This saves you from having to rearrange the copies 
after they have printed.

Setting the print order 

When you wish to print multiple copies of the same document, you can change the print 
order with “Print in reverse order” and “Print collate pages,” as necessary. 

1 Open the Print dialog box.
Normally, select Print in the File menu.

2 Click the Options... button.
The Options dialog box is displayed.

3 Set the print order using “Print in reverse order” and “Print collate pages,” 
as necessary.
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Print in reverse order:
Use this setting when you print a multiple page document. The printer 
starts printing from the last page of the document. When this setting is 
disabled, the printer starts printing from the first page of the document.

Print collated pages:
Use this setting when you print multiple copies of a multiple page 
document.
When Collate is enabled, the printer prints the document and collates each 
copy from the first page through to the last page.
When Collate is disabled, the printer prints the document and collates 
copies of the same page. In this case, you will need to manually combine 
the pages to create each set of a multiple-page document.

4 Click the OK button.
The Options dialog box closes.

5 Click the Print button to close the Print dialog box and start the print job.
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�  Setting for Manual Printing
Selecting the icon allows you to set your own printing parameters, including the quality, 
halftoning, and color balance and density. Also, once you have specified your custom 
settings, you can reapply those settings simply by clicking the icon.

Specifying the Print Settings manually

Select the icon from Print Mode in the Print dialog box. You can then set the items in the 
Quality panel and the Color panel.

1 Open the Print dialog box.
Normally, select Print from the File menu.

2 Click the icon in Print Mode.

3 Click the Details... button.
The Quality panel of the Detailed Setting dialog box is displayed.
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4 Set Print Quality or Halftoning, as necessary.

 Changing the Print Quality/Halftoning

 Photo Optimizer 
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5 When you wish to adjust the color settings, click the Color icon. 
The Color panel is displayed.

 Adjusting the Image Data

6 When you have completed the settings, click the OK button.
Then return to the Print dialog box.

7 Click the Print button to close the Print dialog box and start the print job.

When the same print mode setting is to be used the next time you print, 
select the icon from Print Mode in the Print dialog box.

Note
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�  Changing the Print Quality/Halftoning
When your printouts are not satisfactory, the printer driver allows you to make fine 
adjustments to the print quality and halftoning settings. If there is a problem in the image 
data you wish to print, changes to the print quality and halftoning settings may not be visible 
or effective.

Adjusting the print quality

When you wish to specify detailed Print Quality and Halftoning, select the icon in Print 
Mode. 

1 Open the Print dialog box. 
Normally, select Print from the File menu.

2 Select the icon in Print Mode.

3 Click the Details... button.
The Quality Panel of the Detailed Setting dialog box is displayed.
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4 Set the print quality.
The further you move the slide bar toward the right, the better the print 
quality will be, but the longer it will take to perform the printing. The print 
mode display varies with the position of the slide bar.
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5 Select the Halftoning icon, as necessary.
The halftoning selection determines the way in which the ink dots are 
arranged on the page, and changes the appearance of halftones.

Pattern:
Dots of different colors are arranged in a specified order.
Select this option when you want to print graphics with clearly defined color 
boundaries or graphs in which large areas are filled with the same color.

Scatter:
Dots of different colors are arranged at random.
Select this option when you want to print images with blurred boundaries 
and fine gradations of tone and color. This setting is best for printing 
photographs.

6 Click the OK button. You return to the Print dialog box.
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7 Click the Print button to close the Print dialog box and start the print job.

• Some Print Quality settings cannot be selected depending on the
setting made for Halftoning. To obtain the best quality printing, select
Scatter.

• Some settings cannot be selected depending on the type of BJ
cartridge and the selected paper type. In such cases, make the
necessary adjustments within the supported range.

Note
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�  Optimizing Image Data
The Photo Optimizer adjusts a photographic image created by a scanner or a digital 
camera when it is printed out. Use the Photo Optimizer to compensate for unsatisfactory 
color balance and over- or under-exposure before printing.

Photo Optimizer

Place a check mark in the Photo Optimizer checkbox in the Detailed Settings dialog box.

1 Open the Print dialog box.
Normally, select Print from the File menu.

2 Select the icon in Print Mode.

3 Click the Details... button.
The Quality Panel of the Detailed Setting dialog box is displayed.
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4 Place a check mark in the Photo Optimizer checkbox.

5 Click the OK button. You return to the Print dialog box. 

6 Click the Print button to close the Print dialog box and start the print job.
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�  Adjusting the Image Data
When the color reproduction of your printouts is unsatisfactory, you can adjust the color 
balance and density as needed.  Use this feature only when you wish to make fine 
adjustments to the color balance in the printouts, and do not change the settings 
excessively. (Please note that this feature does not compensate the overall color balance of 
the image data as some application programs for editing image data would do.)

Adjusting the colors

Select the icon in Print Mode and then click the Color icon in the Detailed Setting dialog 
box. 

1 Open the Print dialog box.
Normally, select Print from the File menu.

2 Select the icon in Print Mode.

3 Click the Details... button.
The Quality panel is displayed.
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4 Click the Color icon.
The Color panel is displayed. 

5 Set the following items as needed.
Color Correction
BJ Standard: Applies the optimum color correction for printing with a BJ 

printer.  Normally, you will select this setting.
ColorSync: Selected when color correction is performed with 

ColorSync.
None: Selected when color correction is not to be applied.

Matching Method
This sets the color representation method.
Photo: For printing overlapping intermediate color.
Graphic: To print primary color more brightly.
Spot Color: To print documents that use large amounts of a basic color.
Auto: To automatically select the ideal matching for the image 

data. 
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Printer Profile
This selects the profile to suit the type of document. Generally, you will use 
the Recommended by Canon setting.
Recommended by Canon lists the color features that are suitable for the BJ 
cartridge, paper size, print quality, halftoning, etc.

Gamma Correction
Gamma Correction enables the adjustment of halftone contrast between 
perfect white and perfect black.
If you want to adjust the contrast, place a check in this box and move the 
slider left or right to set a value.
When Gamma Correction is not to be performed, clear the check mark from 
the checkbox.

Color Balance
The color intensity is set separately for cyan, magenta, yellow, and black.
The color intensity is adjusted by dragging the slide bar for each color to the 
right or left. For example, if you feel that the blue (cyan) component is too 
strong, drag that slider in the negative direction (to the left). On the other 
hand, if you think that the blue (cyan) is too weak, drag the slider in the 
positive direction (to the right). Once you have made the adjustment, the 
balance of the four colors changes and the overall color tone changes as 
well. It’s a good idea to make such adjustments in very small steps.

Density
Moving the slider to the right increases the density while moving it to the left 
decreases the density.
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6 Click the OK button. Then return to the Print dialog box. 

7 Click the Print button to close the Print dialog box and start the print job.

�  Registering and Managing Print Settings
You can name the settings in the Print dialog box (such as BJ Cartridge, Media Type, Print 
Grayscale, and Print Mode) when you perform registration. You can set default mode for any 
setting that is used often.

Registering print settings

You can use names to register the contents of those settings that are performed with the 
Print dialog box.

1 Open the Print dialog box, and then select options as needed.

2 Click the Apply button.
The Register Settings dialog box is displayed.

3 Click the Apply button.
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4 Type in the name under which you want to register the settings and then 
click the OK button.

You return to the Register Settings dialog box.

5 Click the Close button.
You return to the Print dialog box.

You cannot specify a name that is already being used for a set of print 
mode settings. Use a different name, or remove the settings with that name 
before you register the new settings. 

Importing registered print setting

You can read in a previously registered print mode and set it as the Print dialog box for the 
icon.

1 Open the Print dialog box and click the Apply... button.
The Register Settings dialog box is displayed.

Note
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2 Click on the print mode setting you want to import and then click the Import 
button.

3 Click the Close button.
You return to the Print dialog box.

When a registered Print Mode is to be set as the default (so this print mode 
is always selected when the Print dialog box is open), select its name in the 
Register Settings dialog box and click the Defaults button. If a check mark 
is shown next to a name, it indicates that the print mode is set as the 
default.

Removing registered print settings

When a registered print mode is no longer necessary or you want to register a different 
setting under the same name, delete it by following these steps:

1 Open the Print dialog box and click the Apply... button.
The Register Settings dialog box is displayed.

Note
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2 Click the print mode setting you want to remove and then click the Remove 
button.

3 When a confirmation appears, click the OK button.
The selected print setting is removed from the list.

4 Click the Close button. You return to the Print dialog box.

• Factory Defaults cannot be deleted.

• Once you delete a print setting, you cannot restore it. If you need it, 
you will have to go through the entire setting process again.

Note
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�  Using Background Printing
If background printing is selected with the Chooser, you can open the BJ PrintMonitor to 
confirm the progress of printing or to stop printing.

Also, the order in which suspended documents are printed can be changed.

About background printing

The print processing method which enables you to do other tasks simultaneously while 
printing documents is called “Background Printing.” When background printing is to be 
performed, select Chooser from the Apple Menu, select a printer driver, and set 
Backgrounding to On.

 Selecting a Printer Driver

While background printing is being performed, you can display the BJ PrintMonitor to 
confirm the progress of printing or to stop the printing.

Displaying the BJ PrintMonitor window

When Backgrounding is set to On, the BJ PrintMonitor starts up automatically when you 
print. The BJ PrintMonitor appears in the Application Menu.

To verify the print process, click the BJ PrintMonitor icon in the Application Menu.
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Closing the BJ PrintMonitor window

When you select Close Status Window from the File menu, the BJ PrintMonitor window 
closes.

BJ PrintMonitor Function

The BJ PrintMonitor shows the document currently being printed and a list of the 
documents queued for printing.

Print queue document information includes the document name, number of pages, number 
of copies, and the time when the print job was accepted. The total number of print queue 
documents is displayed in the bottom row.
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The BJ PrintMonitor makes it possible to perform the following tasks.

• The order of the documents in the print queue can be changed.
Position the cursor over the name of the document whose position you want to 
change and drag it to the desired position in the queue while holding down the 
mouse button. When you release the button, the document moves to the 
selected position.

You can temporarily suspend the printing of one document so that another 
document in the print queue can be printed out.

• Printing can be stopped.
Click the name of the document name for which you want to stop printing and 
then click the icon. The selected document is deleted from the list.

Suspends printing of the document. Restarts 
the printing of the document.

Suspends the printing of specified documents 
only.

Restarts the printing of the documents 
suspended with .

Stops printing of the specified document.

Control Buttons

Shows information about the document currently being 
printed.

The icon on the left gradually fills with black as printing 
proceeds.

Lists the names of the queued documents.
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• Printing can be suspended/restarted.
Click the name of the document for which you want to suspend printing and then 
click the . 

To restart printing, click the icon.
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�  Using the Printer With a Network
The BJC-3000 can be connected to a network. To enable use of the printer from any 
computer connected to the network, the necessary printer driver must be installed on each 
computer.

Connection environment and installation

• The BJC-3000 can be connected to an Ethernet environment.
• Install the printer driver on all the computers that will use this printer.

See your Quick Start Guide.

• The printer must be connected to the computer acting as the print server via a 
USB interface cable. The print server and the client machines use different 
printer drivers and different tools to confirm printing progress. Refer to the 
example shown below.

Print Server

USB interface cableEthernet
Environment

Client machine Client machine

Client machineClient machine

Client machine

BJC-3000
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Print server
Refers to the computer to which the printer is directly connected via a USB interface cable. 
On the print server, select the printer driver called BJC-3000. From the print server, the 
progress of printing can be confirmed using the BJ PrintMonitor.

Client machine
Refers to a computer that is connected to the print server via an Ethernet network. From a 
client machine, select the printer driver called BJC-3000 (Server). When printing is 
executed, data is sent to the printer via the print server. Although the BJ PrintMonitor 
cannot be started from a client machine, the progress of printing can be confirmed by 
starting the BJ StatusMonitor on the print server.

Selecting the printer driver

To use the printer with a network, the correct printer driver must be installed on each 
computer. The print server must be set up first. Then, the necessary settings are made for 
each client machine.

Setting up the print server

1 Select Chooser from the Apple Menu.
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2 Select the BJC-3000 icon and select the printer name from “Connected 
to:”.

3 Click the Share button.

4 Confirm that BJC-3000 Server is selected for “Enter new print server 
name:”, and then click the Send button.
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5 Confirm that a new print server name has been added to “Current print 
servers,” and then click the Close button.

6 Click the close box to close the Chooser.

Setting up client machines

1 Select Chooser from the Apple Menu.

2 Select the BJC-3000 (Server) icon and select the print server in 
“Connected to:”.

3 Click the close box to close the Chooser.
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Confirming the status of the print server from a client machine

When the progress of printing with the print server is to be confirmed in the BJ PrintMonitor, 
start the BJ StatusMonitor.

Starting the BJ StatusMonitor

Double-click the BJ StatusMonitor icon in the BJ Extras folder.

Closing the BJ StatusMonitor window

Select Quit from the File menu to close the BJ StatusMonitor.
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Functions of the BJ StatusMonitor

The progress of print jobs being performed by the print server machine can be 
confirmed using the BJ StatusMonitor. A list of documents that are currently 
being printed as well as those in the print queue is displayed. The information 
related to the jobs in the print queue includes the document name, number of 
pages, number of copies, and the time at which the print job was accepted. The 
total number of documents in the print queue is displayed in the bottom row.

The following operations can be performed with the BJ StatusMonitor. Note, 
however, that the owner of the client machine and the owner of the document 
must be the same. If you double-click a document name, you can determine the 
owner of the print job.

Suspends the printing of specified documents 
only.

Restarts printing of the documents suspended 
with .

Stops printing of the specified document.

Functions of the buttons

Displays information related to the document currently 
being printed.

The icon on the left gradually fills with black as printing 
proceeds.

Lists the names of the queued documents.
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• Stop printing
Click the name of the document for which you want to stop printing and 
then click the icon. The selected document is deleted from the list.

• Suspend/Restart printing
Click the name of the document for which you want to suspend printing 
and then click the icon. To restart printing, click the icon.

• The owner of a computer can be determined from the Owner Name item
after selecting File Sharing from the Control Panel.

• When you are using two or more print servers, you can switch the
display of BJ StatusMonitor. Select the desired print server from Print
Server and then click the OK button. You can then switch the display 
of the BJ StatusMonitor.

Note
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Cleaning the Print Head

Printing a Nozzle Check Pattern

Aligning the Print Head

Cleaning the Paper Feed Rollers

Turning the Printer On and Off

Special Settings

Uninstalling the Printer Driver
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�  Cleaning the Print Head
Cleaning the print head clears the nozzles. There are two ways to clean the print heads: 
normal print head cleaning and deep print head cleaning. Always execute normal print head 
cleaning first. If this does not correct the problem then execute deep print head cleaning.

Cleaning the print head consumes ink, so clean the print head only when 
necessary.

Normal print head cleaning 

1 Open the Page Setup dialog box.
Normally, select Page Setup from the File menu.

2 Click the Utilities button.

3 After confirming that Print Head Cleaning is selected in the drop-down 
menu, click the icon.

Note
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4 When a confirmation message appears, make sure that the printer is 
turned on and then click the OK button. Print head cleaning begins.

5 Print a Nozzle Check Pattern to confirm the success of print head cleaning.

 Printing a Nozzle Check Pattern

Deep print head cleaning carries out more intensive cleaning.

1 Open the Page Setup dialog box. 
Normally, select Page Setup from the File menu.

2 Click the Utilities button.

3 After checking that Print Head Cleaning is selected, click the icon.

4 When a confirmation message appears, make sure that the printer is 
turned on and then click the OK button. Print head cleaning begins.

5 Print a Nozzle Check Pattern to confirm the success of print head cleaning.

 Printing a Nozzle Check Pattern
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�  Printing a Nozzle Check Pattern
The Nozzle Check Pattern confirms whether the inks are being correctly ejected from the 
print head nozzles. Print the Nozzle Check Pattern when your printouts are streaked or the 
color tones are not correct, or after print head cleaning has been executed.

Printing a Nozzle Check Pattern

1 Open the Page Setup dialog box.
Normally, select Page Setup from the File menu.

2 Click the Utilities button. 

3 Select Test Print, then click the icon.

4 When a confirmation message appears, make sure that paper is loaded in 
the printer and the printer is turned on. Then click the OK button.
The Nozzle Check Pattern is printed.
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If the cleaning had no effect, perform normal print head cleaning and deep 
print head cleaning again. After cleaning the print head several times, if the 
Nozzle Check Pattern is not satisfactory, the print head may be worn out 
and the BJ cartridge must be replaced.

 Replacing the BJ Cartridge

Note
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�  Aligning the Print Head
Each time you replace a BJ cartridge or switch BJ cartridges for a special print job, you 
must align the print head to ensure optimum results in printing.

Aligning the print head

1 Open the Page Setup dialog box.
Normally, select Page Setup from the File menu.

2 Click the Utilities button.

3 Select Test Print, then click the icon.

4 When a confirmation message appears, make sure that the printer is 
turned on and that plain paper is loaded in the printer. Then click the 
OK button. 
The pattern for basic resolution is printed.
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5 Enter the values corresponding to the best printed pattern in (B1) and (B2) 
and then click the Send button.

6 When a confirmation message appears, make sure that the printer is 
turned on and that plain paper is loaded in the printer. Then click the OK 
button. 
The high-resolution pattern is printed.

7 Enter the values corresponding to the best printed pattern in (B1) and (B2) 
and then click the Send button.
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�  Cleaning the Paper Feed Rollers
With frequent use of High Resolution Paper or other coated papers, paper dust from the 
coated surfaces of the paper accumulates around the paper feed rollers and may cause 
misfeeds and paper jams. If this occurs, use the special cleaning sheet provided in the 
package of High Resolution Paper to clean the paper feed rollers inside the printer.

Cleaning the paper feed rollers

1 Open the Page Setup dialog box.
Normally, select Page Setup from the File menu.

2 Click the Utilities button.

3 After checking that Print Head Cleaning is selected, click the icon.

4 When a confirmation message appears, make sure that the special 
cleaning sheet (that came with the High Resolution Paper) is set in the 
printer and the printer is turned on. Then click the OK button. Cleaning 
begins.
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�  Turning the Printer On and Off
The Auto Power On/Off capability of the printer driver allows you to turn the printer off when 
no data is sent to the printer for a certain period of time and turn the printer back on again 
when data is sent to the printer.

Turning the printer on and off

1 Open the Page Setup dialog box.
Normally, select Page Setup from the File menu.

2 Click the Utilities button.

3 Click Auto Power Setting, and then select the auto power settings Auto 
Power On and Auto Power Off, as necessary. Click the Send button.
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Auto Power On:
When this setting is enabled, the printer is turned on when data is sent to 
the printer.
The default setting is off.

Auto Power Off:
When no data is sent to the printer for the set time, the printer is turned off 
automatically.
The default setting is off.

4 When a confirmation message appears, click the OK button.

When Auto Power On/Off is to be cancelled, remove the check mark from 
each checkbox using the same procedure.

Note
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�  Special Settings
With the special settings in the Print Utility dialog box, you can change the printer’s mode 
settings and printer driver to change its operation.

Use the Chooser to change the driver-supported resolution.

Changing the printer’s mode 

A pause can be specified to allow the most recent printout to dry, or to adjust the print head 
position.

1 Open the Page Setup dialog box.
Normally, click Page Setup from the File menu.

2 Click the Utilities button.

3 Select Special Settings, and then place a check mark in the checkboxes 
corresponding to the required settings. Click the Send button.
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Pause Between Pages
Inserts a pause after completing high-density printing of a page. Select this 
item, by setting it to On, if you find that print quality is being affected by the 
next page being fed before the ink on the previous page has completely 
dried.

Pause Between Scanning
Inserts a pause between passes of the print head. Select this item, by 
setting it to On, if you find that the printed pages are not drying well.

4 When a confirmation message appears, click the OK button.
This completes changing the printer’s mode.

Changing the driver-supported resolution

The driver-supported resolution is usually set to Standard. Try changing this setting.

1 Select Chooser from the Apple menu.

2 Click the BJC-3000 icon.
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3 Click the Setup button.

4 Click on Driver-Supported Resolution and select High from the pop-up 
menu.

5 Click the OK button.

6 Click the close box to close the Chooser.
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�  Uninstalling the Printer Driver
When the Printer Driver is no longer necessary, you can remove an installed printer by 
selecting “Custom remove.” The “Custom remove” option allows you to remove just those 
files that are not needed when you change your computer environment.

Uninstalling the printer driver with the Custom remove

1 If there are any unsaved documents in applications that are currently 
running, save your documents. 

2 Double-click BJC-3000-01 folder and then double-click Printer Driver folder.

3 Double-click the BJ Installer icon.

4 When the Software License Agreement is displayed, click the Agree 
button.

5 Click on “BJC-3000” to highlight it and click the Choose button.
The BJC-3000 Script Screen appears.

6 Click the Custom remove tab.
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7 Place a check mark in the “Software for use with QuickDraw” checkbox.

8 Click the Remove button.

9 When a confirmation message appears, click the Continue button.
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10 When a confirmation message appears, click the Restart button.
Your computer restarts.
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Printing Photographs

Tips for Printing Photographic Images

About Photo Optimizer
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Tips for Printing Photographic Images

To produce the best possible print quality for printing photographic images from a digital 
camera or scanner, or photographic images downloaded from a home page on the Internet, 
follow these guidelines:

• Use the BC-34 Photo BJ Cartridge.
• Use special media designed for reproducing photographs.
• Use correct print settings in the printer driver.

1 Make sure that the printer is switched on.  Also make sure that the BC-34 
Photo BJ Cartridge is installed in the cartridge holder.

2 Load special print media in the auto sheet feeder of the printer.
Excellent prints of photographs can be obtained with plain paper; for 
superior color reproduction, using one of the following special media is 
recommended.

• High Resolution Paper 
• Glossy Photo Paper 
• Glossy Photo Cards 

 Loading Paper and Other Media
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3 Open the Printer Properties dialog box and select SuperPhoto in the 
Choose Print Mode box under the Main tab.

When SuperPhoto is selected, the BJ Cartridge setting automatically 
changes to Photo so you can use the four different types of inks provided 
by the Photo BJ Cartridge.

4 Click the OK button to close the Printer Properties dialog box.

5 Start the print job.

3 Select the command used for printing (for example, “Print” from the File 
menu) to open the Printer Properties dialog box.

4 Select the Photo icon in the Printer Properties dialog box.

5 Select Photo in the BJ Cartridge setting, and click the Print button.

For optimum reproduction of all the color tones, make sure that the Media 
Type setting is correct for the media you have loaded in the printer.

Windows

Macintosh

Note
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About Photo Optimizer

The Photo Optimizer adjusts a photographic image created with a digital camera device 
when it is printed out.  Use the Photo Optimizer to compensate unsatisfactory color balance 
and over- or underexposure before printing.

1 Open the Printer Properties dialog box, then click the Main tab.

2 Click the Advanced button.

3 Select Photo Optimizer in the Quality tab.

4 Check the Whole Page checkbox, if necessary. 

Enabled:
When the Whole Page setting is enabled, the Photo Optimizer adjusts 
multiple photographic images appearing on the same page separately.  
Use this setting when any trimmed or rotated images are contained in the 
page.

Disabled:
When the Whole Page setting is disabled, the Photo Optimizer adjusts 
multiple graphic images appearing on the same page as a whole.

Windows
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About Photo Optimizer

1 Open the Photo Optimizer in the Quality panel. The Photo Optimizer 
feature works on the image that is edited using the edit menu such as 
“Cut” and “Rotate” in a graphics application program.

Macintosh

Disabled Enabled
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Routine Maintenance

Prolonging the Service Life of the Printer

BJ Cartridge Maintenance 

When to Replace the BJ Cartridge

Printing a Nozzle Check Pattern

Cleaning the Print Head

Replacing the Ink Tanks

Replacing the BJ Cartridge

Aligning the Print Head

Cleaning the Printer

Cleaning the Paper Feed Rollers

Transporting the Printer
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Prolonging the Service Life of the Printer

To ensure a long service life for your printer, clean it frequently and replace consumable 
items such as the BJ cartridges when required.  Before you move the printer to a new 
location, pack it in its original box and packing material to prevent damage during shipping.

Guidelines for replacement of consumable items:

 BJ Cartridge Maintenance

 When to Replace the BJ Cartridge

How to maintain the printer:

 Cleaning the Printer

 Cleaning the Paper Feed Rollers

How to pack the printer for moving:

 Transporting the Printer
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BJ Cartridge Maintenance

Over time, ink tanks run out and require replacement, and eventually the BJ cartridges also 
require replacement after the print heads wear out.  The following topics regarding BJ 
cartridge maintenance describe how to check the status of the BJ cartridges and take the 
appropriate actions to correct problems.

 Printing a Nozzle Check Pattern

 Cleaning the Print Head

 Replacing the Ink Tanks

 Replacing the BJ Cartridge

 Aligning the Print Head
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When to Replace the BJ Cartridge

If your printout appears streaked or blurred, open the front cover of the printer and visually 
check the level of the ink in all the ink tanks.  If remaining ink is low or has run out, replace 
it.

 Replacing the Ink Tanks

If an ink tank runs out of ink, the POWER light may flash orange four times 
and the BJ Status Monitor for Windows starts up to display a message to 
warn you that an ink tank has run out of ink.

After you replace the ink tank(s), if there are still signs of poor quality in 
your printing, follow the procedure outlined in the flow chart on the next 
page.

Note
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When to Replace the BJ Cartridge

 Printing a Nozzle Check Pattern

 Cleaning the Print Head (Normal print head cleaning)

 Cleaning the Print Head (Deep print head cleaning)

 Replacing the BJ Cartridge

 Aligning the Print Head

Nozzle check pattern poor quality?

Nozzle check pattern poor quality?

Nozzle check pattern poor quality?

Print a nozzle check pattern

Execute normal print head cleaning

Execute deep print head cleaning

Replace the BJ cartridge

Execute print head alignment
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Printing a Nozzle Check Pattern

The Nozzle Check Pattern confirms whether the inks are being correctly ejected from the 
print head nozzles and whether the print head on the BJ cartridge is correctly aligned.  Print 
the Nozzle Check Pattern when your printouts are streaked or the color tones are not 
correct, or after you perform print head cleaning.

1 Open the Printer Properties dialog box.

2 Click the Maintenance tab.

3 Click the Nozzle Check Pattern icon in the Test Prints box.

1 Select Page Setup from the File menu.

2 Click the Utilities button.

3 Select Test Print by clicking the up- or down-arrow.

4 Select the Nozzle Check Pattern icon.

Windows

Macintosh
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Printing a Nozzle Check Pattern

You can print a Nozzle Check Pattern with the printer driver or with the 
RESUME button on the printer.  To print the Nozzle Check Pattern from the 
operation panel, press and hold down the RESUME button until the 
POWER light flashes twice, and then release it.

5 When a confirmation message appears, make sure that paper is loaded in 
the printer and the printer is switched on.

6 Click the OK button.

7 Look at the check patterns and perform the correction procedure.
Separate patterns are printed to display the status of the BJ cartridge.

Note
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Printing a Nozzle Check Pattern

If patterns (1) are broken or missing, print head cleaning is required.
 Cleaning the Print Head

If patterns (2) are not overlapped perfectly, print head alignment is required.
 Aligning the Print Head

Each pattern indicates the status of the nozzles of the BJ cartridges 
installed in the printer.

(1)

BC-33 Color Cartridge or
BC-34 Photo Color Cartridge 

BC-30 Black Cartridge

(1)

(2)(2)

(1) Nozzle check pattern
(2) Print head alignment check pattern for

BJ cartridge

(1) Nozzle check pattern
(2) Print head alignment check pattern for

BJ cartridge

Note
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Cleaning the Print Head

Cleaning the print head clears the nozzles.  There are two ways to clean the print head: 
normal print head cleaning and deep print head cleaning.  Always execute normal print 
head cleaning first.  If this does not correct the problem, then execute deep print head 
cleaning.

Cleaning the print head consumes ink, so clean the print head only when 
necessary.

�  Normal print head cleaning

1 Open the Printer Properties dialog box.

2 Click the Maintenance tab.

Note

Windows
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Cleaning the Print Head

3 Click the first (left) Print Head Cleaning icon in the Print Head Cleaning box.

1 Select Page Setup from the File menu.

2 Click the Utilites button.

3 Select the Print Head Cleaning icon.

You can also start print head cleaning with the RESUME button on the 
printer.  Press and hold down the RESUME button until the POWER light 
flashes once, and then release it.

Macintosh

Note
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Cleaning the Print Head

4 When a confirmation message appears, make sure that the printer is 
switched on and then click the OK button.  

Print head cleaning begins. (It takes about 40 seconds to complete print 
head cleaning and the POWER light stops flashing.)

5 Print a Nozzle Check Pattern to confirm the success of normal print head 
cleaning.

 Printing a Nozzle Check Pattern

MacintoshWindows
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Cleaning the Print Head

�  Deep print head cleaning

Always execute normal print head cleaning first. Only when the normal 
print head cleaning does not correct the problem, perform deep print head 
cleaning.

1 Open the Printer Properties dialog box.

2 Click the Maintenance tab.

3 Click the Print Head Deep Cleaning icon in the Print Head Cleaning box.

Note

Windows
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Cleaning the Print Head

1 Select Page Setup from the File menu.

2 Click the Utilities button.

3 Select the Print Head Deep Cleaning icon.

Macintosh
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Cleaning the Print Head

4 When a confirmation message appears, make sure that the printer is 
switched on and then click the OK button.  

Print head cleaning begins. (It takes about two minutes to complete print 
head cleaning and the POWER light stops flashing.)

5 Print a Nozzle Check Pattern to confirm the success of deep print head 
cleaning.

 Printing a Nozzle Check Pattern

If the cleaning had no effect, perform normal print head cleaning and deep 
print head cleaning again.  After cleaning the print head several times, if the 
Nozzle Check Pattern is not satisfactory, the print head may be worn out 
and the BJ cartridge must be replaced.

 Replacing the BJ Cartridge

MacintoshWindows

Note
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Replacing the Ink Tanks

When you purchase extra ink tanks, make sure that you get the correct ink 
tanks for each BJ cartridge.

• For BC-33 Color BJ Cartridge: 
BCI-3BK Ink Tank
BCI-3C Ink Tank 
BCI-3M Ink Tank 
BCI-3Y Ink Tank

  BC-33 Color BJ Cartridge 

• For BC-34 Photo BJ Cartridge: 
BCI-3PBK Photo Ink Tank 
BCI-3PC Photo Ink Tank 
BCI-3PM Photo Ink Tank 
BCI-3Y Ink Tank

  BC-34 Photo BJ Cartridge

• For BC-30 Black BJ Cartridge:
BCI-3BK Ink Tank

  BC-30 Black BJ Cartridge 

Movie

Note
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Replacing the Ink Tanks

1 Make sure that the printer is switched on and open the front cover.  The 
cartridge holder moves to the left side.

• If you need to replace more than one ink tank, do not remove the ink 
tanks together.  Remove and replace each ink tank one by one to ensure 
that each new ink tank is inserted in the correct slot.  If you insert an ink 
tank in the wrong slot, colors will not print correctly.

• To avoid interfering with the ink supply from a tank, never touch the
opening on an ink tank.

2 To remove the empty ink tank, press in on the tab on the ink tank to release 
it; then lift it out of the slot.

Do not remove the BJ cartridge!  Leave the BJ cartridge installed in the 
printer and remove only the ink tank(s).

Note

Fix tab
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Replacing the Ink Tanks

• Discard empty ink tanks according to the local laws and regulations
regarding disposal of consumables.

• To avoid staining your hands, clothing, or areas of your work site, do not
shake or drop ink tanks when you are handling them.

3 Remove the new ink tank from its package.  Pull the orange tape up and 
against the perforations to open the packing film.

• Remove the film carefully so you do not remove the label from the ink 
tank.  The label is needed to match the ink tank with the correct slot of
the BJ cartridge.

• Remove the film by pulling on the orange tape.  Do not attempt to
remove the film before you remove the orange tape.

Note

Note
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Replacing the Ink Tanks

4 Grip the bottom of the ink tank and twist off the orange protective cap in the 
direction of the arrow.

Do not attempt to reattach a protective cap to an ink tank.  Discard the 
protective cap immediately.

Protective cap

To prevent ink spills, do not press this side of the ink tank.

Note
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Replacing the Ink Tanks

5 Hold the new ink tank at a slight angle and align it with the correct slot. 
Then insert the ink tank in its place.

Make sure you insert the ink tank into the correct slot of the cartridge 
holder.

The correct array of ink tanks in the BJ cartridges is shown below.Note

BJC-3BK BJC-3C BJC-3M BJC-3Y BJC-3PBK
Photo

BJC-3PC
Photo

BJC-3PM
Photo

BJC-3Y BJC-3BK

BC-33 
Color BJ Cartridge

BC-34 
Photo BJ Cartridge

BC-30 
Black BJ Cartridge
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Replacing the Ink Tanks

6 To lock the ink tank in place, press down on top of the ink tank.  Press down 
until the ink tank locks in place with a click.

7 Close the front cover.

The cartridge holder returns to the home position, and print head cleaning 
begins automatically.

The POWER light flashes during print head cleaning.  When print head 
cleaning is complete and the POWER light stops flashing, you can resume 
normal operation.
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Replacing the BJ Cartridge

If print quality remains poor even after replacing the ink tanks and cleaning the print head, 
the print head is worn out and you must replace the BJ cartridge.

Use only the following BJ cartridges with the BJC-3000 printer:

• BC-30 Black BJ Cartridge 
• BC-33 Color BJ Cartridge 
• BC-34 Photo BJ Cartridge 

1 Make sure that the printer is switched on and open the front cover.  The 
cartridge holder moves to the left side.

Movie

Note
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Replacing the BJ Cartridge

2 Raise the cartridge lock lever to unlock the BJ cartridge.
Make sure that you raise the lever all the way up.

To avoid staining your hands, clothing, or areas in your work site, handle 
the BJ cartridge carefully.  Avoid dropping or shaking the BJ cartridge.

Cartridge lock lever

Note
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Replacing the BJ Cartridge

3 Remove the entire BJ cartridge with the ink tanks in place.

• If you are removing a partially used BJ cartridge, store it in the Ink
Cartridge Storage Box.

 Notes on Handling BJ Cartridges

• Always hold the BJ cartridge by the handles embossed on the left and
right sides of the BJ cartridge.  Do not touch the metal contacts or the
print head on the BJ cartridge.

Note



302Routine Maintenance

Replacing the BJ Cartridge

4 Remove a new BJ cartridge from its package.  Remove the orange 
protective cap then slowly remove the orange protective tape.

• Never attempt to reattach the tape or cap to the BJ cartridge.  Discard
the protective cap and tape immediately.

• To avoid poor print quality, never touch the print head area of the 
BJ cartridge.

Protective tape

Protective cap

Note
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Replacing the BJ Cartridge

5 Set the BJ cartridge in the cartridge holder, then lower the cartridge lock 
lever until it locks in place.

When you install the BC-30 Black BJ Cartridge, insert it into the right side 
of the cartridge holder.

6 Press in on the tabs of the protective cartridge inserts and remove them.

Note

Fix tabs
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Replacing the BJ Cartridge

7 Insert the ink tank(s) in the new BJ cartridge.

You can use new ink tanks or the ink tanks from the worn BJ cartridge.

 Replacing the Ink Tanks

Install an ink tank immediately after removing it from the worn BJ cartridge 
or its package.  If an ink tank remains exposed for a long period, it may run 
out of ink quickly after it is installed.

8 Close the front cover.

The cartridge holder returns to the home position and print head cleaning 
begins automatically.  Do not open the front cover during print head 
cleaning.

After you replace a BJ cartridge, always align the print head.

 Aligning the Print Head

Note
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Aligning the Print Head

Each time you replace a BJ cartridge or switch BJ cartridges for a special print job, you 
must align the print head to ensure optimum printing.

1 Open the Printer Properties dialog box.

2 Click the Maintenance tab.

3 Click the Print Head Alignment icon in the Test Prints box.

1 Select Page Setup from the File menu.

2 Click the Utilities button, then select Test Print by clicking the up- or down-
arrow.

3 Select the Print Head Alignment icon.

4 When a confirmation message appears, make sure that the printer is 
switched on and one sheet of plain paper is loaded, and then click the OK 
button. The printer starts to print the standard head alignment pattern. 
(During print head alignment, do not open the front cover.)

Windows

Macintosh
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Aligning the Print Head

5 When the pattern is printed, click the Yes button.

6 Check all the patterns in lines of (B1) and (B2).
For each line, enter the appropriate number where you see that the lines 
are perfectly aligned.

7 When you finish entering numbers...

Click the OK button to save the settings.

Save the settings.

8 Make sure that the printer is switched on and one sheet of plain paper is 
loaded, and then click the OK button.  The printer starts to print the high-
resolution head alignment pattern.

Correct:

Incorrect:

Windows

Macintosh
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Aligning the Print Head

9 Check all the patterns in lines (B1) and (B2).
For each line, enter the appropriate number where you see that the lines 
are perfectly aligned.

10 When you finish entering numbers...

Click the OK button to save the settings.

Save the settings.

Correct:

Incorrect:

Windows

Macintosh
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Aligning the Print Head

11 Click the OK button.  
This completes the Print Head Alignment procedure.

When you wish to turn off the printer after print head alignment, always 
press the POWER button to switch the printer off. If you do not turn the 
printer off correctly with the POWER button, the print head alignment 
settings will not be saved.

Note
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Cleaning the Printer

After routine use, paper dust and room dust may accumulate around the paper output tray 
and other parts of the printer.  Clean the printer periodically.

To avoid personal injury from burns or electrical shock or damage to the 
printer during cleaning, never use a flammable solvent such as thinner, 
benzene or alcohol.

1 Press the POWER button ( ) to turn the printer off.  Check the POWER 
light and make sure that it is not on or blinking.

Do not unplug the power cord when the POWER light is on or flashing.  
This can damage the printer.

2 Make sure that the POWER light is off, then unplug the power cord from the 
power outlet.

To avoid personal injury from touching printer components, always unplug 
the printer before cleaning.

Caution

Note

Caution
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Cleaning the Printer

3 Remove the paper output tray and wipe the paper output area with a soft 
cloth.
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Cleaning the Paper Feed Rollers

With frequent use of high resolution paper and other coated paper, paper dust from the 
coated surfaces of such media accumulates around the paper feed rollers and may cause 
misfeeds and paper jams.  If this occurs, use the special cleaning sheet that comes with 
each pack of High Resolution Paper to clean the paper feed rollers inside the printer.

1 Raise the paper rest.

2 Remove two stickers on the cleaning sheet.

3 Set the paper guide to the Letter position.
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Cleaning the Paper Feed Rollers

4 Slide the cleaning sheet into the auto sheet feeder until it stops.

5 Make sure that the POWER light is green.
Press and hold down the RESUME button until the POWER light flashes 
three times, then release it.  The paper feed rollers of the printer start 
rotating and then stop.  Wait for approximately 15 to 30 seconds.

6 The cleaning sheet feeds into the auto sheet feeder, and paper dust will 
cling to the cleaning sheet as it rotates.

Use the cleaning sheet once only and then discard it. Note
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Transporting the Printer

Use the original box and packing material to repack the printer for shipping or moving to 
another location. (When you do not use the original box, make sure that the printer is 
packaged properly so that it does not get damaged during transportation.)

1 Make sure that the printer is switched on and open the front cover. The 
cartridge holder moves to the left side.

 Turning On the Printer

2 Raise the cartridge lock lever to unlock the BJ cartridge.

3 Remove the entire BJ cartridge with the ink tanks in place.

Always hold the BJ cartridge by the handles embossed on the left and right 
sides of the BJ cartridge.  Do not touch the metal contacts or the print 
head area on the BJ cartridge.

• To avoid staining your hands, clothing, or areas in your work site, handle 
the BJ cartridge carefully. Avoid dropping or shaking the BJ cartridge.

• If you are removing a partially-used BJ cartridge, store it in the Ink
Cartridge Storage Box.

 Notes on Handling BJ Cartridges

Note

Note



314Routine Maintenance

Transporting the Printer

4 Lower the cartridge lock lever.

5 Press the POWER button ( ) while leaving the front cover open. The 
POWER light turns off and the cartridge holder remains in the same 
position. Now unplug the power cord from the power outlet.

6 Fix the cartridge holder with tape and the cartridge lock lever with packing 
material.

7 Close the front cover.

8 Lower the paper rest.



315Routine Maintenance

Transporting the Printer

9 Remove the paper output tray.

Make sure that the printer is off. Note
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Transporting the Printer

10 Disconnect the printer cable from your computer and printer, and 
disconnect the power cord from the printer. (Illustration shows use of a 
parallel printer cable.)
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Transporting the Printer

11 Reattach the tape and packing material to the printer and insert the printer 
into its plastic bag. 

Packing material

Tapes
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Transporting the Printer

12 Fit the packing material on either end of the printer and pack the printer into 
the original box.

If you are shipping the printer through a shipping agent, mark the box with 
FRAGILE or HANDLE WITH CARE.

Note
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Troubleshooting

Printout Is Unsatisfactory

Printer Does Not Start or Stops Mid-Job

Paper Jams or Does Not Feed

The POWER Light Flashes Orange

An Error Message Appears

Other Problems

Avoiding Problems

Before You Call for Help

Getting Help From Canon
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Printout Is Unsatisfactory

Color document printed in monochrome
Colors not clear
Printed and on-screen colors do not match
Meaningless characters or symbols printed
Printed text rotated 90 degrees
Printing in top left corner
Text cut off at bottom right corner, right edge, or bottom edge
Text or image reversed (mirrored)
Enlarged/reduced printing not correct
Single file page prints over two or more pages
Colors streaked or wrong
Straight lines are broken
Printed pages curled
Backs of pages stained with ink
Ink blurred
Printed surface scratched
White streaks visible
Colors streaked or uneven
Last part of print job not printing
Characters and figures notched/gradation streaked or unnatural
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Printout Is Unsatisfactory

�  Color document printed in monochrome
A document created in color is printed in monochrome.

CHECK 1 GRAYSCALE PRINT SELECTED?

Open the Printer Properties dialog box and disable Grayscale Print in the 
Main tab.

Disable Print Grayscale on the left bottom corner of the Print dialog box.

CHECK 2 MONOCHROME PRINTING SELECTED IN APPLICATION PROGRAM?

Some application programs have a setting in the Print dialog box that 
allows you to enable or disable color printing.

Check that the setting is enabled in the application program.

For details, refer to the documentation of the application program.

CHECK 3 CORRECT PRINTER DRIVER SELECTED?

If the wrong printer driver that only supports monochrome printing is 
selected, all the documents are printed in monochrome.

Start the print job again and check that “Canon BJC-3000” is displayed in 
the Name entry box of the Print dialog box.

If the name of another printer is displayed, click the down-arrow and select 
“Canon BJC-3000” from the pull-down list.

Windows

Macintosh
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Printout Is Unsatisfactory

To avoid this problem, you may find it convenient to set the BJC-3000 as 
the default printer. To do so, click Start, select Settings, and click on 
Printers. Highlight the Canon BJC-3000 icon and right-click. Now click the 
Set As Default option (make sure a check mark appears).

�  Colors not clear
The colors in printed photographs and illustrations are not as clear as you expected.

CHECK 1 BJ CARTRIDGE AND MEDIA CORRECT FOR THE PRINT JOB?

For printing photographs or illustrations, use of High Resolution Paper, 
Glossy Photo Paper, or High Gloss Photo Film is recommended. These 
media provide better color reproduction and brighter colors than plain 
paper.

For best results, use the BC-34 Photo BJ Cartridge. (However, do not use 
this BJ cartridge with High Gloss Photo Film.)

For printing color graphs or charts with text, use the BC-33 Color 
BJ Cartridge.

A clogged or worn BJ cartridge may also cause printing problems. Print a 
Nozzle Check Pattern and check the printed patterns.

 Printing a Nozzle Check Pattern

Note
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Printout Is Unsatisfactory

CHECK 2 PRINTER DRIVER SETTINGS CORRECT FOR MEDIA AND PRINT JOB?

Open the Printer Properties dialog box and select the print mode best 
suited for the print job in the Choose Print Mode box under the Main tab.

Also make sure that the BJ Cartridge and Media Type settings match the 
BJ cartridge and media currently set in the printer.

 Printing on Paper and Other Media

 Using BJ Cartridges

 Using the Windows Printer Driver

 Printing Photographs

You may also want to click the Advanced button in the Main tab. Click the 
Color tab, check that Color Adjustment is enabled, and then adjust the 
Color settings such as Color Balance, Output Style, and Brightness.

Select the Color panel and change the settings such as the Matching 
method.

CHECK 3 RE-FILLED INK TANK INSTALLED IN THE BJ CARTRIDGE?

You may not be able to achieve satisfactory performance with an ink tank 
that has been re-filled by a third party. It is recommend that you use ink 
tanks especially designed for use with the BJ cartridge.

 Using BJ Cartridges

Note

Windows

Macintosh
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Printout Is Unsatisfactory

�  Printed and on-screen colors do not match
The colors you see on the screen do not match the colors you see in the printed copy of the 
same image. For example, objects that appear blue on the screen are printed purple and 
objects that appear pale green on the screen are printed dark green.

A color display and printer do not reproduce color in the same way. The printed color tones 
may not perfectly match the colors you see on the screen because screen colors vary 
based on how the screen is viewed and calibrated.

If the differences between displayed and printed colors are extreme, check the following.

CHECK 1 IS THE INK IN THE BJ CARTRIDGE IN GOOD CONDITION?

If there are wide differences between the screen colors and printed colors, 
one of the ink tanks may have run out of ink or some of the print head 
nozzles may be clogged.

Print a Nozzle Check Pattern and check the results.

 Printing a Nozzle Check Pattern

CHECK 2 IS THE INK TANK INSTALLED IN THE CORRECT SLOT OF THE 
CARTRIDGE HOLDER?

Make sure that you install the ink tanks in the correct slots of the cartridge 
holder.

 Replacing the Ink Tanks
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Printout Is Unsatisfactory

CHECK 3 ARE THE PRINTER DRIVER SETTINGS CORRECT?

Open the Printer Properties dialog box and select the print mode best 
suited for the print job in the Choose Print Mode box under the Main tab.

Also make sure that the BJ Cartridge and Media Type settings match the 
BJ cartridge and media currently set in the printer.

 Printing on Paper and Other Media

 Using BJ Cartridges

 Using the Windows Printer Driver

 Printing Photographs

If Monochrome Effects is selected for Special Effects, the colors displayed 
on the screen may differ from those that are printed. Make sure the correct 
settings are selected.

You may also want to click the Advanced button in the Main tab; then click 
the Color tab and adjust the color settings such as Color Balance, Output 
Style and Brightness. If Color Adjustment is off, click the checkbox to turn it 
on.

Note

Windows
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Printout Is Unsatisfactory

�  Meaningless characters or symbols printed
The document is displayed correctly on the screen but meaningless text and symbols are 
printed.

CHECK 1 DID YOU CANCEL A PRINT JOB BEFORE IT WAS COMPLETE?

There may be data remaining in the printer or the computer from the 
previous print job. Turn off the printer and computer, turn them on again, 
and print again.

To check for print data remaining from a previous job, select Settings from 
the Start menu, then click Printers. Double-click the BJC-3000 icon. If you 
see one or more print jobs queued for printing, and select Purge Print 
Documents from the Printer menu.

For details, see your Windows documentation or online Help.

CHECK 2 ARE YOU USING THE CORRECT PRINTER DRIVER? 

Meaningless characters and symbols may print if you have selected the 
wrong printer driver for the print job.

Start the print procedure again and make sure that “Canon BJC-3000” is 
displayed in the Name entry box of the Print dialog box.

If another driver is selected, click the down-arrow and select “Canon 
BJC-3000” from the pull-down list.

To avoid this problem, you may find it convenient to set the BJC-3000 as 
the default printer.

Windows

Windows

Note
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Printout Is Unsatisfactory

CHECK 3 ARE THE PRINTER AND COMPUTER SECURELY CONNECTED?

Check the printer cable connections at the printer and computer. A faulty 
or loose connection can generate meaningless characters and symbols to 
print.

 Connecting and Turning On the Printer

CHECK 4 IS THE PRINTER PORT SET TO ECP? 

When the printer port of the computer is set to the ECP mode, the printer 
may not perform a print job properly. Cancel the ECP mode, and print 
again.

If the problem is not solved, contact your computer manufacturer.

CHECK 5 IS THE PROBLEM IN THE ORIGINAL FILE?

If meaningless characters or symbols are printed only when you print a 
certain file, the cause of the problem may be in the file or the application 
program you are using. Rebuild the file and print it again.

If the rebuilt file prints correctly, the original file was probably faulty.

If the rebuilt file does not print correctly, contact the applications company.

 Before You Call for Help

Windows
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Printout Is Unsatisfactory

�  Printed text rotated 90 degrees
The document text orientation is not correct and it is printed rotated 90 degrees.

CHECK 1 IS THE ORIENTATION SETTING CORRECT?

If the paper is inserted vertically with the Orientation setting for 
Landscape, text and paper are rotated away from one another by 90 
degrees.

Select Portrait to print across the width of the page and select Landscape 
to print across the length of the page.

Open the Printer Properties dialog box and set the correct printing 
direction.

Check the button for Orientation in the Page Layout tab.

Select Page Setup from the File menu and check Orientation.

CHECK 2 IS LANDSCAPE ORIENTATION SPECIFIED IN THE APPLICATION 
PROGRAM?

Check the Orientation feature in your application program.

Some application programs have a setting in a print dialog box that allows 
you to set the orientation.

For details, refer to the documentation of the application program.

Windows

Macintosh
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Printout Is Unsatisfactory

If the application program has an Orientation setting, make sure that the 
setting (Portrait/Landscape) matches the Orientation setting in the printer 
driver.

�  Printing in top left corner
CHECK 1 IS THE PAGE IN THE PRINTER LARGER THAN THE PAGE SIZE SPECIFIED 

IN THE PRINTER DRIVER?

If you print on paper larger than the Page Size selected in the printer 
driver, the page is printed in the top left corner.

Open the Printer Properties dialog box and check the Page Size setting. If 
the setting does not match, replace the paper in the printer or click the 
down-arrow and select the correct paper size from the pull-down list.

CHECK 2 IS SCALED PRINTING SET FOR REDUCTION IN THE PRINTER DRIVER?

If Scaled Printing is set for reduction in the printer driver, the document is 
reduced and printed in the top left corner of the page.

To disable Scaled Printing, open the Printer Properties dialog box, click 
the Page Layout tab, and click Normal-size Printing.

If you want to use Scaled Printing with reduction, make sure that the 
correct percentage is set and confirm that the Page Size selection is 
correct.

Note
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Printout Is Unsatisfactory

�  Text cut off at bottom right corner, right edge, or bottom edge
The text is printing in the bottom right corner of the page or printing beyond the right or 
bottom margins and cut off from view.

CHECK 1 IS THE PAPER IN THE PRINTER SMALLER THAN THE PAGE SIZE 
SPECIFIED IN THE PRINTER DRIVER?

If you print on paper smaller than the Page Size selected in the printer 
driver, text is printed in the bottom right corner, or cut off at the bottom or 
right edge of the paper.

Open the Printer Properties dialog box, and check the Page Size setting.

If the setting does not match the size of the paper in the printer, replace 
the paper in the printer or click the down-arrow and select the correct 
paper size from the pull-down list.

CHECK 2 IS SCALED PRINTING SET FOR ENLARGEMENT IN THE PRINTER 
DRIVER?

If Scaled Printing is set for enlargement in the printer driver, the document 
is enlarged and printed in the bottom right corner, or cut off at the bottom 
or right edge of the paper.

To disable Scaled Printing, open the Printer Properties dialog box, click 
the Page Layout tab, and click Normal-size Printing.

If you want to use Scaled Printing with enlargement, make sure that the 
correct percentage is set and confirm that the Page Size selection is 
correct.
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Printout Is Unsatisfactory

�  Text or image reversed (mirrored)
The printed image is printed with left and right sides reversed or “mirrored.”

CHECK IS BACK PRINT FILM SELECTED FOR MEDIA TYPE?

Open the Printer Properties dialog box and check the Media Type setting 
in the Main tab. If the setting is not correct, click the down-arrow and select 
the correct media from the pull-down list.

The Media Type setting must match the media loaded in the printer for the 
print job.

�  Enlarged/reduced printing not correct
A print job set up for Scaled Printing in the printer driver is not executing correctly.

CHECK 1 DOES THE SIZE OF THE PAPER IN THE PRINTER MATCH 
THE PAGE SIZE SETTING IN THE PRINTER DRIVER?      

If you are using Scaled Printing to enlarge or reduce the print job so it fits 
on the paper in the printer, first set the Page Size in the Page Layout tab to 
the size specified in the application program. Next, set the Printer Page 
Size to the size of the paper in the printer.

CHECK 2 ARE YOU USING THE CORRECT PAPER SIZE FOR SCALED PRINTING?

To set the scale for the enlargement or reduction, load paper that matches 
the Printer Page Size setting in the Page Layout tab.

Windows
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Printout Is Unsatisfactory

�  Single file page prints over two or more pages
CHECK 1 DOES THE PAGE SIZE SETTING IN THE APPLICATION 

PROGRAM AND PRINTER DRIVER MATCH?                 

Set the same Page Size setting for the application program and the printer 
driver.

Open the Printer Properties dialog box, click the Page Layout tab, and 
select the Page Size that matches the Page Size setting in the application 
program.

CHECK 2 IS THE SIZE OF THE TOP MARGIN SPECIFIED IN THE APPLICATION 
PROGRAM TOO LARGE?

In the application program, set the top, bottom, right or left margin to the 
minimum values. If you cannot change the margin, increase the number of 
lines per page.

For more information about setting the page format in the application 
program, refer to the documentation of your application program.

Windows

Note
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Printout Is Unsatisfactory

�  Colors streaked or wrong
The text appears scratched, streaked, or the wrong colors are printed.

CHECK 1 IS THE INK IN THE BJ CARTRIDGE IN GOOD CONDITION?

If text or images are streaked, scratched, faint, or if the wrong colors are 
printing, one of the ink tanks may have run out of ink, the print nozzles 
may be clogged, or the print head may be worn out.

Print a Nozzle Check Pattern and check the printed patterns.

 Printing a Nozzle Check Pattern

CHECK 2 HAS THE PROTECTIVE TAPE OR CAP BEEN REATTACHED TO THE 
BJ CARTRIDGE?

After removing the orange protective cap and tape, do not attempt to 
re-attach them to the BJ cartridge. Re-attaching the tape or cap can cause 
air bubbles, trap dirt or dust, and clog the ink nozzles.

If the protective tape or cap has been re-attached, remove it. Install the 
BJ cartridge in the printer and clean the print head immediately.

CHECK 3 DID YOU PRINT ON THE CORRECT PRINT SIDE OF THE MEDIA?

The correct print side is different for each type of media.

Make sure that the correct print side is facing up when you load the media 
in the auto sheet feeder.

 Printing on Paper and Other Media
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Printout Is Unsatisfactory

�  Straight lines are broken
CHECK 1 HAS THE PRINT HEAD BEEN ALIGNED?

Each time you install a print head, you must align the print head. If you do 
not align the print head, straight lines may appear broken or uneven.

 Aligning the Print Head

CHECK 2 IS THE BJ CARTRIDGE INSTALLED CORRECTLY?

Remove the BJ cartridge and re-install it correctly.

After you re-install the BJ cartridge, align the print head.

 Replacing the BJ Cartridge

CHECK 3 IS PRINT QUALITY SET TO FAST IN THE PRINTER DRIVER?

Changing Print Quality to Fine in the printer driver may improve the quality 
of printed straight lines. 

1 Open the Printer Properties dialog box.

2 Click the Advanced button in the Main tab.

3 In the Quality tab, drag the slide bar to the right to select Fine.

Windows
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Printout Is Unsatisfactory

1 When using Manual for printing, click the Details button in the Printer 
Properties dialog box.

2 In the Quality panel, drag the slide bar to the right to select Fine.

CHECK 4 IS THE PAPER THICKNESS LEVER SET CORRECTLY?

If straight lines are printed uneven or broken after changing the setting of 
the paper thickness lever on the front of the printer, re-align the print head.

 Aligning the Print Head

�  Printed pages curled
As printed pages are ejected from the printer, they are curled or wavy.

CHECK 1 ARE YOU PRINTING ON THIN PAPER?

The large amount of ink used to print color photographs and illustrations 
can cause printed pages to curl or warp.

For such cases, be sure to use special media such as High Resolution 
Paper or Glossy Photo Paper.

When you use High Resolution Paper, Glossy Photo Paper, or other 
special media, always load the pages with the print side (whiter side) 
facing up. Only one side of these media is treated with a special coating 
for better ink absorption.

Macintosh

Note
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Printout Is Unsatisfactory

CHECK 2 IS THE PRINTER DRIVER SET FOR HIGH DENSITY PRINTING?

Move the Intensity setting (print density) in the Color tab to a lower setting 
and execute the print job again. A lower Intensity setting uses less ink and 
thus causes less curling of the printed page. 

1 Open the Printer Properties dialog box and click the Advanced button in 
the Main tab.

2 Click the Color tab.

3 Use the Intensity slide bar to change the Intensity setting.

1 When using Manual for printing, click the Details button in the Printer 
Properties dialog box.

2 Click the Color panel, and use the Intensity slide bar to change the 
intensity setting.

Curling occurs most frequently with small paper sizes such as A5. 
To avoid this curling problem, try not to use small paper sizes to print 
documents that contain photographs or illustrations.

Windows

Macintosh

Note
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Printout Is Unsatisfactory

�  Backs of pages stained with ink
The backs of pages are stained after they are printed and ejected from the printer.

CHECK 1 IS THE PAPER OUTPUT SLOT DIRTY?

Clean the printer periodically. Clean the paper output slot and the area 
around it.

 Cleaning the Printer

CHECK 2 IS A PAGE EJECTED BEFORE THE PREVIOUS PAGE IS DRY?

If you are printing on media that requires a few minutes to dry, remove 
each page from the paper output tray as it is ejected from the printer. This 
prevents the next page from stacking on top of a printed page before it is 
dry.

You can also use the print pause feature to increase the pause between 
printed pages.

1 Open the Printer Properties dialog box.

2 Click the Maintenance tab and click the Custom Setting button.

3 In the Custom Setting dialog box, check Pause Page in the checkbox.

4 Click the Send button to close the dialog box and send the setting to the 
printer.
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Printout Is Unsatisfactory

CHECK 3 IS GRAYSCALE PRINTING BEING PERFORMED?

If you are performing grayscale printing, the backs of the pages may be 
stained with ink. You may be able to eliminate this problem by reducing the 
black density on the printer driver setting screen.

1 Open the Printer Properties dialog box and click the Advanced button in 
the Main tab.

2 Click the Color tab. 

3 Use the Black slide bar to change the print density setting.

If this does not produce an improvement, try using the BC-34 Photo BJ 
Cartridge to perform your printing.

1 When using Manual for printing, click the Details button in the Printer 
Properties dialog box.

2 In the Color panel, use the Black slide bar to change the print density 
setting.

Windows

Macintosh
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Printout Is Unsatisfactory

�  Ink blurred
The ink has blurred in the print job; images are not sharp and the ink has spread and run 
together.

CHECK 1 ARE YOU PRINTING A PHOTOGRAPH OR ILLUSTRATION THAT 
REQUIRES A LARGE AMOUNT OF INK?

In the printer driver, set Print Quality to Fine. The Fine setting reduces the 
tendency for ink to spread in printing color documents that require large 
amounts of ink, and reduces the tendency for ink to spread where black 
areas are adjacent to colored areas.

1 Open the Printer Properties dialog box.

2 Click the Advanced button in the Main tab.

3 In the Quality tab, drag the slide bar to the right toward the Fine setting.

1 When using Manual for printing, click the Details button in the Printer 
Properties dialog box.

2 In the Quality panel, drag the slide bar to the right toward the Fine setting.

Windows

Macintosh
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Printout Is Unsatisfactory

CHECK 2 ARE YOU USING PLAIN PAPER?

If you are using plain paper, use another type of print media. To minimize 
ink spread, use High Resolution Paper, Glossy Photo Paper, or High 
Gloss Photo Film.

CHECK 3 IS THE PRINT HEAD DIRTY?

Clogged print head nozzles can cause ink spread and blurring, so clean 
the print head.

 Cleaning the Print Head

CHECK 4 IS THE PRINTER DRIVER SET FOR HIGH-DENSITY PRINTING?

The Intensity setting in the printer driver can be used to adjust print 
density (that is, the amount of ink used to print).

Lowering the print density setting can reduce the tendency for ink to 
spread in color photographs or illustrations.

1 Open the Printer Properties dialog box and click the Advanced button in 
the Main tab.

2 Click the Color tab.

3 Use the Intensity slide bar to change the intensity setting.

Windows
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Printout Is Unsatisfactory

1 When using Manual for printing, click the Details button in the Printer 
Properties dialog box.

2 In the color panel, use the Intensity slide bar to change the print density 
setting.

�  Printed surface scratched
The print side of the paper is scratched and stained.

CHECK 1 ARE YOU PRINTING ON THICK PAPER?

If you print on thick paper, the print head may scratch the printed surface 
of the page. 

If you experience difficulty when printing on thick paper, clean the print 
head.

 Cleaning the Print Head

CHECK 2 IS THE PAPER THICKNESS LEVER SET CORRECTLY?

When you use thick paper such as envelopes, or Artist Canvas, set the 
Paper Thickness Lever to the Down position.

If the printed surface is scratched or stained on plain paper, it is also 
helpful to set the Paper Thickness Lever to the Down position.

Macintosh
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Printout Is Unsatisfactory

CHECK 3 ARE YOU PRINTING ON CURLED PLAIN PAPER?

If curled plain paper is loaded with the curl bowing up, the print head may 
scratch the bottom edge of the paper.

Try to uncurl the paper. If necessary, turn the paper over, and load it in the 
sheet feeder again.

CHECK 4 ARE YOU EXECUTING A HIGH-DENSITY PRINT ON PLAIN PAPER?

If you execute a high-density print job on plain paper, the paper may 
absorb too much ink and curl, and the print head may scratch the surface 
of the curled page. Lower the Intensity setting.

1 Open the Printer Properties dialog box, and click the Advanced button in 
the Main tab.

2 Click the Color tab.

3 Use the Intensity slide bar to change the print density setting.

CHECK 5 ARE YOU PRINTING OUTSIDE THE RECOMMENDED PRINTING AREA?

If you print outside the recommended printing area, the print head may 
scratch the bottom edge of the page.

To avoid problems, print only in the recommended printing area.

When you print on High Gloss Photo Film or Back Print Film, the bottom 
margin must be larger than 1.1 in. (26 mm).

 Printing Area

Note
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Printout Is Unsatisfactory

�  White streaks visible

CHECK PRINT A NOZZLE CHECK PATTERN.

If colors are broken or missing, clean the print head.

If lines are not aligned properly, align the print head.

If any portion of the Nozzle Check Pattern is streaked, the print head 
could be clogged, may not be aligned properly, or the BJ cartridge may be 
worn out.

If the problem persists after cleaning the print head and aligning the print 
head, try replacing the BJ cartridge.

If the Nozzle Check Pattern prints normally, there may be a problem in the 
application program. For details, refer to the Troubleshooting sections of 
the documentation of your application program.

 Printing a Nozzle Check Pattern

Note
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Printout Is Unsatisfactory

�  Colors streaked or uneven
Patterns of uneven or streaked coloring appear on the printout.

CHECK 1 IS PRINT QUALITY ON THE QUALITY TAB IN THE PRINTER DRIVER SET 
TO FAST?

Set Print Quality to Fine and print again. This reduces uneven coloration 
you may see in a document where a large amount of ink is used.

1 Open the Printer Properties dialog box.

2 Click the Advanced button in the Main tab.

3 In the Quality tab, drag the slide bar to the right toward Fine and click the 
OK button.

1 When using Manual for printing, click the Details button in the Printer 
Properties dialog box.

2 In the Quality panel, drag the slide bar to the right toward Fine.

Windows

Macintosh
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Printout Is Unsatisfactory

CHECK 2 IS HALFTONING SET FOR OPTIMUM PERFORMANCE?

Check the Halftoning setting in the Quality tab of the printer driver. The 
Diffusion setting smoothes uneven or streaked colors.

1 Open the Printer Properties dialog box.

2 Click the Advanced button in the Main tab.

3 In the Halftoning box under the Quality tab, disable Auto if it is checked 
and enabled.

4 Click Diffusion and click the OK button.

1 When using Manual for printing, click the Details button in the Printer 
Properties dialog box.

2 In the Quality panel, set Halftoning to Scatter.

Windows

Macintosh
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Printout Is Unsatisfactory

�  Last part of print job not printing
The last part of each page in the document is not printed.

CHECK 1 ARE YOU USING THE PAPER SIZE SPECIFIED IN THE PAGE SIZE 
SETTING?

If the size of the paper loaded in the printer does not match the Page Size 
setting in the printer driver, part of each page may not print.

Open the Printer Properties dialog box.

Check the Page Size setting. If it does not match the size of the paper you 
are using, click the down-arrow and select the correct size from the pull-
down list.

Set the same Page Size setting for the application program and the printer 
driver.

Open the Printer Properties dialog box, click the Page Layout tab, and 
select the Page Size that matches the Page Size setting in the application 
program.

CHECK 2 ARE THE COMPUTER AND PRINTER SECURELY CONNECTED?

Check the connection of the printer cable at the computer and printer. A 
loose connection can cause losing part of a print job.

 Connecting and Turning On the Printer

Note
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Printout Is Unsatisfactory

CHECK 3 IS THE PRINTER PORT SET TO ECP?  

When the printer port of the computer is set to the ECP mode, the printer 
may not perform a print job properly. Cancel the ECP mode, and print 
again.

If the problem is not solved, contact your computer manufacturer.

CHECK 4 IS A WPS PRINTER DRIVER INSTALLED?  

You may not be able to print correctly with a WPS (Windows Printing 
System) printer driver installed in your system. Confirm whether or not a 
WPS driver is installed in your system.

Change the WPS driver port setting to FILE or delete the WPS driver.

1 Open the WPS Driver Properties window.

2 In the Details tab, select FILE in the Print to Port setting.

3 To delete the WPS driver, select Programs and then Windows Printing 
System from the Windows Start menu and click Uninstall.

Windows

Windows
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Printout Is Unsatisfactory

�  Characters and figures notched/gradation streaked or unnatural  
Characters and figures print with unnatural notches.

Gradation appears streaked.

CHECK ARE YOU USING AN APPLICATION PROGRAM THAT ONLY SUPPORTS 
POSTSCRIPT?

The BJC-3000 is a QuickDraw printer and is not a PostScript printer. 
Therefore, if you use an application program that supports only PostScript, 
the lines of characters and figures may print with unnatural notches. 
Always use an application program that supports QuickDraw.

Some PostScript application programs have a setting that allows you to 
use ATM fonts or TrueType fonts. When you specify the ATM fonts or 
TrueType fonts in the application program, then characters, figures and 
gradation can be reproduced properly.

Windows
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Printer Does Not Start or Stops Mid-Job

Printer does not turn on

Print job does not start

Printing halts

Printing starts but nothing prints

Cartridge holder does not move to the left side
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Printer Does Not Start or Stops Mid-Job

�  Printer does not turn on
The printer does not turn on after you press the POWER button.

CHECK 1 HAVE YOU PRESSED THE POWER BUTTON FIRMLY?

Press the POWER button fully down, then release it. If you do not press 
the button hard enough, the printer may not turn on.

 Turning On the Printer

CHECK 2 IS THE POWER CORD PLUGGED IN?

Make sure that the power cord is plugged into a power outlet.

CHECK 3 IS THE POWER OUTLET LIVE?

Connect another electrical device to the same power outlet. If the other 
device operates normally, the power outlet is functioning normally.

If you perform all these checks and the problem is not solved, unplug the 
printer and contact the Canon Customer Care Center.

 Before You Call for Help

 Getting Help From Canon
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Printer Does Not Start or Stops Mid-Job

�  Print job does not start
Printer does not operate after print job is executed from the computer.

CHECK 1 IS THE PRINTER TURNED ON?

Check the POWER light to see if it is green.

If the POWER light flashes green, the printer is still warming up.

After the POWER light is on, the printer is ready to use.

 Printer does not turn on

CHECK 2 ARE YOU PRINTING A VERY LARGE FILE?

A very large file may require some time to process before printing begins. 
Photographs and illustrations can increase the size of a file. For a very 
large file, wait a few minutes for the print job to begin.

Check the POWER light. If the POWER light flashes green, the computer 
is sending print data to the printer and the job is executing normally.

CHECK 3 ARE THE PRINTER AND COMPUTER SECURELY CONNECTED?

Check the printer cable connections at the printer and computer. A faulty 
or loose connection can prevent the printer from starting.

 Connecting and Turning On the Printer
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Printer Does Not Start or Stops Mid-Job

CHECK 4 ARE YOU USING THE CORRECT PRINTER DRIVER?

A print job may not start if you have selected the wrong printer driver for 
the print job.

Check that “Canon BJC-3000” is displayed in the Name entry box of the 
Print dialog box.

If another driver is selected, click the down-arrow and select “Canon 
BJC-3000” from the pull-down list.

If BJC-3000 does not appear in the list, you must install the printer driver.

If you use only the BJC-3000, select the BJC-3000 as the default printer.

Select BJC-3000 from the Chooser of the Apple menu.

Windows

Note

Macintosh
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Printer Does Not Start or Stops Mid-Job

CHECK 5 IS THE CORRECT PRINTER PORT SELECTED?  

If you are using the parallel interface to connect your printer, set your 
printer port to LPT1. 

If you are using USB Interface to connect your printer, set your printer port 
to USBPRN.

1 Open the Printer Properties dialog box: click Start, select Setting, and 
click Printing. Highlight the Canon BJC-3000 icon and right-click. Now 
select Properties.

2 Click the Details tab and select LPT1 or USBPRN in the Print to the 
following port box (LPT1: Canon BJ LPT Printer Port).

CHECK 6 IS THE PRINTER PORT SET TO ECP?  

You may not be able to print correctly if the printer port is set for ECP. 
Cancel the ECP mode, and print again.

If the problem is not solved by cancelling the ECP mode, contact your 
computer manufacturer.

Windows

Windows
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Printer Does Not Start or Stops Mid-Job

�  Printing halts
The printer stops printing before the print job is complete.

CHECK 1 IS THE PRINT JOB A FINELY DETAILED PHOTOGRAPH OR 
ILLUSTRATION?

The printer requires more time to process a finely detailed illustration or 
photograph.

Check the POWER light. If the POWER light flashes green, the computer 
is sending print data to the printer and the job is executing normally.

If the print job requires a large amount of black ink on plain paper, the print 
job may require more time.

CHECK 2 HAS THE PRINTER BEEN OPERATING FOR A LONG TIME?

The print head may occasionally overheat during a long print job.

If the print head overheats, printing pauses at the end of a pass across the 
page to allow time for the print head to cool and then restarts after a brief 
interval. Interrupt printing at a convenient point, turn the printer off, and 
wait for at least 15 minutes for the print head to cool.

If the printer overheats while printing a densely colored photograph or 
illustration, the printer may beep and stop printing to protect the print 
head. In this case, you cannot continue printing. Turn the printer off and 
wait at least 15 minutes for the print head to cool.

To avoid minor burns, never touch the print head or the surrounding area.Caution
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Printer Does Not Start or Stops Mid-Job

�  Printing starts but nothing prints
The printer operates but nothing is printed on the page.

CHECK 1 IS THE INK IN THE BJ CARTRIDGE IN GOOD CONDITION?

The print head nozzles may be clogged, one or more of the ink tanks may 
be low, or the BJ cartridge may be worn.

Visually check the level of the ink in the ink tanks. If the tanks are empty, 
replace them.

 Replacing the Ink Tanks

Next, print a Nozzle Check Pattern to check the status of the print head 
and clean the print head.

 Printing a Nozzle Check Pattern

 Cleaning the Print Head

If the problem is not solved, replace the BJ cartridge.

 Replacing the BJ Cartridge

If you can print a Nozzle Check Pattern, check that the printer is 
connected to the computer securely. If the connection is loose, printing 
starts but nothing may be printed.

Also check that there is no problem with the original file.
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Printer Does Not Start or Stops Mid-Job

CHECK 2 DID YOU REMOVE THE ORANGE PROTECTIVE TAPE FROM THE PRINT 
HEAD?

If the orange protective tape is not removed from the BJ cartridge, ink 
cannot be ejected from the BJ cartridge. Remove the BJ cartridge and 
check the print head.

If the tape has not been removed, remove it. Align the print head before 
you resume printing.

 Replacing the BJ Cartridge

 Aligning the Print Head
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Printer Does Not Start or Stops Mid-Job

�  Cartridge holder does not move to the left side
You want to switch the BJ cartridge, replace an ink tank, or replace the BJ cartridge, but the 
cartridge holder does not move to the left side when you open the front cover.

CHECK 1 IS THE PRINTER TURNED ON?

Check the POWER light and make sure that it is green. If the POWER light 
is off, turn on the printer.

If you have just turned on the printer and the POWER light flashes green, 
the printer is warming up. Wait until the POWER light stops flashing.

CHECK 2 HAS THE FRONT COVER BEEN OPEN LONGER THAN 10 MINUTES?

If the front cover remains open longer than 10 minutes, the cartridge 
holder automatically returns to the home position to prevent the print head 
from drying out.

Close the front cover and open it again. The cartridge holder moves to the 
left side.
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Paper Jams or Does Not Feed

Paper does not feed from auto sheet feeder

Envelopes do not feed

Paper skews during feeding

Multiple sheets feed together

Paper jam
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Paper Jams or Does Not Feed

�  Paper does not feed from auto sheet feeder
After the print job is started, the paper loaded in the auto sheet feeder does not feed.

CHECK 1 IS THE PAPER TOO THICK?

Thick paper does not feed from the auto sheet feeder. You cannot attempt 
to print on paper or other media thicker than .024" or 28 lb (0.6 mm or 
105 g/m2).

CHECK 2 IS THE SHEET FEEDER OVERLOADED?

The number of sheets you can load in the auto sheet feeder depends on 
the media you are using. The media does not feed correctly if you exceed 
the prescribed number of sheets.

CHECK 3 DID YOU RAISE THE PAPER REST?

Before you load media other than envelopes in the auto sheet feeder, you 
should always raise the paper rest. If you do not raise the paper rest 
before loading, the media does not completely enter the paper feed slot 
during feeding.

CHECK 4 IS THE PAPER FOLDED OR CURLED?

To avoid misfeeds and paper jams, never load paper in the auto sheet 
feeder that is folded, curled, or wrinkled.

 Media Types You Can Use With the Printer

 Media Types You Cannot Use With the Printer



360Troubleshooting

Paper Jams or Does Not Feed

�  Envelopes do not feed
Envelopes do not feed or skew during feeding.

CHECK 1 ARE THE ENVELOPES CURLED OR BENT?

Before you load envelopes, make sure they are flat. Press down firmly 
around the edges of the stack to flatten the envelopes and expel air from 
inside the envelopes.

If the envelopes are still not perfectly flat, hold the edges of the stack 
diagonally and bend them gently to straighten them.

Make sure that the flaps in the stack are straight and not overlapping.

If the envelopes still do not feed, use a pen or similar object to flatten the 
edges of the envelopes.

 Using Envelopes
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Paper Jams or Does Not Feed

CHECK 2 ARE TOO MANY ENVELOPES LOADED?

The number of envelopes you can set in the auto sheet feeder is up to 10.

Do not exceed 10 envelopes in a stack.

 Using Envelopes

CHECK 3 ARE THE ENVELOPES LOADED CORRECTLY?

To avoid misfeeds and jams, always load the top edge of an envelope (or 
stack of envelopes) lengthwise with the flap side down.

 Using Envelopes
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Paper Jams or Does Not Feed

�  Paper skews during feeding
The paper or other media does not feed straight into the paper feed slot.

CHECK 1 IS THE AUTO SHEET FEEDER OVERLOADED?

The number of sheets you can load in the auto sheet feeder depends on 
the media you are using. The media does not feed correctly if you exceed 
the prescribed number of sheets.

CHECK 2 IS THE PAPER FOLDED OR CURLED?

To avoid misfeeds and paper jams, do not load paper in the auto sheet 
feeder that is folded, curled, or wrinkled.

 Media Types You Cannot Use With the Printer

CHECK 3 IS THE PAPER GUIDE SET CORRECTLY?

If the paper guide on the auto sheet feeder is not set correctly, the paper 
does not feed straight or may jam in the printer.

The paper guide must be snug against the side of the stack and not too 
tight.
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Paper Jams or Does Not Feed

�  Multiple sheets feed together
More than one sheet feeds from the stack at the same time.

CHECK 1 DID YOU FAN THE STACK BEFORE LOADING?

Before loading a stack of media in the auto sheet feeder, always fan the 
pages to remove static cling and align the edges. Fanning the stack 
separates the sheets so they can feed smoothly from the auto sheet 
feeder.

CHECK 2 IS THE AUTO SHEET FEEDER OVERLOADED?

The number of sheets you can load in the auto sheet feeder depends on 
the media you are using. The media does not feed correctly if you exceed 
the prescribed number of sheets.

CHECK 3 IS THE PAPER FOLDED OR CURLED?

To avoid misfeeds and paper jams, never load paper in the auto sheet 
feeder that is folded, curled, or wrinkled.

 Media Types You Cannot Use With the Printer

CHECK 4 ARE YOU PRINTING ON TRANSPARENCIES?

When more than one transparency feeds from a stack at the same time, 
lower the paper rest, set the stack, and try again.

 Using Transparencies
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Paper Jams or Does Not Feed

�  Paper jam
If paper jams in the printer, remove it.

1 Slowly pull the paper out of the printer from the auto sheet feeder or the 
paper output slot, whichever is easier. (If the paper tears or shreds, open 
the front cover and remove all the fragments of paper.)

2 Close the front cover, load the paper, and then press the RESUME button.
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Paper Jams or Does Not Feed

• If the paper cannot be removed, press the POWER button twice to eject 
the paper automatically and start the print job again.

• Paper within the range of 17 to 28 lb (64 to 105 g/m2) can be loaded in the
auto sheet feeder.

 Media Sizes You Can Use With the Printer

• To avoid misfeeds and paper jams, do not load wrinkled, folded, or
curled paper in the auto sheet feeder.

 Media Types You Cannot Use With the Printer

Note
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The POWER Light Flashes Orange

When an error occurs, the POWER light flashes orange. The number of flashes indicates 
the cause of the problem.

Two flashes: Out of paper, paper jam, paper feed error

Three flashes: Paper jam

Four flashes: BJ cartridge out of ink

Five flashes: BJ cartridge not installed correctly

Six flashes: BJ cartridge not installed

Seven flashes: BJ cartridge defective

Eight flashes: Waste ink tank almost full

The POWER light flashes orange and green alternately: Service error
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The POWER Light Flashes Orange

�  Two flashes: Out of paper, paper jam, paper feed error
If no paper is loaded in the auto sheet feeder, or if the paper is not loaded correctly, set the 
paper correctly and press the RESUME button.

If paper has jammed in the printer, remove the jam and press the RESUME button.

 Paper Jams or Does Not Feed

If the paper is not feeding into the auto sheet feeder, adjust the paper 
guide and insert the paper.

�  Three flashes: Paper jam
If paper has jammed in the printer, remove the jam and press the RESUME button.

 Paper Jams or Does Not Feed

Note
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The POWER Light Flashes Orange

�  Four flashes: BJ cartridge out of ink
An ink tank in the BJ cartridge has run out of ink.

Replace the depleted ink tank and press the RESUME button.

 Replacing the Ink Tanks

�  Five flashes: BJ cartridge not installed correctly
The correct BJ cartridge is not installed. Install a BJ cartridge for the BJC-3000. 

 BJ Cartridges You Can Use With the Printer

�  Six flashes: BJ cartridge not installed
No BJ cartridge is installed. Select and install the BJ cartridge (color, photo, or black) 
according to the work you are doing.

�  Seven flashes: BJ cartridge defective
There is a problem with the BJ cartridge mounted in the printer.

Remove the BJ cartridge and check that the contacts on the BJ cartridge and cartridge 
holder are clean. Also check that the orange protective tape has been removed from the 
print head then install the BJ cartridge again.

If the error occurs again after you resume operation, replace the BJ cartridge.

 Replacing the BJ Cartridge
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The POWER Light Flashes Orange

�  Eight flashes: Waste ink tank almost full
The printer has a built-in waste ink tank to hold the ink that is consumed during print head 
cleaning.

Eight flashes indicate the waste ink tank is nearly full. Press the RESUME button to skip the 
error so you can continue printing.

To prevent the ink waste tank from becoming full, call the Canon Customer Care Center for 
help to have the waste ink tank replaced immediately.

 Getting Help From Canon

When the waste ink tank becomes full, the POWER light flashes orange 
and green alternately, and printing will no longer be possible.

Call the Canon Customer Care Center.

�  The POWER light flashes orange and green alternately: Service error
A service error means the printer requires the attention of a qualified technician.

Count the number of flashes. (You may be asked for this information.) Call the Canon 
Customer Care Center.

 Before You Call for Help
 Getting Help From Canon

Note
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An Error Message Appears

Error writing to LPT1 or USBPRN  

Application error, general protection fault  

Other error messages

Windows

Windows
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An Error Message Appears

�  Error writing to LPT1 or USBPRN  

You cannot print when this message appears.

CHECK 1 IS THE PRINTER TURNED ON?

Check the POWER light to see if it is green.

If the POWER light flashes green, the printer is warming up.

After the POWER light is on, the printer is ready to use.

 Printer does not turn on

CHECK 2 ARE THE PRINTER AND COMPUTER CONNECTED PROPERLY?

Check the connections of the printer cable at the computer and the printer.

CHECK 3 IS PRINT SPOOLING OPERATING CORRECTLY?

Cancel spooling and send the print job directly to the printer. 

1 Open the Printer Properties dialog box from the Start menu: click Start, 
select Settings, and click Printers. Highlight the Canon BJC-3000 icon and 
right-click. Select Properties.

2 Click the Details tab and click the Spool Settings button. Click the button 
for “Print directly to the printer.”

Windows
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An Error Message Appears

CHECK 4 IS THE PRINTER PORT OPERATING CORRECTLY? 

Check the status of the printer port.

When you are using the parallel interface:

1 Right-click the My Computer icon and select Properties from the pop-up 
menu.

2 Click the Device Manager tab, select Ports (COM & LPT), and then 
double-click Canon BJ LPT Printer Port (LPT1).

3 In the General tab, check that Original Configuration (Current) is enabled. 
An error occurs if this item is disabled. Read the message under Device 
Status and verify that no problem is indicated.

4 Click the Resources tab and read the message under Conflicting device 
list. If a conflict is indicated, delete the competing device.

When you are using the USB interface:

1 Right-click the My Computer icon and then select Properties from the pop-
up menu.

2 Click the Device Manager tab, select the Universal serial bus controller, 
and then double-click Canon BJC-3000.

3 In the General tab, note what is displayed. If the system indicates that 
there is an error, apply the countermeasures described in “Additional 
Notes on Handling the USB Interface.”
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An Error Message Appears

CHECK 5 IS THE PRINTER DRIVER INSTALLED CORRECTLY?

There may be a problem with the printer driver. Uninstall the printer driver 
and install it again.

Also refer to the “Additional Notes on Handling the USB Interface.”

CHECK 6 IS THE PRINTER PORT SETTING IDENTICAL TO THE INTERFACE YOU 
ARE USING?

If the printer port setting is not identical to the interface connected to the 
printer, an error message appears.

To check the printer port setting, open the Printer Properties dialog box 
and click the Details tab.

• If LPT1 is displayed in the “Print to the following port” box, the printer 
port is set to the parallel port.

• If USBPRN nn (nn: numerals) is displayed in the “Print to the following 
port” box, the printer port is set to the USB port.

If the printer port setting does not match the interface connected to the 
printer, shut down Windows and turn the printer off. Then connect the 
printer using the correct interface specified in the printer driver, or install 
the correct printer driver that matches the connected interface.
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An Error Message Appears

CHECK 7 IS A WPS DRIVER INSTALLED?

You may not be able to print correctly if a WPS (Windows Printing System) 
driver is installed on your computer.

1 Click Start, point to Settings, and click Printers.

2 If a WPS driver is installed, right-click the icon and then select Properties 
from the pop-up menu.

3 Click the Details tab and check the “Print to the following port” setting.

If the selected port is the port also used by the BJC-3000, change the 
WPS driver port setting to FILE or delete the WPS driver.
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An Error Message Appears

�  Application error, general protection fault    
CHECK 1 ARE YOU USING A WINDOWS 3.1 APPLICATION PROGRAM?

Attempting to print from a Windows 3.1 application program installed on a 
system with Windows 98 or Windows 95 may cause an error. Use a 
Windows 98 or Windows 95 compatible application program.

You cannot use the BJC-3000 with the Windows 3.1 operating system.

CHECK 2 ARE SEVERAL APPLICATION PROGRAMS RUNNING IN THE 
BACKGROUND?

If you are running several application programs at the same time, there 
may not be enough memory available for the print job.

Quit the other application programs and try again.

CHECK 3 DOES THE COMPUTER HAVE SUFFICIENT MEMORY?

Make sure that you have the required amount of memory installed for the 
application program you are using to print.

For details, refer to the documentation for your application program.

If the amount of memory is insufficient, install more memory.

 Before You Call for Help
(Checking the Windows version and memory capacity)

Windows

Note
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An Error Message Appears

CHECK 4 IS THERE SUFFICIENT FREE SPACE ON THE HARD DISK?

An error may occur if there is not enough free space available on the hard 
disk.

Check the amount of free space on the hard disk.

If there is little free space available on the disk, delete any unneeded files.

 Before You Call for Help
 (Checking the amount of free space on hard disk)

CHECK 5 IS THERE A PROBLEM IN THE FILE YOU ARE TRYING TO PRINT?

If these errors occur only when you try to print a particular file, there may 
be a problem in the file or the application program. Rebuild the file and try 
printing it again.

If there is no problem with the new file, the old file was probably faulty.

If the same error occurs with the new file, call either the software company 
or the Canon Customer Care Center.

 Before You Call for Help

CHECK 6 IS THE PRINTER DRIVER INSTALLED CORRECTLY?

There may be a problem with the printer driver. 

Uninstall the printer driver and install it again.

Also refer to the “Additional Notes on Handling the USB Interface.”
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An Error Message Appears

�  Other error messages
CHECK 1 AN ERROR DISPLAYED IN THE BJ STATUS MONITOR? 

When an error occurs, the BJ Status Monitor screen opens.

The Print Status tab displays a short description of the error and other 
information about the print job. Click the Guide tab to display instructions 
on how to solve the problem.

For problems that require more than one step in correcting the problem, 
click the Next button to see the next screen, or click the Back button to 
see the previous screen.

CHECK 2 AN ERROR DISPLAYED IN ANY SCREEN OTHER THAN 
THE BJ STATUS MONITOR?

One of the following messages may be displayed.

Delete any unneeded files to make more disk space available.

 Before You Call for Help
 (Checking the amount of free space on hard disk)

Quit any other application programs you are running in the background.

 Before You Call for Help
 (Checking the Windows version and memory capacity)

Could not spool successfully due to insufficient disk space

Could not spool successfully due to insufficient memory
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An Error Message Appears

Uninstall the printer driver and reinstall it.

Restart Windows and try again.

Try printing again after the current job is finished.

CHECK 3 ANY ERROR NUMBER (XXXX:) DISPLAYED?  

Error number (*202) displayed

Sufficient memory not available for the application program.

Check that the required amount of memory is allocated to the application 
program.

If there is not enough memory installed, install more memory.

Refer to your computer documentation for information on installing 
additional memory.

Printer driver could not be found

Background printing failed

Could not print [application name]-[file name] 

Macintosh
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An Error Message Appears

Error number (*203) displayed

Installed printer driver not operating correctly.

Remove the installed BJ printer driver and then install the printer driver 
again.

Error number (*300) displayed

Check the following.

• Printer is turned on?

 Turning On the Printer

• Printer cable is connected securely?

Make sure that the printer cable is securely fastened to the 
computer and the printer.

If the problem cannot be solved, check the settings in the Chooser. 

1 Select the Chooser from the Apple menu.

2 Click the BJC-3000 icon.

3 Make sure that BJC-3000 is specified in the Connect to box.

If the problem still cannot be solved, remove unneeded documents from 
the Control Panel folder and try again.



380Troubleshooting

Other Problems

Cannot install the printer driver

BJ Status Monitor does not open 

Cannot execute background printing
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Other Problems

�  Cannot install the printer driver
CHECK 1 DID YOU FOLLOW THE PRINTER DRIVER INSTALLATION INSTRUCTIONS 

IN THE QUICK START GUIDE?

The Quick Start Guide provides step-by-step instructions for installing the 
printer driver. If you are reinstalling the printer driver, remove any other 
Bubble Jet printer drivers which have been installed on the computer 
before reinstalling the printer driver.

If an error occurred during installation and you had to shut down the 
installation procedure, you may not be able to install the printer driver 
because Windows is no longer stable. Restart Windows and then reinstall 
the printer driver.

CHECK 2 ARE ANY OTHER APPLICATION PROGRAMS RUNNING?

The installation program may not execute successfully if it is run with other 
applications running in the background.

Before you run the installation program again, shut down all other 
application programs.

If other BJ printer drivers are installed on your system, uninstall them 
before you run the installation program again.

Note
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Other Problems

CHECK 3 DID YOU SPECIFY THE CORRECT CD-ROM DRIVE FOR 
INSTALLATION?

If the printer driver installation program did not start automatically when 
you loaded the CD-ROM, double-click the My Computer icon, then 
double-click the CD-ROM icon on the Windows desktop.

For details about the installation procedure, refer to the Quick Start Guide.

• The drive name (E:, for example) varies according to how your system 
is set up.

• When you install the printer driver from Run in the Start menu, specify
the CD-ROM drive and file name (Setup.exe) correctly.

CHECK 4 IS THERE A PROBLEM WITH THE CANON CREATIVE CD-ROM?

The Canon Creative CD-ROM may be damaged. On the Windows 
desktop, double-click the My Computer icon then double-click the 
CD-ROM icon. If Windows cannot read the CD-ROM, call the Canon 
Customer Care Center.

 Before You Call for Help

Windows

Note
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Other Problems

�  BJ Status Monitor does not open     

CHECK 1 DOES YOUR PRINTER CABLE SUPPORT BI-DIRECTIONAL 
COMMUNICATION?

Check the hardware specifications of your printer cable. Operation of the 
BJ Status Monitor requires bi-directional data transfer between the 
computer and printer. The printer cable must be capable of bi-directional 
data transfer.

CHECK 2 IS THE BI-DIRECTIONAL OPTION SELECTED IN THE PRINTER DRIVER?

Check the bi-directional option.

1 Open the Printer Properties dialog box from the Start menu.

2 Click the Details tab and click the Spool Settings button.

3 In the Spool Settings dialog box, click the button for “Enable bi-directional 
support for this printer.”

Windows
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Other Problems

�  Cannot execute background printing
The BJ Backgrounder is not displayed during a print job and you cannot use background 
printing.

CHECK 1 IS THERE ENOUGH FREE SPACE AVAILABLE ON THE HARD DISK?

You may not be able to print if there is not enough free space on the hard 
disk. Delete unneeded files to create more space.

 Checking the amount of free space on hard disk

If you are unable to make more space available on your hard disk by 
deleting files, turn background printing off.

CHECK 2 IS BACKGROUND PRINTING ENABLED IN THE PRINTER DRIVER?

1 Open the Printer Properties dialog box, then click the Page Layout tab.

2 Check Background Printing in the Background checkbox.

1 Select Chooser from the Apple menu.

2 Set Backgrounding to On.

Note

Windows

Macintosh
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Avoiding Problems

Setting Color Adjustment

Adjusting Brightness (gamma curve coefficient)

Adjusting Output Style

Checking the printer and computer connection

Setting the BJC-3000 as default printer 

Cancelling ECP 

Windows

Windows
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Avoiding Problems

�  Setting Color Adjustment
In the printer driver, you can adjust the color tones of the image by changing the density of 
each color (cyan, magenta, yellow, and black).

For example, you can lower the magenta setting when the reds are too strong or raise the 
cyan setting when the blues are too weak.

To adjust the color balance, follow these steps.

1 Open the Printer Properties dialog box, and click the Advanced button on 
the Main tab.

2 Click the Color tab.

3 Move the slide bars of the individual colors to the left or right (or click the 
arrows on each end of the slide bars).

If Color Balance is grayed out, check the Color Adjustment box (make sure 
there is a check mark in the box). If Color Adjustment is grayed out, check 
the other settings within the printer driver. Make sure the BJ cartridge 
option is set to Color or Photo.

Windows

Note
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Avoiding Problems

1 When using Manual for Printing, click the Details button.

2 Click the Color panel.

3 Move the slide bars of the individual colors to the left or right.

Macintosh
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Avoiding Problems

�  Adjusting Brightness (gamma curve coefficient)
In the printer driver, you can specify the contrast among intermediate tones between black 
and white. For example, adjusting the brightness towards Light makes the overall image 
brighter, with stronger contrast in the light areas and lower contrast in the dark areas.

To adjust the brightness, follow these steps.

1 Open the Printer Properties dialog box, and click the Advanced button in 
the Main tab.

2 Click the Color tab.

3 Specify the desired brightness setting in the Brightness box.

If Brightness is grayed out, check the Color Adjustment box (make sure 
there is a check mark).

1 When using Manual for printing, click the Details button.

2 Select the Color panel.

3 Specify the desired Brightness setting.

If Brightness is grayed out, check the Brightness box (make sure there is a 
check mark).

Windows

Note

Macintosh

Note
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Avoiding Problems

�  Adjusting Output Style
The Output Style settings in the printer driver allow you to specify whether intermediate 
tones are emphasized in the printout or primary colors are printed more brightly.

Auto: Samples the data stream and selects the optimum matching method 
for the print job.

Accurate or Photo: Emphasizes intermediate tones. Best suited for natural images (skin 
tone, sky blue, foliage green, etc.).

Vivid or Graphic: Emphasizes primary colors. Reds, blues, yellows printed brightly for 
color graphs, charts, and tables.

Spot color: Emphasizes basic colors. Best suited for documents (Macintosh) 
that require few intermediate colors. 

To select Output Style, follow these steps:

1 Open the Printer Properties dialog box, and click the Advanced button in 
the Main tab.

2 Click the Color tab.

3 Select Auto, Accurate, or Vivid in the Output Style box.

If Output Style is grayed out, check the Color Adjustment box (make sure 
there is a check mark).

Windows

Note
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Avoiding Problems

1 When using Manual for printing, click the Details button.

2 Select the Color panel.

3 Specify the Matching Method setting.

If Output Style is grayed out, check the Matching Method box (make sure 
there is a check mark).

Macintosh

Note
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Avoiding Problems

�  Checking the printer and computer connection
If you have problems with the printer, the cause may be in the hardware you are using to 
connect the printer and computer.

• If you are using a switching device, USB hub or external buffer, disconnect the 
device and connect the printer directly to the computer again. If you can print 
normally with the direct connection, contact the manufacturer of the device.

• The printer cable may be faulty, or you may be using the wrong type of cable. 
Replace the printer cable and try again.

Recommended printer cable specifications are as follows.

• When using the parallel interface—IEEE 1284-compatible:
Material: AWG28 or larger

Type: Twisted-pair shielded cable

Length: Up to 6.5 ft (2.0m)

Connectors: Amphenol 30360 or equivalent

• When using the USB interface:
Material: AWG28 (data wiring pair) or AWG20 to 28 (distribution pair)

Type: Twisted-pair shielded cable

Length: Up to 16.4 ft (5.0m)

Connectors: USB standard Series B pluggable
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Avoiding Problems

�  Setting the BJC-3000 as default printer 
When you are using more than one printer, you may find it convenient to set the BJC-3000 
as the default printer.

To set the BJC-3000 as the default printer, follow these steps:

1 On the Windows desktop, click the Start button, point to Settings, and 
click Printers.

2 In the Printers window, click the BJC-3000 icon to highlight it.

3 Select Set As Default from the File menu, or right-click and select Set As 
Default from the pop-up menu.

Windows
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Avoiding Problems

�  Cancelling ECP 
If you are experiencing difficulty, the problem may be solved by cancelling the ECP mode 
setting.

To cancel the ECP mode, follow these steps:

1 Open the Printer Properties dialog box and click the Maintenance tab.

2 Click the Custom Setting button.

3 If “Set printer to ECP mode” is checked and enabled, click the checkbox to 
disable the ECP mode setting.

4 Click the Send button to send the setting to the printer.

Windows
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Before You Call for Help

Narrowing down the problem

Checking the printing environment
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Before You Call for Help

�  Narrowing down the problem
If you are experiencing difficulties, try to narrow the problem down to one of these three 
factors.

 Printer problem
 Hardware problem other than the printer
 Application program problem

Printer problem

If the printer will not operate, or if the POWER light flashes orange and green alternately 
with beeps, call the Canon Customer Care Center. Count the number of flashes and beeps. 
(You may be asked for this information.)

Hardware problem other than the printer

If the printer is operating normally and the settings in the application program are also 
correct, there may be a problem with a printer cable or in the computer system (for example, 
memory, hard disk, or interface). Contact your computer manufacturer.

Application program problem

Problems that arise only when you use a particular application program are probably 
caused by the application program. For details, consult the software company.

The problem may also be solved by installing the latest version of the printer driver.
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Before You Call for Help

�  Checking the printing environment
Check the information on the operating environment such as the name and version number 
of your operating system, the amount of memory installed, hard disk capacity and amount 
of free space on hard disk, and the printer driver version number.

 Checking the Windows version and memory capacity
 Checking the amount of free space on hard disk
 Checking the version number of the printer driver

Checking the Windows version and memory capacity

1 Right-click the My Computer icon and select Properties from the pop-up 
menu.

2 On the General tab note the system name, version number, and memory 
capacity.

Select About This Computer from the Apple menu.

Windows

Macintosh
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Before You Call for Help

Checking the amount of free space on hard disk

1 On the Windows desktop, double-click the My Computer icon.

2 Right-click the icon of the hard disk and select Properties from the pop-up 
menu.

3 On the General tab, check the hard disk capacity and the amount of free 
space.

1 On the desktop, click the icon of the hard disk.

2 Select Get Info from the File menu.

3 Select General Information.

Windows

Macintosh
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Before You Call for Help

Checking the version number of the printer driver

1 On the Windows desktop, click the Start button, point to Settings, and 
click Printers.

2 Right-click the BJC-3000 icon and select Properties from the pop-up 
menu.

3 Click the Main tab and click the About button. The version number of the 
printer driver is displayed.

1 Double-click the Extensions Folder in the System Folder and then select 
the BJC-3000 icon.

2 Select Get Info from the File menu.

3 Select General Information. The version number of the printer driver is 
displayed.

Windows

Macintosh
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Getting Help From Canon

Canon Computer Systems, Inc. offers a full range of customer technical support* options 
including:

• For e-mail technical support, the latest driver downloads and answers to 
frequently asked questions (www.ccsi.canon.com)

• 24-hour, 7-day-a-week,automated support for troubleshooting issues on most 
current products (1-800-423-2366)

• 24-hour, Fax-On-Demand System for product specifications and technical 
information (1-800-526-4345)

• Free technical support Monday-Saturday for products still under warranty** 
(1-757-413-2848)

• Technical support 7 days a week for products no longer under warranty, for 
$24.99 per call (1-800-423-2366), or for $2.50 per minute, to a maximum of 
$25.00 per call (1-900-246-1200)

Within Canada, call for technical support 24 hours a day, 7 days a week 
(1-800-OK-CANON)

* Support program specifics subject to change without notice.
**Refer to individual product information for warranty details.

Note
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Specifications

General Specifications

System Requirements



401Specifications

General Specifications

Printing method
Bubble Jet on-demand

Printing resolution
1440 (horizontal) x 720 (vertical) dpi

Print speed (printing with Canon standard pattern)
• Black printing using BC-30 Black BJ Cartridge Fast 9 ppm 
• Color printing using BC-33 Color BJ Cartridge Fast 4 ppm
• Black printing using BC-33 Color BJ Cartridge Fast 6 ppm

Print direction
Bi-directional

Print width
8 in. (203.2 mm max.)

Receive buffer
128 KB max.

Interface (parallel)
IEEE 1284-compatible
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General Specifications

Interface (USB)
USB 1.0-compatible 

Interface connector (parallel)
Amphenol 57-40360 or equivalent

Interface connector (USB)
USB standard Series B receptacle (USB interface)

Recommended parallel printer cable — IEEE 1284-compatible
• Material AWG28 or larger
• Type Twisted-pair shielded cable
• Length Up to 6.5 ft (2.0 m)
• Connectors Amphenol 30360 or equivalent

Recommended USB printer cable
• Material AWG28 (data wiring pair) or AWG20 to 28 

(distribution pair)
• Type Twisted-pair shielded cable
• Length Up to 16.4 ft (5.0 m)
• Connectors USB standard Series B pluggable

Acoustic noise level
Approx. 45 dB (per ISO 9296)
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General Specifications

Operating environment
• Temperature 41 to 95˚F (5 to 35˚C)
• Humidity 10 to 90% RH (no condensation)

Storage environment
• Temperature 32 to 95˚F (0 to 35˚C)
• Humidity 5 to 90% RH (no condensation)

Power supply
USA/Canada                 AC 120V, 60Hz

Power consumption
• Off Approx. 2W (AC 230±10%)

Approx. 2W (AC 120V)
• Standby Approx. 3W (AC 230±10%)

Approx. 3W (AC 120V)
• Printing Approx. 35 W

Dimensions (with paper rest and paper output tray retracted)
• 16.5" x 12.0" x 6.6" (W x D x H)
• 418 x 306 x 169 mm (W x D x H)

Weight
Approx. 8.16 lb. (3.7 kg)
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General Specifications

Sheet feeder capacity

• Plain paper (64 gm) 100 sheets max.
• Envelopes 10 pieces max.
• High Resolution Paper 80 sheets max.
• Transparencies 30 sheets max.
• Back Print Film 10 sheets max.
• Glossy Photo Paper 10 sheets max.
• High Gloss Photo Film 1 sheet
• Glossy Photo Cards 1 sheet
• Banner Paper 1 sheet
• Magnet Sheet 1 sheet
• Artist Canvas 1 sheet
• Greeting Cards 1 sheet
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General Specifications

Ordinary print media

Regular size
Letter, Legal, A4, A5, B5, US Com.#10, European DL

Custom size
• width 13.94" to 9.50" (100.0 to 241.3 mm)
• height 3.94" to 23.0" (100.0 to 584.2 mm)

Weight 17 to 28 lb (64 to 105 g/m2)

Thickness 0.24" (0.6 mm) max. 

Canon Specialty Papers
• Bubble Jet paper
• High Resolution Paper
• Glossy Photo Paper
• High Gloss Photo Film
• Glossy Photo Cards
• Transparencies
• Back Print Film
• Banner Paper
• Magnet Sheets
• Artist Canvas
• Greeting Cards
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General Specifications

Graphic image printing

Data format Canon extended mode—Raster image format

Resolution Canon extended mode—180, 360, 720, 1440 dpi

Compatible BJ cartridges

BC-33 Color BJ Cartridge
• Nozzles 48 per color
• Ink colors Cyan, Yellow, Magenta, Black
• Capacity* Approx. 280 sheets

(at 7.5% coverage per color)
• Print head life 3000 pages

BC-34 Photo BJ Cartridge 
• Nozzles 48 per color
• Ink colors Photo Black, Photo Cyan, 

Photo Magenta, Yellow
• Capacity Approx. 280 sheets

(at 7.5% coverage per color)
• Print head life 3000 pages

BC-30 Black BJ Cartridge
• Nozzles 160
• Ink colors Black only
• Capacity Approx. 500 sheets

(at 5% coverage)
• Print head life 5000 pages

* Based on the number of sheets per ink tank over the printable area on plain paper.
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System Requirements

Printer driver operating environment

IBM PC/AT-compatible computer running on Windows 98, Windows 95, Windows 
NT 4.0, or iMac or Power Macintosh G3 computer running on Mac OS 8.1 or 
later

Hard disk space

Approximately 26MB to install on Windows 98, Windows 95, Windows NT 4.0, or  
approximately 30MB to install on Mac OS (including temporary files)

• BJ Status Monitor cannot be used when printer is used in network
operating environment.

• When connecting printer and computer through USB interface, use 
the system under the following operating environment.

Computer with Microsoft Windows 98, which is preinstalled by a computer 
manufacturer on purchase. (USB port operation also needs to be assured 
by the manufacturer.)

iMac or Power Macintosh G3 computer with Mac OS 8.1 or later, which is 
preinstalled by a computer manufacturer on purchase. (When using an 
iMac running under Mac OS 8.1, the system must be upgraded using iMac 
Firmware 1.0, which can be downloaded from the home page of Apple 
Computer, Inc.)

Specifications subject to change without prior notice.

Note

Windows

Macintosh
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Using the IS-32 Color Image Scanner Cartridge

Using the Scanner 

Using the Scanner With Windows

Using the Scanner With Macintosh

Scanner Problems
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Using the Scanner

Scanner Driver Basics

Unpacking the Scanner Cartridge

Installing the IS Scan Software

Installing the Scanner Cartridge

Basic Scanning Procedure

Using the White Calibration Sheet

Scanning Area Guidelines

Loading an Image
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Scanner Driver Basics

Installing the optional IS-32 Color Image Scanner Cartridge in the printer makes it possible 
to scan and save images such as your favorite photographs and greeting cards.

Photograph

Wallpaper for your computer 
Home page 

Greeting card
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Scanner Driver Basics

To use the scanner cartridge, you must install the IS Scan software, which includes the 
IS Scan scanner driver and the IS Scan Plus utility program. These two programs provide 
many features that allow you to perform simple color adjustments to improve the quality of 
the original image or enhance the image for artistic effect.

You can run the IS Scan driver from within a TWAIN-compliant graphics application 
program, or you can run the IS Scan Plus utility program directly as a stand-alone 
application program. The IS Scan Plus utility program allows you to scan, edit, enhance, 
and save the image data.

To use the scanner cartridge, you must install the IS Scan software. You can run the 
IS Scan driver from within a TWAIN-compliant graphics application, or you can run it 
directly as a stand-alone program.

TWAIN is an industry interface standard that allows software applications 
to communicate with digital imaging devices such as scanners. 
Applications that support TWAIN provide a standardized method of 
acquiring images.

Windows

Macintosh

Note
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Unpacking the Scanner Cartridge

Make sure you have the following items.

�  IS-32 Color Image Scanner Cartridge

The scanner cartridge is composed of precision components. To avoid 
poor scanning results, do not touch the optical components or electrical 
contacts.

Optical components

Electrical contacts

Do not touch 
these areas

Caution
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Unpacking the Scanner Cartridge

�  White Calibration Sheet
You use this sheet to maintain the correct color balance of scanned images. The first time 
you install the scanner cartridge, you need to run the white level calibration. You will also 
run calibration when the white level calibration data needs to be updated.

�  Scanning Holder
You can use this holder to hold a photo or other small image you wish to scan. The holder is 
two layers, one being a clear plastic cover to protect photographs.
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Installing the IS Scan Software

Before installing the IS Scan software, you must install the BJC-3000 Printer Driver.

1 Make sure the Canon Creative CD-ROM is inserted in your CD-ROM 
drive.

2 Double-click the BJC-3000 icon on your desktop:    

You’ll see this screen:
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Installing the IS Scan Software

3 Click the Manuals, Supplies, and Help button. You’ll see this screen:
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Installing the IS Scan Software

4 Click Canon Accessories and Paper. You’ll see this screen:

5 Click the Install IS-32 Driver button.

6 Follow the instructions on the screen.
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Installing the Scanner Cartridge

• The scanner cartridge is composed of precision components. To avoid 
poor scanning results, do not touch the optical components or electrical 
contacts.

• To avoid damaging the scanning head of the scanner cartridge, do not 
store the scanner cartridge in an SB-31 Ink Cartridge Storage Box. The 
pad for the BJ cartridge print head inside the container is covered with 
ink that could damage the scanning head of the scanner cartridge. 

Optical components

Electrical contacts

Do not touch 
these areas

Caution
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Installing the Scanner Cartridge

�  Replacing a BJ Cartridge With the Scanner Cartridge

1 Make sure that the printer is plugged in and turned on. Open the front 
cover; the cartridge holder moves to the center automatically.

2 Raise the cartridge lock lever to unlock the BJ cartridge.

3 Remove the BJ cartridge.

To avoid staining your hands, clothing, or work area, handle the 
BJ cartridge carefully. Avoid dropping or shaking the BJ cartridge. 
Store the BJ cartridge in the Ink Cartridge Storage Box.

Caution
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Installing the Scanner Cartridge

4 Insert the scanner cartridge into the cartridge holder, then lower the 
cartridge lock lever until it locks in place.
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Basic Scanning Procedure

After installing the IS Scan scanner driver, you can use the BJC-3000 printer as a scanner.

1 Remove the BJ cartridge installed in the cartridge holder and then install 
the IS-32 Color Image Scanner Cartridge.

2 Start a graphics application program.

For Windows Users

• If you use a TWAIN-compliant graphics application program, launch the TWAIN-
compliant application program. IS Scan launches from within the application 
program.

• If you use IS Scan Plus, select Programs from the Start menu first. Point to 
IS Scan Plus and then select IS Scan Plus.

For Macintosh Users

• If you use a TWAIN-compliant graphics application program, launch the TWAIN-
compliant application program first. IS Scan launches from within the application 
program.

• If you use IS Scan as a stand-alone application program, double-click IS Scan 
BJC-3000 in the folder you specified during the installation procedure.

Windows

Macintosh
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Basic Scanning Procedure

3 The first time you use the scanner, you need to perform the White Level 
Calibration.

 Using the White Calibration Sheet

4 Insert the image you wish to scan into the scanning holder, then load the 
scanning holder into the auto sheet feeder.

 Loading an Image

5 Scan the image.

 Scanning an Image

 Scanning an Image

6 Save the scanned image.

7 Now you can install the BJ cartridge and print the scanned image.

Windows

Macintosh
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Using the White Calibration Sheet

The white calibration sheet provided with the scanner cartridge is used for maintaining the 
correct color balance of scanned images. White level calibration is required when the 
scanner cartridge is used for the first time and when the white level calibration data needs 
to be updated.

When white level calibration is needed, you will see this screen when you click the Prescan 
or Scan button.

  

Windows

Macintosh
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Using the White Calibration Sheet

1 Load the white calibration sheet with the cropped corner at upper left.

2 Click the OK button on your screen.

3 When the white calibration sheet is ejected from the paper output tray, 
White Level Calibration processing is complete. Click the OK button.
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Using the White Calibration Sheet

• Do not leave the white calibration sheet in locations that are exposed to 
direct sunlight or that are subject to high temperatures or humidity.

• Do not bend or wrinkle the white calibration sheet.

• When cleaning the white calibration sheet, use a soft cloth that is dipped 
in a weak, neutral detergent solution, and then wipe its wet surface off 
with a dry, soft cloth.

• The white level calibration data is stored into memory and used for 
maintaining the correct color balance of scanned images. When a 
message appears and prompts you to load the white calibration sheet, 
click the OK button and perform white level calibration.

You can also initiate White Level Calibration from the IS Scan driver.

 Other IS Scan Features

 Other IS Scan Functions

Note

Windows

Macintosh
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Scanning Area Guidelines 

• The scanning area varies according to conditions such as the scanning resolution and 
display resolution.

• If you wish to scan images larger than the size of the scanning holder provided with the 
IS-32 Color Image Scanner Cartridge, the SH-101 A4/LTR scanning holder is available 
for purchase. Visit the Canon Web site to find out about accessories and supplies 
(www.ccsi.canon.com).

• The maximum thickness of the image must be within 0.45 mm, including the scanning 
holder. The scanning holder is 0.2 mm thick so the image you wish to scan must be less 
than 0.25 mm thick.

• To prevent possible damage to the printer or scanner cartridge, do not scan an image 
with paper clips or staples.

Paper size Scanning area

Letter 8.50 × 11.00 in 8.19 × 10.60 Inches

A6 105.0 × 148.0 mm 3.86 × 5.43 Inches

A5 148.0 × 210.0 mm 5.55 × 7.87 Inches

A4 210.0 × 297.0 mm 8.00 × 11.29 Inches

B5 182.0 × 257.0 mm 6.89 × 9.72 Inches
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Loading an Image

1 Slide the paper guide to the left edge of the auto sheet feeder.

2 Place the image in the scanning holder.

• To prevent paper jams, always insert the image you wish to scan into 
the scanning holder.

• Do not leave the scanning holder in locations that are exposed to direct 
sunlight or that are subject to high temperatures or humidity.

• When you load the scanning holder on the printer, be sure to set the 
paper thickness lever to the down (or envelope) position. Scanning with 
the lever set incorrectly will adversely affect the print quality.

3 Load the scanning holder in the auto sheet feeder of the printer.



427Using the Scanner

Loading an Image

4 Adjust the paper guide to the left edge of the scanning holder.

To prevent possible damage to the scanning holder, always insert the 
seamed side into the auto sheet feeder first.

Caution
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Using the Scanner With Windows

Using IS Scan

Changing the Scanning Mode

Using the Customized Scanning Mode

Saving the Settings

Using the Saved Settings

Other IS Scan Features

Using IS Scan Plus

Using Copy

Using Capture Image

Using Capture Photo

Editing a Scanned Image

Printing a Scanned Image

Saving a Scanned Image
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Using IS Scan

This section describes how to scan an image when you launch IS Scan from within a 
TWAIN-compatible application program.

�  Scanning an Image

These basic procedures may vary according to the application program 
you are using.

1 Install the IS-32 Color Image Scanner Cartridge in the printer.

 Installing the Scanner Cartridge

2 Make sure Canon IS Scan 2 is set as the Acquire Source and then select 
the command used for scanning (such as Acquire or TWAIN) from the 
menu of the application program. The main IS Scan dialog box displays:

Note
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Using IS Scan

3 Specify the basic settings.

• Click the down-arrow on the right of the Paper Size box and select the 
most appropriate paper size for the image you wish to scan.

• Select the most appropriate scanning mode for the image you wish to 
scan in the Scanning Mode box.

 Changing the Scanning Mode

4 Load the image you wish to scan in the auto sheet feeder of the printer 
and click the Prescan button.

It’s a good idea to use prescanning to determine whether or not an image 
can be scanned properly or to test the effects of image adjustments. If the 
image is slanted or a portion of the image is cut off in the preview area, 
click the Clear button. Load the image correctly and click the Prescan 
button again.

5 To scan only a portion of the image, you can drag the mouse to specify the 
portion. The specified portion is called a Selection Box and only the area in 
the Selection Box will be scanned. To specify the Selection Box:

• Point to a corner of the rectangular area of the image that you want to 
select.

• Drag the mouse to the opposite corner of the rectangle.

Note
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Using IS Scan

• Release the mouse button. The Selection Box appears on the image. 

• To move the Selection Box, place the mouse pointer within the Selection 
Box and drag the mouse to the desired position.

• To resize the Selection Box, point to a corner of the Selection Box and 
then drag the mouse.

• You can confirm the dimensions of the Selection Box in the Image Size 
box.

• The minimum size of the Selection Box is 1" × 1" (25.4 mm × 25.4 mm).

Note
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Using IS Scan

6 Load the image you wish to scan in the auto sheet feeder again.

7 Click the Scan button. Remember, if you specified a Selection Box in 
step 5, only that portion of the image is scanned.

8 After scanning is complete, click the Transfer button to transfer the image 
data to the TWAIN-compatible graphics application program. Adjust, edit, 
or enhance the image in the application program as needed.
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Using IS Scan

• Some TWAIN-compliant graphics application programs do not display 
the main IS Scan dialog box but instead display a different screen 
characteristic of the application program. If you are using this type of 
application program, read the documentation of the application program 
carefully and perform prescanning or normal scanning.

• After launching IS Scan from within a TWAIN-compatible application 
program, do not close the application program. If you do, the system may 
not be able to respond.

• To quit IS Scan, select Exit Driver from the Settings menu.

Note
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Changing the Scanning Mode

You can select a scanning mode according to your scanning purpose. Optimum settings, 
such as image type and resolution, are pre-assigned based on the contents of a scanning 
job. When you wish to customize the settings for special scanning jobs, click the Custom 
button.

�  Selecting a Default Scanning Mode
Select the most appropriate icon in the Scanning Mode box of the main IS Scan dialog box 
according to your scanning purpose.

Scanning 
Mode

Purpose
Image Type
Resolution

Edge Emphasis
Character Emphasis

Color Matching

Prescan 
Mode

Standard setting for scanning a 
color image

Color
180 dpi

Off
Off
On

Grayscale

Standard setting for scanning a 
monochrome image

Grayscale
180 dpi

Off
Off
Off

Grayscale

Suitable for scanning a 
photographic print such as a 
snapshot

Color
360 dpi

Off
Off
On

Grayscale
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Changing the Scanning Mode

When you select FAX or OCR, the document is scanned and processed as 
a grayscale image and converted to monochrome binary image data. This 
process eliminates unnecessary image background and increases the 
quality of the scanned text and line art. When you select Text, the 
document is scanned and processed as a monochrome image.

Scans by converting a 
monochrome image into the 
data suitable for facsimile 
transmission

Monochrome
200 dpi

Off
On
Off

Monochrome

Scans by converting a 
monochrome image into the 
data suitable for OCR input

Monochrome
360 dpi

Off
On
Off

Monochrome

Suitable for scanning an image 
that consists mostly of text

Monochrome
180 dpi

On
Off
Off

Monochrome

Used for customizing the 
settings for special scanning 
jobs

Using the Customized 
Scanning Mode

— — —

Scanning 
Mode

Purpose
Image Type
Resolution

Edge Emphasis
Character Emphasis

Color Matching

Prescan 
Mode

Note
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Using the Customized Scanning Mode

When you select Custom in the Scanning Mode box of the main dialog box, the Custom 
dialog box opens and allows you to adjust the scanning settings for special scanning 
jobs. 

1 Open the main IS Scan dialog box.

2 Click the Custom button in the Scanning Mode box. This displays the 
Custom dialog box:
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Using the Customized Scanning Mode

3 Specify these settings in the Custom dialog box:

Standard Value
You change the standard values for the default settings here.

Image Type
Select a type of image: Color (the default), Grayscale, or Monochrome.

Resolution
Determines the precision of the scanned image. The higher the resolution 
setting, the higher the precision and quality of the scanned image. 
(However, the higher the resolution setting, the larger the file size.)

• The 90 dpi setting is sufficient for viewing images on a screen.
• The 180 dpi setting is sufficient for printing images.

Threshold
Determines the intensity of halftones for monochrome images. Drag the 
slide bar to the left for a lighter image or drag it to the right for a darker 
image. The Threshold option is available only when the Image Type is set 
for Monochrome and Character Emphasis is off.

Edge Emphasis
Sharpens the edges of a soft image to create a clearer, more accented 
appearance in the entire image. This option is available only when the 
Image Type is set for Monochrome. Edge Emphasis is not used with 
prescanning.
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Using the Customized Scanning Mode

Character Emphasis
Determines whether or not Image Trust processing is used for scanning 
grayscale images. Image Trust processing sharpens the appearance of 
characters in monochrome documents. This is especially helpful if you 
intend to use the scanned original with an OCR software application. This  
option is available only when the Image Type is set for Monochrome.

Color Matching
In some cases, the colors displayed on your monitor may not match the 
colors you see in your printout. Color Matching attempts to match the 
colors of the scanned image with the selection in the Monitor Type box in 
order to attain a better match between the colors you see on the monitor 
and the colors you see in your printout. This option is available only when 
the Image Type is set for Color.

Monitor Type
Displays the name of the monitor profile currently in use. To select another 
monitor type setting, click the down-arrow and select a name from the drop-
down list. This list includes the names of ICC profile formats, standard 
profiles for monitors, installed in the system. A monitor profile can be 
selected only when Color Matching is selected.

Prescan
Selects the type of image for prescanning. Select Monochrome, Grayscale 
(the default), or Color.
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Using the Customized Scanning Mode

4 Click the OK button to return to the main dialog box.

5 Make sure that the image you wish to scan is inserted into the scanning 
holder properly and is loaded in the auto sheet feeder of the printer, then 
click the Scan or Prescan button.
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Saving the Settings

You can save the settings in the main IS Scan dialog box to a file. The next time you scan, 
you only need to open the file in which the desired settings are stored and start scanning.

�  Saving the Settings to a File
Save the Page Size, Scanning Mode, and Image Size settings in the main IS Scan dialog 
box as a file.

1 Specify the desired settings in the Paper Size, Scanning Mode, and Image 
Size boxes.

2 Select Save Settings File from the Settings menu.

3 Select the folder in which the file is to be saved.

4 Enter a File name.

5 Click the Save button.
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Using the Saved Settings

Open the file in which the desired settings were saved and use those settings for scanning.

1 Select Open Settings File from the Settings menu.

2 Select the file you wish to use, then click the Open button. The file name 
is displayed in the Settings File box, and the settings change in the main 
IS Scan dialog box.

• When you open the file while an image is displayed in the preview area, 
the prescanned or scanned image is discarded. Prescan or scan the 
image again.

• Select Save Settings File from the Settings menu when you have 
changed the settings and you wish to overwrite the current file and save 
all the current settings to it.

• Select Save Settings File As from the Settings menu when you have 
changed the settings and you wish to save all the current settings under 
a new file name.

Note
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Other IS Scan Features

�  White Level Calibration
Use this feature to maintain the correct color balance of scanned images. You need to 
perform White Level Calibration when you use the scanner cartridge for the first time and 
when the white level calibration data needs to be updated.

1 Select White Level from the Option menu of the main IS Scan dialog box.

2 When a message appears, insert the white calibration sheet into the auto 
sheet feeder of the printer.

 Using the White Calibration Sheet

3 Click the OK button.

4 When the white calibration sheet is ejected from the paper output tray, the 
White Level Calibration process is complete.

�  Device Information
When you select Device Information from the Option menu of the main IS Scan dialog box, 
you can verify the name of the printer that is currently connected to your system and 
information on the communication mode.

• If the printer is connected using the parallel interface, Device Information displays a 
communication mode such as ECP/1 or ECP/2.

• If the printer is connected using the USB interface, Device Information displays USB as 
the communication mode.
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Other IS Scan Features

�  Enlarging the Scanned Image in the Preview Area

To enlarge the scanned image in the preview area, click the Enlarge icon (  key) or 

select Large from the View menu.

To return to the original size, click the Standard icon (  key) or select Normal from the 

View menu.

�  Using Online Help

When you click the  symbol in the main IS Scan dialog box, the online Help for IS Scan 

opens so you can learn more about IS Scan.
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Using IS Scan Plus

IS Scan Plus is a utility program that allows you to edit, enhance, print, and save an image 
acquired by the IS Scan scanner driver. You can use IS Scan Plus if you do not have a 
graphics application program.

�  Launching IS Scan Plus

1 Select Programs from the Start menu, then click IS Scan Plus.

2 Select IS Scan Plus. The main IS Scan Plus screen appears:
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Using IS Scan Plus

3 Select an option:

Copy
Scan and immediately print an image without editing.

 Using Copy

Capture Image
Scan and edit an image other than a photographic print.

 Using Capture Image

Capture Photo
Scan and edit a photographic print such as a snapshot.

 Using Capture Photo

Device Information
Verify the name of the printer that is currently connected to your system 
and information on the communication mode.
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Using IS Scan Plus

�  Using Online Help
When you need detailed instructions, click the Help button in the upper right of the main 
screen. You can access the online Help from all the screens that IS Scan Plus displays.

�  Verifying the Device Information
Make sure that the printer is connected properly and is turned on, and click the Device 
Information button.

• If the printer is connected using the parallel interface, Device Information displays a 
communication mode such as ECP/1 or ECP/2.

• If the printer is connected using the USB interface, Device Information displays USB as 
the communication mode.

�  Closing IS Scan Plus
When you wish to close IS Scan Plus, click the Exit button in the upper right of the main 
screen. You can access the Exit button from all the screens that IS Scan Plus displays.
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Using IS Scan Plus

�  IS Scan Buttons

Returns to the main IS Scan Plus screen.

Moves back to the previous screen.

Displays the Edit screen.

 Editing a Scanned Image

Prints a scanned image.

 Printing a Scanned Image

Saves a scanned image.

 Saving a Scanned Image
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Using Copy

Use the Copy feature when you wish to print an image immediately after scanning. You 
cannot edit or enhance the scanned image before printing.

1 Click the Copy button in the main IS Scan Plus screen. The Copy screen 
displays:
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Using Copy

2 Specify any required settings:

• Select Color or Monochrome in the Document Type box.

• Select Fine or Fast in the Copy Mode box.

• Select the paper size in the Paper Size box.

• The Copies box is disabled.

3 Click the Print Setting button. This displays the Print Setup dialog box. 
Make sure Canon BJC-3000 is displayed as the default printer. Click the 
Properties button, if necessary, to display the Printer Properties dialog box 
and specify any printer settings. See your online BJC-3000 User’s Manual 
for details.
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Using Copy

4 When you click the Copy button, a message box appears. Click OK in the 
message box to confirm that the scanner cartridge is installed. Copying 
begins.

5 Another dialog box appears to remind you to remove the scanner 
cartridge, and install the BJ cartridge according to your print job. Also, 
make sure paper is loaded in the auto sheet feeder of the printer.

6 Click the OK button in the dialog box. Printing begins.
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Using Copy

• To print the image displayed in the Preview Area again, click the Reprint
button.

• To make a copy of another image using the same settings, click the Copy 
button. When a confirmation message appears, click the Yes button and 
repeat the procedure described above.

• To make a copy using different settings, click the Clear button to clear 
the copied image from the preview area. Repeat the procedure 
described above.

Note
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Using Capture Image

Use the Capture Image feature to scan an image other than a photographic print. You can 
also edit, enhance, save, and print the scanned image.

1 Click the Capture Image button in the main IS Scan Plus screen. This 
displays the Capture Image screen.
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Using Capture Image

2 Select the most appropriate icon in the Scanning Mode box of the Capture 
Image screen according to your scanning purpose.

Standard setting for scanning a color image.

Standard setting for scanning a monochrome image.

Suitable for scanning a photographic print such as a 
snapshot.

Suitable for scanning an image that consists mostly of text.

Used for customizing the settings for special scanning jobs.

 Using the Customized Scanning Mode

3 Select the paper size in the Paper Size box.

4 Insert the image you wish to scan in the scanning holder, and then load it 
in the auto sheet feeder of the printer.

5 Click the Prescan button.

The remaining steps are similar to those described for Scanning an Image 
using IS Scan.

 Scanning an Image
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Using Capture Photo

Use the Capture Photo feature to scan a photographic print such as a snapshot. You can 
also edit, enhance, save, and print the scanned image.

1 Click the Capture Photo button in the main IS Scan Plus screen. The 
Capture Photo screen displays:

By default, a Selection Box displays in the Preview Area. To delete the 
Selection Box, point to any location in the Preview Area and right-click 
your mouse.
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Using Capture Photo

2 Specify these settings:

• Select Color or Black & White in the Photo Type box.

• Select Regular or Panorama in the Photo Size box.

3 Insert the image you wish to scan into the scanning holder, and then load it 
in the auto sheet feeder of the printer.

4 Click the Prescan button.

The remaining steps are similar to those described for Scanning an Image.

 Scanning an Image
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Editing a Scanned Image

You can edit or enhance a scanned image acquired using the Capture Photo or Capture 
Image feature. The editing features you can use vary according to the settings you used for 
scanning and whether you used the Capture Photo or Capture Image feature for scanning.

You can edit or enhance the image displayed in the Preview Area.

1 Click the Edit button in the main IS Scan Plus screen. The Edit screen 
displays:
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Editing a Scanned Image

2 You can select these editing options. For details on each feature, use the 
online Help for IS Scan Plus.

Contrast / Brightness
Adjusts the brightness and contrast of an image.

Image Compensation
Softens edges in the image by reducing the contrast between pixels, or 
sharpens hazy or blurred images. You can also smooth the appearance of 
the image and invert the image.

Edges
Enhances the edges in an image by increasing the contrast of the pixels 
between areas of different colors. 

Lines
Emphasizes selected edges and de-emphasizes all other edges of an 
image.

Pixelize
Squares off all the pixels in an image to lower resolution and makes the 
pixels appear larger to create a mosaic tile effect.

Posterize
Reduces the number of colors in an image.

Low Relief
Applies special options to create a three-dimensional effect in the image.
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Editing a Scanned Image

Background
Allows you to add a background to a monochrome image.

Crop Photo
Crops a scanned photograph in the Preview Area.

Frame
Allows you to add a frame border around the image.

• Depending on the settings you use for scanning, some editing features 
are not available. For details, see the online Help for IS Scan Plus.

• You cannot use Crop Photo and Frame in the Capture Image screen. 
You can select Background when a monochrome image is captured.

3 Edit or enhance the image as required.

4 Click the Apply button to apply the effect to the image in the Preview Area.

To undo the settings, click one of the undo buttons:

Undo All
Click once to undo all editing effects and restore the original in the 
Preview Area.

Undo Previous
Click once to undo the previous editing effect; click repeatedly to undo 
each previous editing effect one by one.

Note
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Printing a Scanned Image

You can print a scanned image acquired using the Capture Image or Capture Photo feature. 
Remove the scanner cartridge, and install the BJ cartridge according to your print job.

Click the Print button on the IS Scan Plus screen. If you are using Capture Image, the Print 
dialog box appears: 
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Printing a Scanned Image

If you are using Capture Photo, the Photo Print Options dialog box appears.

Click Print Setting to change the printer settings or click Print to print the image.

 Opening the Printer Properties Dialog Box
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Saving a Scanned Image

IS Scan Plus allows you to save a scanned image to a file under a new name. You can use 
the saved image for pasting into another document or for attaching to your e-mail or a home 
page on the Internet.

You can save the image displayed in the Preview Area.

1 Click the Save button. This displays the Save As dialog box.

2 Select the folder in which you wish to save the image.

3 Enter a File name.
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Saving a Scanned Image

4 Click the down-arrow for “Save as type” and select a format for the file.

You can select one of the following file formats.

• Bitmap .BMP

• JPEG .JPG

• TIFF .TIF

5 Click the Save button.



463Using the Scanner With Macintosh

Using the Scanner With Macintosh

Scanning Images With Application Software

Using the Main IS Scan Dialog Box

Scanning an Image

Scanning Images With IS Scan

Changing the Scanning Mode

Customizing the Scanning Settings

Copying a Scanned Image to the Clipboard

Adjusting an Image

Modifying an Image

Applying Special Effects to an Image

Other IS Scan Functions

Using the Copy Utility
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Scanning Images With Application Software

This section explains how to start IS Scan from a TWAIN image editing application software 
so that you can scan images. 

�  Selecting a TWAIN-compatible Device
Before you scan images with application software, you must first select a TWAIN-
compatible device using the BJC-3000 driver. The basic procedure is described below 
(steps may vary based on your application software).

1 Start the application software and then select New... from the File menu. 
Then, open the menu you use to scan images. Install the scanner 
cartridge in the printer.

2 To open the dialog box for selecting a TWAIN-compatible input device, you 
normally select Import and then select TWAIN Select... from the File 
menu. The “Select a source” dialog box is displayed.

3 Click the IS Scan BJC-3000 DS icon 
and then click the OK button.

BJC-3000 is now selected as the input 
device. Once you have performed these 
steps, the setting remains in effect until 
you change to another input device.
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Using the Main IS Scan Dialog Box

Menu button
Selects the IS Scan functions. Click this button to change the settings for a scanned 
image or to edit a scanned image.

Image Control 
Panel

Brightness and 
Contrast

Preview Area

Menu Button

Scan Button

Save  Button

Halt Button

Help Button

Information Box
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Using the Main IS Scan Dialog Box

Scan, Prescan, or Clear button
Click this button to start scanning. This button switches to Prescan or Clear, 
depending on the setting or situation.

Transfer or Save button
Click this button to transfer a scanned image to an application. When using IS Scan 
only without an application software, this button says Save.

Halt button
Click this button to cancel scanning.

Information box
Displays the settings related to image scanning. To perform scanning using other 
settings, click the Menu button and then select Settings.

Help button
Click this button to display helpful explanations about the IS Scan functions.

Brightness and Contrast 
Click this button to adjust the degree of brightness of an image.

Image Control Panel
Displays the size of the image to be scanned. For units, you can select inches, mm, 
or pixels. 

Preview area
Displays a scanned image.
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Scanning an Image

1 Click the Menu button and then select Settings. The Settings dialog box 
displays:

2 Make the necessary settings for the image to be scanned.

• Click on Paper Size to select a size that approximates the image to be 
scanned.

• Click on Scanning Mode to select the item that best approximates the 
image to be scanned.

 Changing the Scanning Mode
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Scanning an Image

• Place a check mark in the Prescan check box. 
Prescan performs a quick scan so you can check the image. You can 
disable this function.

3 Click the OK button and then close the Settings dialog box.

4 Place the object to be scanned in the printer and then click the Prescan 
button. You see the image displayed in the Preview Area.

5 If you only want to scan part of the object, drag the mouse within the 
Preview Area to select the part to be scanned. The Selection Box indicates 
the area that will be scanned.
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Scanning an Image

• To create a Selection Box, position the cursor over one corner of the 
area to be selected, press and hold down the mouse button, and then 
drag the mouse diagonally to the opposite corner of the area you want to 
select. Release the mouse button.

• If you position the cursor over a point within the selected area, you can
move the area by dragging. If you position the cursor over one of the 
lines indicating the selected area, you can change the size of the 
selected area by dragging that line in or out.

• The minimum size of the selected area is 1" × 1" (25.4 mm by 25.4 mm).

• The size of the selected range is displayed in the Image Control Panel. 

6 Place the image to be scanned in the printer and click the Scan button. 
Remember, only the range indicated by the Selection Box is scanned.

Note
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Scanning an Image

7 If the image displayed in the Preview Area is not what you expect, click the 
Clear button and start over.

If you like the image, click the Transfer button. The scanned image is 
transferred to the application software. Edit the image data as required 
prior to printing or saving it.

• Some application programs do not display the main IS Scan dialog box, 
but display their own scanning screen. In this case, refer to the 
documentation supplied with the scanning software.

• Do not close an application program that started IS Scan while 
IS Scan is still running. This may cause the system to lock up.

Note
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Scanning Images With IS Scan

You can use IS Scan as a stand-alone program to scan and edit images.

�  Starting IS Scan

1 Turn on the printer and install the scanner cartridge.

2 Double-click the IS Scan BJC-3000 folder.

3 Double-click the IS Scan BJC-3000 icon.
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Scanning Images With IS Scan

IS Scan starts and the main dialog box displays.

The contents of the main dialog box and the method you use to scan 
images are basically the same as when using TWAIN application software.
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Scanning Images With IS Scan

�  Saving Scanned Images

1 Click the Save button.
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Scanning Images With IS Scan

2 Make the necessary settings.

• Select the location to which you want to save your image.

• Enter a name for the image data in Name.

• Click the up- or down-arrow in Format to select PICT or TIFF.

3 Click the Save button. The image data is saved into a file.
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Changing the Scanning Mode

You can select a scanning mode according to your scanning purpose. Optimum settings, 
such as image type and resolution, are pre-assigned based on the contents of a scanning 
job. When you wish to customize the settings for special scanning jobs, click the Custom 
button.

�  Selecting a Default Scanning Mode
Select a setting that best approximates the image to be scanned. 

Scanning 
Mode

Use
Image Type
Resolution

Edge Emphasis
Color Matching

Prescan 
Mode*

DTP 
(Color)

Standard setting used when a 
color draft is to be scanned

Color
180 dpi

Off
On (Execute)

Grayscale

Photo Recommended when scanning 
a photograph

Color
360 dpi

Off
On (Execute)

Color

DTP 
(B&W)

Standard setting used when a 
black & white draft is to be 
scanned

Grayscale
180 dpi

Off
Off

Grayscale

* By default, Prescan is disabled. Once enabled, Black & White is the default Prescan 
  Mode. You can select a Prescan Mode of Color, Grayscale, or Black & White.
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Changing the Scanning Mode

Text Recommended when scanning 
a document consisting entirely 
of text, such as a document 
created with a typewriter or 
word processor

Black & 
White
180 dpi

On (Execute)
Off

Black & 
White

FAX Scans by converting a 
monochrome image into the 
data suitable for facsimile 
transmission

Black & 
White 
(Text 
Enhanced)
200 dpi

Off
Off

Black & 
White

OCR Scans by converting a 
monochrome image into the 
data suitable for OCR input

Black & 
White 
(Text 
Enhanced)
360 dpi

Off
Off

Black & 
White

Custom Selected when a specific range 
of settings are to be made

Customizing the 
Scanning Settings

––––– ––––– –––––

* By default, Prescan is disabled. Once enabled, Black & White is the default Prescan 
  Mode. You can select a Prescan Mode of Color, Grayscale, or Black & White.

Scanning 
Mode

Use
Image Type
Resolution

Edge Emphasis
Color Matching

Prescan 
Mode*
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Changing the Scanning Mode

• The Settings dialog box displays when you select Settings after you click 
the Menu button in the main dialog box.

• When you select FAX or OCR, the document is scanned and processed 
as a grayscale image and converted to monochrome binary image data. 
This process eliminates unnecessary image background and increases 
the quality of the scanned text and line art. When you select Text, the 
document is scanned and processed as a monochrome image.

Note
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Customizing the Scanning Settings

When you select Custom for Scanning Mode in the Settings dialog box, you can specify the 
scanning settings.

1 Click the Menu button in the main dialog box and then select Settings.

2 Click the up- or down-arrow in Scanning Mode and then select Custom.
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Customizing the Scanning Settings

3 Make the appropriate settings for the image to be scanned.

Image Type
Select a mode according to the image to be scanned. You can select 
Color, Grayscale, Black & White, or Black & White (Text Enhanced).

Resolution
Select a resolution according to the image to be scanned. The higher the 
resolution, the finer the image you can get, although the amount of data 
will be large. In general, 90 dpi is sufficient for home pages, while 180 dpi 
is good for output to a printer. Settings are 90, 180, 200, 300, 360.

Threshold
This function is valid only when Image Type is set to Black & White. The 
lightness/darkness of monochrome images can be adjusted by moving the 
slide bar. If the slide bar is moved to the left, the scanned image will be 
lighter, while if the slide bar is moved to the right, the image will be darker.

Prescan
Place a check mark in the Prescan check box to perform the prescan. The 
scanning mode can be set to Black & White, Grayscale, or Color.

Color Matching
This function is effective only when Image Type is set to Color. When this 
function is enabled, the colors are adjusted according to the monitor when 
the image is scanned. The monitor itself is set with the system feature of 
ColorSync® in the Apple menu control panel.
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Customizing the Scanning Settings

Edge Emphasis
This function is valid only when Image Type is set to Black & White. If this 
function is selected, only the edge of the image is emphasized when the 
image is scanned. This is disabled for prescan.

4 Click the OK button. The main dialog box displays.

5 Place the image to be scanned in the printer, then click the Prescan button 
or Scan button to start scanning.
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Copying a Scanned Image to the Clipboard

If you copy a scanned image to the clipboard, you can use the image easily with other 
application software. This is particularly useful when you want to paste an image into 
documents created with application software that is not TWAIN-compatible.

�  Copying an Image

1 Click the Menu button in the main dialog box. Select Edit and then select 
Copy.

The image data is copied to the clipboard.

To use an image copied to the clipboard, start your application software 
and then select Paste from the Edit menu.

Note
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Adjusting an Image

If you are not satisfied with a scanned image, you can perform fine adjustment using a 
range of functions. Image data can be processed so that the brightness of the image 
changes or so that the image appears sharper or softer.

�  Adjusting the Brightness and Contrast

1 Click the Brightness and Contrast button in the main dialog box. The 
Brightness and Contrast dialog box displays.
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Adjusting an Image

2 Move each slide bar to the right or left to adjust the image.

Brightness
Moving the Brightness slide bar to the left makes the entire image darker, 
while moving it to the right makes the image brighter.

Contrast
Moving the slide bar to the left reduces the contrast of the entire image, 
while moving it to the right increases the contrast.

3 After making the adjustment, click the Apply button to change brightness 
and contrast of the image displayed within the preview area.

4 Once you are satisfied with the adjustment, click the OK button.
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Modifying an Image

You can modify a scanned image so that it looks sharper or softer. Also, a Despeckle 
function allows you to remove speckling and make a scanned image appear cleaner. A 
function for inverting colors to produce a negative film is also available.

1 Click the Menu button in the main dialog box, select Image, and then 
select the desired function from the submenu.

Sharpen Sharpens an image to make it clearer.

Soften Softens the edges of an image.

Despeckle Removes speckling from an image, making any such areas 
less noticeable.

Invert Inverts the colors of an image to produce a negative of the 
original.

You can check the effect of the adjustment in the Preview Area.
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Applying Special Effects to an Image

Special effects such as edge emphasis, line emphasis, pixelization, posterization, and low 
relief can be applied to a scanned image, creating an image with a feeling different from that 
of the original.

1 Click the Menu button in the main dialog box, select Enhance, and then 
select the desired function from the submenu.

Edges... Emphasizes the edges of a photograph or line drawing.

Lines... Emphasizes only lines in a specific direction.

Pixelize... Applies a mosaic effect to an image.

Posterize... Reduces the number of colors and simplifies the image.

Low Relief... Creates a low relief version of the image.

When you select one of these functions, the corresponding dialog box 
displays.
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Applying Special Effects to an Image

2 Select a desired function from the list.

The following is an example of the screen displayed when you select 
Edges. The operation is the same when any other function is selected. You 
can check the approximate result of the selection in the Preview Area.

For details of each function, refer to the explanation displayed when you 
click the Help button.
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Applying Special Effects to an Image

3 Once you are satisfied with the adjustment, click the OK button.

To cancel an adjustment you have made, click the Menu button and then 
select Undo. Then, select either of the following:

Last Only the function applied immediately before is cancelled. If you 
perform editing two or more times, only the function that you 
selected most recently is cancelled.

All All the applied functions are cleared and the original image is 
restored.

Note
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Other IS Scan Functions

�  White Level Calibration
To achieve the correct color balance for an object to be scanned, an operation called White 
Level Calibration is required. When an image is scanned for the first time, or when the 
temperature of the scanner cartridge rises to a certain level, a message displays prompting 
you to place the white calibration sheet in the printer.

Place the white calibration sheet in the printer and then click the OK button. The calibration 
sheet is scanned and the calibration is performed.

You can also initiate this operation whenever necessary. 

1 Click the Menu button in the main dialog box and then select Settings.

2 Click the White Level button.

3 When the message appears, place the white calibration sheet in the 
printer.

 Using the White Calibration Sheet

4 Click the OK button.

When the white calibration sheet is ejected, white leveling is complete.
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Other IS Scan Functions

�  Using the Online Help
Clicking the Help button on the main dialog box displays helpful explanations of the 
functions of IS Scan. You can also display the Help by clicking the Menu button, then 
Help, and Help again.
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Using the Copy Utility

Use this utility to scan an object and then print the result immediately. Although the scanned 
image cannot be edited or saved, the process from scanning to printing is completed 
quickly and easily.

�  Installing the Copy Utility
To use the Copy Utility, you must first copy the folder including the necessary files to any 
location.

1 Load the Canon Creative CD-ROM into the CD-ROM driver on your 
Macintosh.

2 Double-click on the Copy Utility folder.
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Using the Copy Utility

3 Drag the Copy Utility for BJC-3000 folder and copy it to any location.

Now you can start the Copy Utility at any time.

To use the Copy Utility, the printer driver and IS Scan scanner driver must 
also be installed.

�  Starting the Copy Utility

1 Turn on the printer and install the scanner cartridge.

2 Click the Copy Utility for BJC-3000 folder.

Note
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Using the Copy Utility

3 Click the Copy Utility icon.

The Copy Utility starts and the main dialog box displays:
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Using the Copy Utility

�  Copying the Image

1 Click the Color or Black & White button according to the image to be 
scanned.

2 Select the paper size you are using in Paper Size.

3 Select the number of copies to be output in Copies.

4 Select the type of paper you are using:  Plain Paper, High Resolution 
Paper, or Transparency.

5 Set Brightness, as necessary. Move the slide bar to the right and left to set 
the brightness.

6 Place the image to be copied in the printer, then click the Copy button.

Scanning starts.

7 When the message appears, remove the scanner cartridge and replace it 
with a BJ cartridge according to the printing settings.

8 Place a blank sheet of paper in the printer and click the OK button.

Printing starts.
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Using the Copy Utility

• To print the same image again, click the Reprint button.

• To copy another document with the same settings, click the Copy button 
and follow the instructions on the screen.

• To perform copying with different settings, click the Reset button and 
follow the instructions on the screen.

�  Ending the Copy Utility
To close the Copy utility, click the close box or the Quit button.

Note

Close box
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Scanner Problems

Scanning Result Is Unsatisfactory

Scanner Cannot Be Used With a TWAIN-compatible Application Program

Other Scanner Problems
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Scanning Result Is Unsatisfactory

Scanned Image Blurred or Distorted

Quality of Scanned Image Is Uneven

White Portion Becomes Grayish

Parts of an Image Missing or Not Aligned Properly

Image Contains Unexpected Colors, or Is Too Light or Too Dark
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Scanning Result Is Unsatisfactory

�  Scanned Image Blurred or Distorted

CHECK 1 ARE YOU USING A CLEAR IMAGE FOR SCANNING?

Blurry images are not suited for scanning. For best scanning results, 
always use a clear, sharp image. (The scanned image cannot be better 
than the original image.)

CHECK 2 IS THE SCANNING HOLDER UNSTAINED AND UNDAMAGED?

The scanning holder is bound to get dirty. Clean the scanning holder using 
a soft cloth that is dipped in a weak, neutral detergent solution, and then 
wipe its wet surface off with a dry, soft cloth.

If the scanning holder is scratched or damaged, replace it.

You can purchase a scanning holder for A4/LTR-size images. Visit the 
Canon Web site to find out about accessories and supplies 
(www.ccsi.canon.com).

CHECK 3 ARE YOU SCANNING THICK PAPER?

The image being scanned must be thinner than 0.25 mm. The thickness 
including the scanning holder must be thinner than 0.45 mm.

Note
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Scanning Result Is Unsatisfactory

�  Quality of Scanned Image Is Uneven
The scanned image is coarse and/or blurry.

CHECK IS THE RESOLUTION SETTING HIGH ENOUGH?

Resolution determines the precision of the scanned image.

The greater the number of dots used to draw an image, the higher the 
precision and the quality of the scanned image becomes. For a better 
quality image, select a greater number.

The scanning speed becomes slower and the file size of the scanned 
image becomes larger when you use a higher resolution.

 Changing the Scanning Mode

 Changing the Scanning Mode

Windows

Macintosh
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Scanning Result Is Unsatisfactory

�  White Portion Becomes Grayish
CHECK 1 DID YOU PERFORM WHITE LEVEL CALIBRATION?

Use White Level Calibration to maintain the correct color balance of 
scanned images.

 Using the White Calibration Sheet

CHECK 2 DID YOU ADJUST THE BRIGHTNESS AND CONTRAST?

Depending on the image you scan, a white portion is not recognized as 
white because the scanner detects and scans even the small differences 
of the density between white and other colors.

Adjust the brightness and contrast.

• When you are using IS Scan Plus, use the online Help.

• When you are using a TWAIN-compatible graphics application program, 
see the User’s Manual for the application program.

Note
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Scanning Result Is Unsatisfactory

CHECK 3 DID YOU SCAN A MONOCHROME IMAGE USING THE COLOR OR 
GRAYSCALE SETTING?

If the Scanning Mode is set to Color or Grayscale, the scanner detects and 
scans even the grades of the density, and white may not be recognized as 
white.

When you scan a monochrome image, always set Black & White in the 
Scanning Mode so the scanner can scan using only two values between 
white and black.

For details on how to set Black & White in the Scanning Mode, use the 
online Help.

 Changing the Scanning Mode

 Changing the Scanning Mode

Windows

Macintosh
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Scanning Result Is Unsatisfactory

�  Parts of an Image Missing or Not Aligned Properly
CHECK 1 DID YOU PLACE AN IMAGE WITHIN THE PROPER SCANNING AREA?

Check that the image you wish to scan is placed in the proper scanning 
area.

CHECK 2 DID YOU SPECIFY THE SCANNING AREA CORRECTLY?

If the Paper Size setting is smaller than the size of the image you scan, 
parts of the image will be missing.

If you place the image outside the scanning area, parts of the image may 
not be aligned properly. Always check that the image is set within the 
proper scanning area.
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Scanning Result Is Unsatisfactory

�  Image Contains Unexpected Colors, or Is Too Light or Too Dark
The appearance of the scanned image is not what you expected, or the image is too light or 
too dark.

CHECK 1 IS THE NUMBER OF DISPLAY COLORS SET TO HIGH COLOR OR TRUE 
COLOR?

Check the number of display colors as follows.

1 From the Start menu, select Settings, and then select Control Panel.

2 Double-click the Display icon, then click the Settings tab.

3 Check that Colors is set to High Color or True Color in the Colors box.

Check the Color Depth setting as follows.

1 From the Apple menu, select Control Panels.

2 Select Monitors & Sound.

3 Check that Thousands or Millions are set for Color Depth.

Windows

Macintosh
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Scanning Result Is Unsatisfactory

CHECK 2 IS COLOR MATCHING ENABLED?

The colors displayed on your display may not match the actual scanned 
colors.

Color Matching attains the best match between the colors displayed on 
your display and the actual colors in the scanned image.

You can enable Color Matching when the Scanning Mode is set for Color.

Check that Color Matching is enabled.

1 Click the Custom Setting button.

2 Make sure that Color Matching is enabled in the Custom Setting dialog 
box.

1 Select Settings from the Menu screen.

2 Make sure that Color Matching is enabled.

Windows

Macintosh



504Scanner Problems

Scanner Cannot Be Used With a TWAIN-compatible 
Application Program

Cannot Launch IS Scan From Within the TWAIN-compatible Graphics 
Application Program

Cannot Transfer to TWAIN-compatible Graphics Application Program
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Scanner Cannot Be Used With a TWAIN-compatible Application Program

�  Cannot Launch IS Scan From Within the TWAIN-compatible Graphics 
Application Program

CHECK DOES THE TWAIN-COMPATIBLE GRAPHICS APPLICATION PROGRAM 
YOU ARE USING SUPPORT THE LATEST 32-BIT TWAIN 
SPECIFICATIONS OR TWAIN SOURCE MANAGER (VERSION 1.5 OR 
LATER)?

When IS Scan is used as a TWAIN interface, you must use the latest 32-bit 
TWAIN-compatible graphics application program. See the User’s Manual 
for your application program.

When IS Scan is used as a TWAIN interface, you must use the graphics 
application program that supports the TWAIN Source Manager (Version 
1.5 or later). See the User’s Manual for your application program.

Windows

Macintosh
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Scanner Cannot Be Used With a TWAIN-compatible Application Program

�  Cannot Transfer to TWAIN-compatible Graphics Application Program
CHECK DOES THE TWAIN-COMPATIBLE GRAPHICS APPLICATION PROGRAM 

YOU ARE USING SUPPORT THE FILE FORMAT TYPE AND RESOLUTION 
OF THE IMAGE DATA?

Some TWAIN-compatible graphics application programs support specific 
file format types and resolution settings only. For example, the resolution 
settings of some OCR (optical character reader) application programs are 
limited to 300 or 400 dpi.

Check the file format types and resolution settings of the TWAIN-
compatible graphics application program first, and then scan and transfer 
the image again.
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Other Scanner Problems

Cannot Install Scanner Driver

Does Not Launch With Default Settings   

Improper Colors Displayed in the Dialog Box

Scanning Too Slow

Communication Error Occurs

Error Message Appears

Windows
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Other Scanner Problems

�  Cannot Install Scanner Driver
CHECK 1 DID YOU FOLLOW THE SCANNER DRIVER INSTALLATION 

INSTRUCTIONS?

 Installing the IS Scan Software

If an error occurred during installation and you had to shut down the 
installation procedure, you may not be able to install the scanner driver 
because Windows is no longer stable. Restart Windows and then reinstall 
the scanner software.

CHECK 2 ARE ANY OTHER APPLICATION PROGRAMS RUNNING?

The scanner driver installation program may not execute successfully if it 
is run with other applications running in the background.

Before you run the installation program again, shut down all other 
application programs.

CHECK 3 DID YOU SPECIFY THE CORRECT CD-ROM DRIVE FOR 
INSTALLATION?  

If the BJC-3000 splash screen did not come up automatically when you 
loaded the CD-ROM, double-click the My Computer icon, then double-click 
the CD-ROM icon on the Windows desktop.

 Installing the IS Scan Software

Windows

Windows
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Other Scanner Problems

• The drive name (E: for example) varies according to how your system is 
set up.

CHECK 4 IS THERE A PROBLEM WITH THE CD-ROM?  

The Canon Creative CD-ROM may be damaged. On the Windows 
desktop, double-click the My Computer icon then double-click the 
CD-ROM icon. If Windows cannot read the CD-ROM, call the Canon 
Customer Care Center for help. 

 Getting Help From Canon

Note

Windows
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Other Scanner Problems

�  Does Not Launch With Default Settings  

CHECK DID YOU LAUNCH IS SCAN FROM A TWAIN-COMPATIBLE GRAPHICS 
APPLICATION PROGRAM?

This problem occurs when IS Scan is launched from a TWAIN-compatible 
graphics application program.

Depending on the TWAIN-compatible graphics application program, 
Previous Settings selected in the Standard Value box under the Custom 
Settings dialog box may be cleared, and standard settings characteristic of 
the TWAIN-compatible program you are using may be used when 
launching IS Scan.

To use the settings selected in the Custom Settings dialog box when 
launching IS Scan, follow these steps:

1 Select Save Settings File from the Settings menu.

2 The next time you launch IS Scan, select Open Settings File from the 
Settings menu.

Windows
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Other Scanner Problems

�  Improper Colors Displayed in the Dialog Box
CHECK IS THE NUMBER OF DISPLAY COLORS SET TO HIGH COLOR OR TRUE 

COLOR?

This problem occurs when IS Scan is launched from a TWAIN-compatible 
application program.

If the problem is not solved, change the number of display colors of your 
computer.

1 From the Start menu, select Settings, and then select Control Panel.

2 Double-click the Display icon, then click the Settings tab.

3 Check that the Colors setting is High Color or True Color in the Colors box.

Or, you may be able to solve the problem by minimizing the IS Scan 
window and then return to the original size.

Check the Color Depth setting.

1 From the Apple menu, select Control Panels.

2 Select Monitors & Sound.

3 Check that Thousands or Millions are set for Color Depth.

Windows

Macintosh
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Other Scanner Problems

�  Scanning Too Slow
Scanning is requiring an unusually long time.

CHECK ARE YOU USING A HIGHER RESOLUTION THAN REQUIRED?

In order to scan an image, your computer must be able to receive a large 
amount of data. Therefore, the scanning speed varies according to the 
performance of the computer.

To shorten the time required for scanning:

• Use the appropriate resolution setting. Make sure that the resolution is 
not set higher than you require.

• Use the prescanning capability.
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Other Scanner Problems

�  Communication Error Occurs
CHECK 1 DID YOU LAUNCH IS SCAN OR IS SCAN PLUS IMMEDIATELY AFTER IT 

WAS CLOSED?

Do not attempt to launch IS Scan or IS Scan Plus again immediately after 
it is closed. Wait for a few seconds and then launch again.

CHECK 2 IS THE PRINTER PLUGGED IN AND READY?

Check that the printer is plugged in and ready.

CHECK 3 ARE YOU USING THE USB INTERFACE RUNNING UNDER 
WINDOWS 98?

When using the USB interface running under Windows 98, a 
communication error may occur if the Hardware acceleration setting is 
Full. To solve the problem, follow these steps:

1 Double-click the System icon in the Control Panel for Windows.

2 When the System Properties window is displayed, click the Performance 
tab.

3 Click the Graphics button.

4 If Hardware acceleration is set to Full in the Advanced Graphics Settings 
dialog box, set to None.

Windows
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Other Scanner Problems

�  Error Message Appears
CHECK REFER TO THE ONLINE HELP.

From the main IS Scan screen, select Contents from the Help menu, or 
press F1.

Open the online Help. 

Windows

Macintosh


	Contents
	Introduction
	Welcome
	Copyright
	Disclaimer
	Trademarks
	How to Use This Manual
	Printer Features
	Safety Precautions

	Parts and Functions of the Printer
	Front View
	Rear View
	Inside the Printer
	Operation Panel

	Connecting and Turning On the Printer
	About the Printer Cable
	Notes on Handling the USB Interface
	Connecting the Power Cord
	Turning On the Printer
	Turning Off the Printer

	Printing on Paper and Other Media
	Media Sizes You Can Use With the Printer
	Media Types You Can Use With the Printer
	Media Types You Cannot Use With the Printer
	Loading Paper and Other Media
	Setting the Paper Thickness Lever
	Printing Area
	Notes on Handling Media
	Using Plain Paper or High Resolution Paper
	Using Envelopes
	Using Transparencies
	Using Back Print Film
	Using Glossy Photo Paper
	Using High Gloss Photo Film
	Using Glossy Photo Cards
	Using Banner Paper
	Using Magnet Sheets
	Using Artist Canvas
	Using Greeting Cards

	Using BJ Cartridges
	BJ Cartridges You Can Use With the Printer
	Notes on Handling BJ Cartridges

	Using the Windows Printer Driver
	Printer Driver Basics
	Preparing and Executing a Print Job
	Getting to Know the Printer Driver
	Making the Most of the Printer Driver
	Using Maintenance Functions

	Using the Macintosh Printer Driver
	Printer Driver Basics
	Preparing and Executing a Print Job
	Print Mode Settings
	Executing Special Functions
	Printer Maintenance

	Printing Photographs
	Tips for Printing Photographic Images
	About Photo Optimizer

	Routine Maintenance
	Prolonging the Service Life of the Printer
	BJ Cartridge Maintenance
	When to Replace the BJ Cartridge
	Printing a Nozzle Check Pattern
	Cleaning the Print Head
	Replacing the Ink Tanks
	Replacing the BJ Cartridge
	Aligning the Print Head
	Cleaning the Printer
	Cleaning the Paper Feed Rollers
	Transporting the Printer

	Troubleshooting
	Printout Is Unsatisfactory
	Printer Does Not Start or Stops Mid-Job
	Paper Jams or Does Not Feed
	The POWER Light Flashes Orange
	An Error Message Appears
	Other Problems
	Avoiding Problems
	Before You Call for Help
	Getting Help From Canon

	Specifications
	General Specifications
	System Requirements

	Using the IS-32 Color Image Scanner Cartridge
	Using the Scanner
	Scanner Driver Basics
	Unpacking the Scanner Cartridge
	Installing the IS Scan Software
	Installing the Scanner Cartridge
	Basic Scanning Procedure
	Using the White Calibration Sheet
	Scanning Area Guidelines
	Loading an Image

	Using the Scanner With Windows
	Using IS Scan
	Changing the Scanning Mode
	Using the Customized Scanning Mode
	Saving the Settings
	Using the Saved Settings
	Other IS Scan Features
	Using IS Scan Plus
	Using Copy
	Using Capture Image
	Using Capture Photo
	Editing a Scanned Image
	Printing a Scanned Image
	Saving a Scanned Image

	Using the Scanner With Macintosh
	Scanning Images With Application Software
	Using the Main IS Scan Dialog Box
	Scanning an Image
	Scanning Images With IS Scan
	Changing the Scanning Mode
	Customizing the Scanning Settings
	Copying a Scanned Image to the Clipboard
	Adjusting an Image
	Modifying an Image
	Applying Special Effects to an Image
	Other IS Scan Functions
	Using the Copy Utility

	Scanner Problems
	Scanning Result Is Unsatisfactory
	Scanner Cannot Be Used With a TWAIN-compatible Application Program
	Other Scanner Problems



		2000-05-23T10:37:58-0500
	Canon ITS
	Michael Moore
	Document is released




